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Welcome 

About this manual 
This manual is intended for use both as an introduction to SPATIALnet FM for 
beginners, and as a reference document for more advanced users. It contains detailed 
descriptions of the commands available in this configuration of SPATIALnet. 

 Who should use this manual? 
This manual is intended for all users of SPATIALnet FM.  Administrators and application 
developers should consult further documentation. 

Prerequisite knowledge 
A sound working knowledge of the Microsoft Windows© user interface is required 
(menus, toolbars, dialog boxes, mouse operations, etc.), as well as a good 
understanding of the AutoCAD application environment.  Note that a high level of 
expertise in AutoCAD is not required to use SPATIALnet FM. 

 

Related documentation 
There are a number of other manuals that may be useful to you: 

 

Document Description 

SPATIALnet FM 
Administrator's Guide 

Describes the functionality available in JMS 
Administration. 

Table 1 - Related documentation 

The AutoCAD online help documentation is a useful guide to the AutoCAD environment 
and its commands, and is accessible via the AutoCAD Help menu. 

Conventions used in this manual 
Below is a list of the typographical conventions used throughout the guide. 

 

Convention Meaning 

Bold, Arial font Menu name, keyboard key, dialog box name, 
field name, command name or icon. 

> Used to separate menu commands, for example:  
SPATIALnet > View > Keymap 
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Convention Meaning 

Note: Notes indicate information that emphasize or 
supplement information from the main text, as 
shown below.  

Note:  This information may help in some 
situations, or contain hints and tips. 

Important: The information contained in the note is critical to 
completing a task. 

... Details The description of a generic dialog box in this 
manual will always include three full stops in the 
name of the dialog box. These full stops are used 
as a stand-in for an entity type. For example, the 
…Details dialog box can be interpreted as 
meaning the Rack Details dialog box, Building 
Details dialog box or the ...Details dialog box of 
any other type of entity for which such a dialog 
box is capable of being displayed. 

Italics Indicates a reference to another section of the 
document, or to external documentation. 

Italics are also used when a new term is defined. 

Hyperlink Indicates a reference to a chapter or section 
within this document. There is an automatic 
cross-reference embedded to allow you to jump 
to a specifically referenced section when viewing 
this document as a PDF file or HTML page. 

Table 2 - Conventions  

Comments and suggestions 
We welcome all comments on the software and documentation, and are very 
interested in suggestions, which would help us to enhance the SPATIALnet product and 
its usefulness to you. Please send your comments and suggestions to your distributor 
of SPATIALinfo products. 

How to use this manual 
This manual both provides an introduction to new users of SPATIALnet, and also serves 
as a comprehensive reference for more experienced users needing information on how 
to perform any function in the system. The table of contents and index can be used to 
quickly find the area you are interested in. 

If you are a new user, you should read Chapter 1 Introduction: SPATIALnet Basics and 
work through Chapter 2 General SPATIALnet Functions.  This will introduce you to 
many aspects of the SPATIALnet FM system.  Depending on the type of work you need 
to do, and the level of access your administrator has granted you, only some of the 
remaining chapters may be relevant to you.  The table below provides a guide to the 



SPATIALnet FM Tutorial Step 1: Logging On and Selecting a Job 
 

Confidential  Page 7 

type of user most likely to need the information contained in each chapter.  If you are 
unsure which apply to you, speak to your SPATIALnet administrator. 

 

The SPATIALnet FM Tutorial 
 

This manual provides a brief but thorough introduction to SPATIALnet which walks you 
through several basic processes in the system.  The tutorial is intended to help you 
familiarize yourself with the concepts and operation of the software.  If you have not 
used SPATIALnet FM before, working though this tutorial is a good place to start.   

The tutorial is divided into several chapters, each dealing with a specific aspect of the 
system, or set of functions relating to a particular kind of network.  

The chapters are organized as follows: 

 

Chapter 1. Introduction 

• SPATIALnet Basics 

 

Chapter 2. General SPATIALnet Functions 

• Logging On and Selecting a Job 

• CAD-Scrape Landbase 

• Set Cad Layers, View Template & Symbol Search Path 

• Control Object Visibility 

• Setting Zoom Level Extents 

• Save View 

• Configure a New Boundary Type 

• Add a New Boundary 

• Editing Boundaries 

• Working with Manipulators and Linear Edit Modes. 

• Configure Network Support Structures 

• Add New Poles and Strand 

• Add  Underground Structures 

• Managing Conduits and Ducts 

• Add New Site Type 

• Add New Site 

• Document References 

• Generating Plottable Drawings 

• Generating a Map Book 

 

Chapter 3. Addresses and Service Areas 
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• Add Service Area Boundary 

• Adding Buildings and Addresses (Manual Addition) 

• Add Land Parcels 

• Automatically Create Service Addresses from Land Parcels 

• MDUs 

• Edit Multiple Addresses 

• Reassign Service Areas 

 

Chapter 4. Outside Plant Fiber 

• Add Term Panel to Site 

• Adding More Equipment to a Site – Understanding Splice Locations. 

• Moving Equipment Between Splice Locations. 

• Configure New HFC Fiber Receiver Type and Usage Codes 

• Add New HFC Node 

• Add New Fiber Cable Type 

• Connect Site and Node with a New Fiber Cable 

• Insert “Tap Splice” into Existing Cable 

•  Editing Segments 

•  Cutting a Cable 

•  Reconnect Cable End by Dragging to New Site 

•  Add Fiber Annotation 

•  Splice Fibers 

•  Optical Coupling 

•  Trace Fibers 

•  Generate Splice Report  

•  Generate Link Loss Report 

•  Generate Trace Report 

 

Chapter 5. Fiber To The Home 

• Configure FTTX Distribution Cabinet Site 

• Add New FTTX Distribution Cabinet Site 

• Cloning a FTTX Distribution Cabinet Site 

• Add Fiber Taps 

• Associate Taps with Poles 

• Create Drops 

• Configure FTTX Fiber Cable Types 
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• Add FTTX Cable 

• Assign Fibers to Tap Ports (“Tail Off” cable) 

Chapter 6. Outside Plant RF (Coaxial Plant) 

• RF Dictionaries 

• Create Design Profile 

• Associate Design Profile with Job 

• Add RF Module to Existing HFC Node 

• Add New HFC Node 

• Connect RF Outputs to Optical Units in HFC Nodes 

• Add RF Power Supply and Power Inserter 

• Add RF Taps 

• Associate Taps with Addresses 

• Add RF Active Devices 

• Add RF Active Device Components (Pads, EQs) 

• Add RF Passive Devices 

• Add RF Cable 

• Create RF Leg With Inline Equipment 

• Reconnecting RF Equipment 

• Editing Taps 

• Tracing RF Plant Connectivity 

• MDU Detail Drawings 

 

Chapter 6. Inside Plant 

(Section 1) Physical Network 

• Creating a site for recording inside plant. 

• Adding floors, floorplans and equipment (racks, chassis, cards). 

• Displaying rack elevation and connectivity diagrams. 

• Connecting equipment. 

• Connecting to Outside Plant. 

• Tracing physical connectivity between inside and outside plant. 

 

(Section 2) Logical Circuits 

• Creating a logical protocol. 

• Creating a customer and a logical service. 

• Mapping the service to inside plant equipment. 

• Configuring Routing and Multiplexing for the service. 
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• Tracing the logical service. 

 

 

Notes: 

1. Chapters 1 to 3 should be worked through in order before subsequent 
chapters, as the later chapters assume familiarity with the material 
presented in the first three chapters. 

2. Chapters 4 to 6 are independent.  You may choose to do any of these, 
or all of them, and may do them in any order.  Sections 1 and 2 of 
Chapter 6 must be done in the order presented. 

3. You do not need to complete the entire tutorial in a single session.  
You can quit at any stage, log back in again at a later time and 
continue where you left off. 
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Chapter 1 

Introduction: SPATIALnet Basics 

This chapter briefly describes the SPATIALnet system, and provides information about 
basic SPATIALnet concepts. 

What is SPATIALnet? 
SPATIALnet is a powerful application suite integrating CAD, network engineering, and 
GIS/reporting functions on a single platform.  SPATIALnet includes functions for: 

• planning 

• designing 

• construction 

• operation 

• maintenance 

• management 

of networks and their associated infrastructure and data sets.  

SPATIALnet uses: 

• AutoCAD to provide CAD-based representations of data, for both graphical 
visualization and editing. 

• A relational database (either Oracle or Microsoft SQL Server) to store all data 
managed by the application (note that graphics displayed in AutoCAD are 
obtained from the database, and not stored in DWG files) 

The use of a relational database allows all the network information to be stored and 
presented as a completely seamless map.  That is, the map has none of the breaks 
between the edges of drawings or “tiles” which are common in traditional file-based 
systems. You can zoom out to any level, or drill down to any level, and can: 

• View and edit selected entities or areas in the CAD window, 

• View and edit the detailed attributes of any entity in a browser or dialog box, or 

• Both. 

 

What is SPATIALnet FM? 
SPATIALnet FM is an application which has been developed on the SPATIALnet platform 
to manage and model fiber-optic, coaxial, and twisted-pair copper networks, 
including: 

• Management of cable and equipment specifications 

• Location and details of network facilities 

• Location, configuration and connectivity of outside plant cables and equipment 

• Physical splicing of individual fibers or pairs, and groups of fibers or pairs 
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• Usage and status management of end-to-end network paths 

• Management of logical circuits and their relation to physical plant 

• Comprehensive management of Inside Plant, including fully integrated 
connectivity, both inside a building, and also to outside plant. 

This manual provides a step-by-step introduction to the user functions of the 
SPATIALnet FM application 

The interaction between AutoCAD and SPATIALnet 
SPATIALnet uses AutoCAD both to display viewable database objects on the screen, 
and to provide an interface for editing their graphical characteristics.  There are two 
ways SPATIALnet allows you to interact with the objects it displays in AutoCAD, 
depending on the type of object.  The types of object are: 

• SPATIALnet entities 

• CAD-Scraped entities 

 

SPATIALnet entities 

SPATIALnet entities represent objects which are managed by the SPATIALnet data 
model.  Specifically: 

• They have properties (or attributes) defined by SPATIALnet.  The input and 
validation of these attributes is managed by SPATIALnet’s application 
functionality (as described throughout this manual), and their values are stored 
in the database tables and columns defined by the SPATIALnet object model. 

• They satisfy specific rules and constraints (such as valid network connectivity 
or configuration). 

• Their CAD representation is managed by SPATIALnet.  Generally, you do not use 
AutoCAD commands to create or update SPATIALnet entities, but run commands 
from the SPATIALnet menus or toolbars. 

SPATIALnet entities are defined by their data and relationships.  This is in contrast to 
CAD entities, which are defined by their geometry and appearance.  Consequently, 
many of the operations which are performed on CAD entities are not always 
appropriate for SPATIALnet entities, or do not provide the processing or rule-checking 
required to ensure that the SPATIALnet entity remains valid. 

To make it easy to differentiate SPATIALnet entities from ordinary CAD objects, 
SPATIALnet displays a special kind of “grip” called a “manipulator” when an entity is 
selected in the AutoCAD window.  SPATIALnet manipulators allow you to move, rotate, 
and perform other operations on objects in a way that ensures that the integrity of the 
underlying data model is always maintained.  SPATIALnet manipulators look different 
from AutoCAD grips and there are several of them, each with a specific function as 
shown below: 
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AutoCAD Grip SPATIALnet  
Move Manipulator 

     White/Green = Move vertex 
                  Red = Bulge  
                 Blue = Insert vertex 

SPATIALnet 
Rotate 

Manipulator 

SPATIALnet  
Port Connection 

Manipulator 

 

Figure 1 AutoCAD Grip and SPATIALnet Manipulators 

 

When you select an object in AutoCAD and one or more manipulators appear, rather 
than AutoCAD grips, you can be sure you have selected a SPATIALnet entity. 

There are other differences between the way SPATIALnet and CAD-Scraped entities 
behave.  These are described in more detail in Chapter 10. 

CAD-Scraped entities 

While SPATIALnet entities (see above) are used to model complex network data, you 
can still create many kinds of AutoCAD objects using simple AutoCAD commands, and 
SPATIALnet will save these in the database.  Whenever an area is queried from the 
database and rendered into AutoCAD, CAD-scraped entities will be included as if a 
DWG file containing that area had been opened.   

To interact with CAD-scraped entities, use normal AutoCAD commands.  These will 
work as they normally do when using AutoCAD without SPATIALnet.  See Chapter 10 
for further details of CAD-Scraped entities and the CAD-Scrape process. 

 

Layout of the screen 
If you have used AutoCAD software in the past, you will already be familiar with the 
layout of the SPATIALnet FM user interface. 
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Inside Plant Toolbars 

View 
Toolbar 

Various Application Toolbars

SPATIALnet General
Toolbar 

SPATIALnet Menus 

 

Figure 2 - A typical SPATIALnet session.  Note that the visibility of toolbars and their 
locations can be set by the user.  The arrangement may be different on different 

workstations. 

 

General SPATIALnet commands are found under the SPATIALnet menu. Commands 
relating to Outside Plant Fiber functions are under the Fiber menu.  Commands 
relating to Outside Plant Copper functions and under the Copper menu, commands 
relating to Inside Plant are found under the ISP menu, and commands relating to RF 
are found under the RF menu. 

The network details in the display window are created directly from the spatial 
database.  There are no DWG files required to produce or maintain map views. 

You use a combination of commands available from the menus, SPATIALnet toolbars 
and drag and drop functionality to interact with SPATIALnet. 
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Menus 

 

Figure 3 - The SPATIALnet menu 

 

The SPATIALnet menu is where all the commands relating to the usage of SPATIALnet 
are located. 

The Fiber, Copper, ISP, and RF menus are also shown below. 

 

 
 

 

 

Fiber Menu Copper Menu ISP Menu RF Menu 

Figure 4 

 

Note: The options that you see on the SPATIALnet menu or any of its 
submenus may differ from those above as menu layouts can be customized 
for each installation. 
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General toolbar 
As shown in Figure 2, the SPATIALnet user interface contains a toolbar that provides 
shortcuts to certain key SPATIALnet commands.  These enable you to:  

• Set the selection mode (single, multiple) or clear the current selection. 

• Examine the details of the currently selected SPATIALnet entity. 

• Bring up the data browser for the currently selected SPATIALnet entity. 

• Edit the properties of the currently selected SPATIALnet entity. 

• Edit the annotation of the currently selected SPATIALnet entity. 
• Delete the currently selected SPATIALnet entity. 

• Add annotation for the currently selected SPATIALnet entity. 
• Renumber the currently selected SPATIALnet entity.  

• Clear the selection set. 

• Toggle between single and multiple selection mode. 

• Highlight the currently selected SPATIALnet entity. 

• Clear the highlight entity(ies). 

• Use the SPATIALnet Data Dictionary tool (administrator mode only). 

The General toolbar is described in detail, below. 

 

 

Figure 5 -SPATIALnet General toolbar 

 

Note: The options that you see on the SPATIALnet toolbar may differ from 
those above. This shows the toolbar for a user with Administrator privileges. 

 

 

Button Description 

 
Activates the Current Selection dialog box that gives details about which 
entity is currently selected and what the current view type is.  

A dialog box similar to the following is displayed. 
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The fields and controls on this panel are: 

Top Field (unnamed) The current SPATIALnet view type 

Editing Mode Unused in this version 

Selection Display Manipulators: 
  Use the SPATIALnet  
  manipulators to edit  
  SPATIALnet entities. 

 Native Grips: 
  Use AutoCAD’s normal  
  grips to edit SPATIALnet  
  entities. 

Selection Mode Single:  
  Only a single SPATIALnet  
  entity can be selected at a  
  time. 
 Multiple:  
  Multiple SPATIALnet  
  entities can be selected at 
  a time. 

Current Site The current ISP Site.  This will is 
 used to locate certain ISP functions 
 within a specified site.  To change or 
 clear the selection, click on this field. 
 A pop-up menu will be displayed 
 with options Select… or Null. 

Current Theme Unused in this version 
 
Bottom Field (unlabelled) The currently selected SPATIALnet  
 entity.  (If nothing is selected 
 this field does not appear.) 

 

 
Activates the ...Details dialog box of the currently selected SPATIALnet 
entity. 
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A dialog box similar to the following is displayed:  

 

 

 
Opens the object browser window displaying a dialog box similar to the 
following: 

 

 
Opens the Edit dialog box for the selected SPATIALnet entity, allowing its 
properties to be modified. 

 
Edits selected annotation. 

 
Deletes the selected SPATIALnet entity. 

 Annotates the selected entity. 

 
Partially Annotate Selected Entity button.  This creates annotation linking 
an object to a range of pairs/fibers in a cable. 

 
Auto-renumber street addresses 

 Clears the current SPATIALnet selection (does not affect the current 
AutoCAD selection. See Currently selected entity, below). 

 
Changes the current selection mode between Single and Multiple 
selection.  Also indicates current selection mode (double arrow is 
displayed in multi-selection mode). 

 Highlights selected entity. 

 Clears the current highlight. 
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Activates the SPATIALnet Data Dictionary tool, which is only available to 
users with administrator privileges. This is used for debugging purposes 
only, and the SPATIALnet administrator may be asked to run the Data 
Dictionary tool by hotline staff when reporting a problem to extract more 
information about a particular problem.  

Table 3 – General toolbar icons 
 

Currently selected entity 
The currently selected entity (also sometimes referred to as the current entity, the 
current selection or the selected entity) is the SPATIALnet entity you have selected 
using one of the methods described below.  The selected entity then becomes the 
subject of any SPATIALnet commands that you may run (Display details, Edit, Delete, 
Splice etc.) or may supply the container for adding a new piece of equipment. 

If the selection mode set in the Current Selection dialog is set to Single, (see page 16) 
there can only be one currently selected SPATIALnet entity at any one time.  If it is set 
to Multiple, then many objects can be selected, but not all commands accept multiple 
selections. 

Several methods are available for selecting entities: 

1. Clicking on a SPATIALnet entity in the AutoCAD window will select it. 

2. Clicking a Select button on any dialog box will select the entity highlighted in 
that dialog box. 

3. When creating a new entity, there is usually an option to “Auto-select” it as 
soon as it has been created. 

Note: The current SPATIALnet selection is different from the AutoCAD 
“pickfirst” selection (usually indicated by AutoCAD grips being displayed, and 
the CAD object being highlighted with a dashed linestyle).   Setting or 
clearing one does not affect the other.  Generally, CAD-Scrape objects are 
selected and de-selected using the normal AutoCAD commands and 
keystrokes for doing this.  Any selection technique when applied to a 
SPATIALnet entity will be used to set the SPATIALnet selection.  The user does 
not have to distinguish between SPATIALnet and CAD-Scrape entities when 
making a selection as the system will ensure the correct action is taken. 
  

ToolTips 
To display a brief description of an entity, position the mouse pointer over a solid 
portion of the symbol. Rest it there briefly and a ToolTip will appear displaying the 
brief description for this entity. 

The same method can also be used on manipulators to determine their function. 

Command line 
The command line at the bottom of the screen is used to communicate information 
about what is happening and what should be done next. 
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Figure 6 - Command line 

If you are in the middle of an operation, and are unsure what to do next, check the 
command line to see if AutoCAD is prompting you to enter something. 

Dialog boxes 
Dialog boxes are used by SPATIALnet to communicate text information, or prompt for a 
response or textual input.  There are broadly three classes of dialog boxes in 
SPATIALnet, examples of which are shown below: 

 

 

 
  

 

Details Browser List Panel Edit Panel 

Figure 7 Basic Dialog Box Types in SPATIALnet 

 

Both Details Browsers and List Panels provide a window for navigating information 
presented either as a tree (browser) or a tabular list (list panel), and a set of buttons 
each of which performs a specific operation on the entity highlighted in the table or 
tree. 

The most common buttons and their uses are: 

 
Makes the highlighted entity the SPATIALnet Selected entity 
(see Currently selected entity, page 19). 
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Opens a pop-up with some or all of the following options: 

Details: Displays the entity’s details browser 

Map View: Opens a new map window in AutoCAD 
containing the highlighted entity. 

List: Displays the list of all entities of the 
highlighted type. 

Floorplan: Displays a floorplan view of an Inside 
Plant facility. 

Rack Elevation:  Displays a rack elevation view of 
highlighted Inside Plant equipment. 

Detail Drawing:  Displays a connectivity detail schematic  

showing the highlighted piece if inside 
plant equipment 

Highlight Displays the chosen object on the map 
with a highlight so that it can be 
identified. 

 

 
Begins the operation for adding a new instance of the 
highlighted type. 

 
Opens the edit panel for the highlighted entity. 

 
Deletes the highlighted entity. 

 
Allows you to associated file system documents or URLs (e.g. 
web site addresses) with the highlighted entity, or retrieve 
existing associated documents or URLs. 

 
Closes the current panel. 

 

Many more buttons are provided for performing context-specific operations which only 
apply to certain types of entities in certain situations.  These are described in the 
documentation for each function throughout this manual. 

If a button is inactive, it means that the option is unavailable because the current set 
of conditions means that it is not relevant. For example, a button might only become 
active when the correct type of entity is selected. 
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Confirmation dialog box 
SPATIALnet will display a confirmation dialog box when certain operations (for example 
Delete) are selected.  The Confirmation dialog box displays a list of entities that are 
affected by the operation. For the Delete command, the Confirmation dialog box shows 
all the entities that will be deleted as a result of deleting the specified entity. You must 
then confirm the delete operation or cancel it. 

 

 

Figure 8 - The Confirmation dialog box 

 

To confirm the operation for all entities shown in the dialog box, click Confirm. This 
deletes all the listed entities, regardless of whether or not they are highlighted. 

To find out more information on a single entity displayed in the dialog box, highlight 
the entity. The Details button becomes active. Click Details.  The ...Details dialog box 
for the selected entity appears. 

 

Note: When you select Confirm, you can only reverse the action by using the 
SPATIALnet Undo command. Undo cannot be used to reverse any command 
that was used to create, change, remove or restore a view. 

Graphical Display of Entities in SPATIALnet FM 
The display symbology of an entity in SPATIALnet FM is specified in the configuration of 
that object.  SPATIALnet looks up this configuration each time it needs to generate a 
CAD representation of the entity.  Since CAD files are not used to store data, all 
symbology is dynamically regenerated each time the system queries data from the 
database and displays it into the AutoCAD window. 

Changing window focus during commands 
SPATIALnet dialog boxes are provided as a form of communication between you and 
SPATIALnet. Basic Windows functions such as Close and Minimize are available. 
Similarly, while it is possible for many windows and dialog boxes to be open at a time, 
only one of these can be the focus of the keyboard/mouse commands.  

It is necessary for you to manually switch the focus to alternate between windows and 
dialog boxes.  

At any point, if you want to make any changes to settings on a window, you can 
switch back to the window, change the settings and then switch back to the view to 
continue the operation.  
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To switch the focus of commands to the active view, either click on the AutoCAD title 
bar or at a point within the view. This action is known as re-activating a window. 

To switch the focus to a window, click anywhere inside the window. This action is 
known as re-activating a window.  

Saving work 
For most operations run from SPATIALnet commands, the system will write any 
changes you make to the database as you go.  You will not need to explicitly save 
your work and if the system crashes, you will at worst only lose changes for a single 
operation. 

For CAD-Scrape changes, you save your work using the normal save process in 
AutoCAD.  That is, use the File > Save command, Ctrl-S or any other means for saving 
to disk.  This will also save the change to the database.   

If you have created a view and would like to retain it for use during a future 
SPATIALnet session, the view must be saved using the View Manager.  

Terminating (aborting) a command 
Some SPATIALnet commands require you to perform multiple actions, such as entering 
some information into a dialog box and using the mouse to select a placement 
position on the screen. At most points during the execution of a command, the 
operation can be aborted by pressing ESC. 



SPATIALnet FM Tutorial A Tutorial  
 

Confidential  Page 24 

 

Chapter 2 

General SPATIALnet Functions 

 

This chapter provides a brief but thorough tutorial which walks you through several 
basic processes in the system.  The tutorial is intended to help you familiarize yourself 
with the concepts and operation of the software.  If you have not used SPATIALnet FM 
before, working though this tutorial is a good place to start.  Before beginning, 
however, you should read the Introduction in the previous chapter. 

The tutorial is divided into two parts, one for outside plant and the other for inside 
plant.  The inside plant part is presented in two sections, the first dealing with the 
physical network and the second with logical circuits.   

The topics covered in each part of the tutorial are: 

 

Part A: Outside Plant (HFC and Fiber To The Home) 

• Importing some CAD backdrop with landbase and strand maps. 

• Placing a new facility.  

• Placing a new HFC node. 

• Connecting the facility to the node with a new fiber cable. 

• Splicing the fiber to create a traceable optical path between the facility and the 
node. 

• Altering landbase. 

• Creating a FTTX distribution cabinet site. 

• Creating support strand and poles. 

• Creating subscriber addresses. 

• Creating fiber taps and associating with addresses and poles. 

• Connecting Fiber and “tailing off” into taps. 

 

Part B: Inside Plant 

(Section 1) Physical Network 

• Creating a site for recording inside plant. 

• Adding floors, floorplans and equipment (racks, chasses, cards). 

• Displaying rack elevation and connectivity diagrams. 

• Connecting equipment. 
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• Connecting to Outside Plant. 

• Tracing physical connectivity between inside and outside plant. 

 

(Section 2) Logical Circuits 

• Creating a logical protocol. 

• Creating a customer and a logical service. 

• Mapping the service to inside plant equipment. 

• Configuring Routing and Multiplexing for the service. 

• Tracing the logical service. 

 

Notes: 

4. Each step in Parts A and B of the tutorial builds on activities in the 
earlier steps from that part, so you must complete the steps in the 
order they are presented. 

5. Parts A and B are independent.  You may choose to do either or both of 
these, and may do them in any order.  Sections 1 and 2 of Part B must 
be done in the order presented. 

6. You do not need to complete the entire tutorial in a single session.  
You can quit at any stage, log back in again at a later time and 
continue where you left off. 

 

Part A: Outside Plant Fiber 
Engineering and Management. 

This part of the tutorial walks you through the outside plant fiber engineering and 
management functions of SPATIALnet FM.  In the example, you will perform an end-to-
end job for designing a new fiber route for supplying signal to a node in a HFC 
network.  After completing this tutorial, you will be able to use SPATIALnet FM in most 
outside plant situations.  Where the tutorial does not cover a subject, or does not fully 
cover a function, complete details are available in the later sections of this manual. 
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Step 1: Logging On and Selecting a Job 
The first thing to do when starting any SPATIALnet session is log on to the system.  To 
start this process find the SPATIALnet FM icon on the desktop. It should look 
something similar to this: 

 
 

(Alternatively, find SPATIALnet > SPATIALnet FM under Programs on the Windows 
Start menu.) 

Depending on the level of installation, you may also have the icons shown below.  
However, these applications are not covered in this Training Manual. 

 

 

 
 

 

 

1. Double-click on the SPATIALnet FM icon to start SPATIALnet.  You will see the 
SPATIALnet splash screen, which will disappear after about 10 seconds (Hint: 
You can close the splash screen at any time by clicking on it). 

2. After a short time, the SPATIALnet login panel will appear, as shown below. 

 

  

Figure 9 - The SPATIALnet login dialog box 
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3. Type in your username and password, and select the database you wish to 
connect to (if you do not know what your username or password is, or you do 
not know which database to connect to, see your SPATIALnet administrator, or 
refer to the SPATIALnet FM Administration Manual). 
 
After you log in, the system will display the Job Selection Dialog box, similar to 
that shown below: 

 

Figure 10 - Job Selection dialog box 

 

 

4. Click on the New button to create a new Job, and supply a Job Number and 
Description that will help you identify it later and re-connect to it in future 
sessions. Do not check the “Job is to be posted before construction” checkbox, 
select Plant Update for the Job Type, and for RF Design Profile select “(no RF 
profile)”. When done, click the Add button to create the new job.  This will also 
automatically start AutoCAD. 
 

Notes: 

1. After you have created a new job, you can open it in future 
sessions by selecting it in the list shown in Figure 10, and 
clicking the Open button. 

2.  If this is the first time you have logged on to SPATIALnet FM on 
the machine you are using, or if you have just re-installed 
AutoCAD, you may see an alert box similar to the one shown 
below: 

 

 

Figure 11 – AutoCAD No Profile name alert box 
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If the above alert box is displayed, click OK and allow the 
startup process to continue (SPATIALnet creates an AutoCAD 
profile named spatialfm the first time it starts.  After this, the 
profile should be available for use and the alert will not be 
displayed in future sessions). 

 

5. When AutoCAD starts up, you should see a blank drawing, and a number of 
toolbars. 

 

Note: If this is the first time you have run SPATIALnet on the machine you are 
using, or if you have just re-installed AutoCAD, you may see a large number 
of toolbars that you will not need to run SPATIALnet FM, or this tutorial.  The 
menus and toolbars required are shown in Figure 12, below.  You should 
verify that your AutoCAD environment contains these.  Refer to AutoCAD user 
documentation for making toolbars and menus visible. 

 

  

Outside Plant 
Fiber Toolbars 

Inside 
Plant 
Toolbars 

SPATIALnet Menus 
Application-
wide 
Toolbars  

Su
St
To

pport 
ructure 
olbars 

 

Figure 12 – Toolbars and Menus for SPATIALnet FM in AutoCAD 

 

Note: The toolbars may be docked or may not be visible as shown in Figure 
12.  Right-clicking on any visible SPATIALnet toolbar pops up a menu that 
allows you to set the visibility of other SPATIALnet toolbars.  For further 
information on managing toolbars and menus, see the MENULOAD command 
in the AutoCAD Users Guide. 

 

This completes the startup process.  We are now ready to import a CAD file which will 
form the backdrop of our fiber engineering job. 

 

Step 2: CAD-Scrape Landbase and Strand 
Now that we have a running session, let’s start by importing (in the language of 
SPATIALnet, “CAD-Scraping”) an AutoCAD DWG file which contains the landbase and 
strand underlying the network we will create in the next steps. 

The steps are: 
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1. Run the AutoCAD File > Open command. 

2. Navigate to the directory containing your SPATIALnet documentation (usually 
Program Files/SPATIALinfo/SPATIALnet/blklib/dwg) 

3. Open the AutoCAD file Landbase-Strand.dwg. 

4. When the file is opened, SPATIALnet will display the following panel: 

 

 

Figure 13 – SPATIALnet Open Drawing File Dialog Box 

 

 

5. Select SPATIALnet View from the Open Drawing as pulldown list, make sure the 
other fields are filled in as shown in Figure 13 above, and click on the Continue 
button.  

6. When the graphics are visible in the AutoCAD window and the Open Drawing 
File Dialog has closed, run the File > Save AutoCAD command to import the 
graphics into the SPATIALnet database (running the Save command will 
automatically initiate the CAD-Scrape process.  The Scrape process may take a 
few minutes.  See Chapter 10 for further information about CAD-Scrape). 

7. When the scrape is complete, the system will apply the Layer Visibility settings 
to the objects imported into the database.  This may cause some of the objects 
to no longer be visible.  See Step 4, below, for controlling the visibility of 
objects in the database. 

 

When this process is complete, we now have in place the landbase and strand relative 
to which we will create our new fiber network. 

 

Notes: 

1. You can also CAD-Scrape any AutoCAD objects created during the 
session using normal AutoCAD drawing commands.  You don’t always 
have to open a DWG file.  You do have to have a SPATIALnet view 
open, however (not a native CAD file). 
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2. Any blocks scraped in must be defined either in a DWG file on the 
AutoCAD Support File path (the usual method), or in the view template 
DWT file.  CAD-Scrape only records block names; it does not read the 
block definition into the database. 

3. Properties of CAD Layers must be defined in the view template DWT 
file.  If the system renders a CAD object into a layer which is not 
defined in the view template DWT file, the default color, linetype, 
lineweight, etc. will be used. 

4. Because of points 2 and 3, the objects rendered back into AutoCAD 
after being imported using CAD-Scrape may appear different from the 
original objects.  This can be fixed by making the Layer and block 
definitions available as described in points 2 and 3. 

 

Step 3: Set Cad Layers, View Template & 
Symbol Search Path 
Every object which is represented graphically is assigned to a layer in AutoCAD (this 
applies to both CAD-Scraped and Modeled entities).  The CAD layers typically define 
such properties as color, linetype etc.  However, when SPATIALnet scrapes a CAD 
object into the database, it only saves the name of the layer on which the object is 
drawn, and not the properties associated with the layer. 

In SPATIALnet the definitions of the layers and their properties are stored in a CAD 
template file which is loaded whenever SPATIALnet opens a new drawing window.   

To select a template, use one of the following methods: 

a. Run the SPATIALnet > View > Settings…. command. 

                                       Or 

b. Click the View Settings button on the View toolbar, as shown below. 

 

 

This will display the View Settings dialog box.  Click the Edit button on the View 
Templates option to display a list of template files. 
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Click here to edit 
the view templates 

Click here to browse 
for template files 

 

Figure 14 – SPATIALnet Open Drawing File Dialog Box 

 

Click the    button to browse for templates files.  Check that the fm_training.dwt 
template is selected, (select it by navigating to the directory containing the file, 
highlighting it, and clicking the Open button in the Select Template panel).  Then click 
Done in the View Templates dialog box. 

 

Notes:   

1. The template files configured for each view type are saved against your 
user profile.  So if you log on as a different user, you may get a different 
template. 

2. If the template is absent, or the wrong template is used, all the CAD 
objects will most likely be displayed in black and white. 

 

Step 4: Control Object Visibility 
SPATIALnet allows you to control the scale at which different types of CAD objects are 
made visible when a view is rendered from the database.  By hiding detail not 
required in wide-scale views, view creation times can be dramatically reduced. 

For this exercise, we will make all objects visible at all scales.  To do this: 

1. Run the menu command SPATIALnet > View > CAD Layer Filter. 

2. Select all rows in the layer list (select the first row, scroll to the last row, hold 
down the Shift key and select the last row). 
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3. Click the Edit Zoom button on the dialog box shown in Figure 15, below. 

4. Set the Zoom Level to Zoom Level 5 (far), as shown in Figure 15, below. 

 

 

 

Figure 15 – Layer Visibility Control and Edit Zoom panel 
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5. To apply the visibility changes, refresh the CAD window by re-querying data from 
the database.  This is done by clicking on the Refresh button on the SPATIALnet 
View toolbar, shown here:  

 

 

Figure 16 – Refresh button on View toolbar. 

 

Setting Zoom Level Extents 
The above step enabled us to set the zoom level at which each object becomes visible, 
however it didn’t allow us to specify the screen extent at which each zoom level 
becomes active.  (The screen extent is the size of the area covered by the screen.)   

 

To specify the screen extent assigned to each zoom level, use one of the following 
methods to display the View Settings dialog box.  

 

a. Run the SPATIALnet > View > Settings…. command. 

                                       Or 

b. Click the View Settings button on the View toolbar, as shown below. 

 

 

Click the Edit button next to the Zoom Levels option to display the Zoom Levels dialog 
box.   
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Figure 17 – View Settings & Zoom Levels dialog box 

 

Step 5: Save View 
We have just added a new landbase area to our database, but we don’t have any 
defining features which will allow us to easily navigate back to this area in future 
sessions.  There are two ways to make this easy: “Saved Views” and “Boundaries”.  
We will save a view of this area in this step, and create a Boundary in the next step. 

A Saved View is like a bookmark or shortcut to a specific area in the database.  Once 
you have created a saved view, you can instantly navigate back to that area by 
restoring the view.   

To find the area we wish to save, locate the area labeled SHARED HUB SITE in the 
new landbase we have just scraped. (Hint: You can use the AutoCAD Edit > Find tool 
to locate this text (by typing any single word from the string) and zoom directly to the 
area.)  The area in question is shown below. 
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Figure 18 – Location of Shared Hub Site in sample Landbase-Strand 
drawing 

 

Now we will save a view which will allow us to navigate directly to the shared hub site 
in future sessions: 

1. Zoom the AutoCAD window to an extent centered on the SHARED HUB SITE 
shown in Figure 18, above. 

2. From the menu, run the command SPATIALnet  > View > Save View.  

3. Fill in the fields on the Save View As dialog box, as shown below. 

Note:  Fields flagged with a  *  are mandatory. 

 

 

Figure 19 – Saved View details 

 

4. Click the Save button. 
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To retrieve a saved view, run the menu command SPATIALnet > View > View Manager. 

Step 6: Configure a New Boundary Type 

Select the view you wish to restore from the list of saved views and click the Open>> 
button.  This will automatically zoom the view window to the extent you saved, and 
will refresh the contents of the view by re-querying from the database. Checking the 
startup view for current job checkbox will set the saved view as the default startup 
view so that everytime this job is opened it will automatically zoom to this location. 

 

To make it easier to locate and manage areas within the map, it is often convenient to 

 

ther jobs 

d 

 the map, whereas a boundary is. 

int, before you can create a boundary, you must first 

e 

andbase Definitions > 
dary 

nd fill in the field values as shown in the dialog box 

create a boundary around a specific area, such as a county, a city, the area serviced 
by a single hub, etc.  You may already have these boundaries in your existing 
landbase and/or network maps.  Once it is saved as a boundary in SPATIALnet, you can
easily search the database for an area you require and zoom to it directly.  The 
differences between a Boundary and the Saved View from Step 5 are: 

• A Saved View is visible only in the job in which it was created.  O
cannot see it, and it disappears when the job is Posted or Cancelled.  A 
boundary, however, is visible to everyone once it is Published or Posted, an
persists in the database until it is deleted. 

• The outline of a Saved View is not visible on

• There is only one type of Saved View, but you can configure as many types of 
Boundary as you wish. 

As implied by the last bullet po
ensure that the type of boundary you with to create is in the Boundary Definitions 
dictionary.  Let’s assume it is not, and use this example as an opportunity to configur
a new type of Boundary.  Looking ahead to the type of site we will add in Step 7, let’s 
call this new type of boundary a “Shared Hub” boundary. 

1. From the menu, select SPATIALnet > Dictionaries > L
Boundary Definitions….  A dialog box will be displayed, listing all the boun
types currently defined. 

2. Click on the Add button a
below: 
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Figure 20 – New Boundary Dictionary Entry Form 

 

3. Click on the Add button shown in Figure 58 to create the new Boundary Type.  
It should now be listed in the Boundary Definitions list. 

4. Click the Close button on the Boundary Definitions list. 

Step 7: Add a New Boundary 
Now let’s draw a boundary of type “Shared Hub” around the map area we imported in 
Step 2, and shown in Figure 18. 

1. Make sure the area shown in Figure 18 is visible on the screen.  If it is not, run 
the menu command SPATIALnet > View > View Manager… to bring up the Saved 
Views dialog box, highlight the view named “SHARED HUB SITE”, and click on 
Open>>.  Zoom until you have the area you need in the window, and use the 
Refresh button on the View toolbar if you need to bring in more data from the 
database. 

2. From the menu, select SPATIALnet > Add > Landbase > Boundary… to bring up 
the Boundary Creation dialog box.   

3. Fill in the fields of the Boundary Creation dialog box with the values shown 
below. 
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Figure 21 –Boundary Creation dialog box 

 

4. Click the Add button shown in Figure 21.  This will bring up the Line Capture 
Control panel, as shown in Figure 22, below. 

5. With the Vertex Mode cross-hair button selected in the Line Capture control 
panel (see Figure 22, below), click on each point at which you wish to place a 
vertex of the boundary. 

6. Click the Close button as shown in Figure 22, below when done.  This will close 
the boundary polygon geometry and complete the addition of the new 
boundary. 

7. Click the Close button on the Boundary Creation dialog box. (Clicking the Close 
button the Line Capture control panel will refresh the Boundary Creation dialog 
box, allowing for a new boundary to be created, if needed.) 
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Digitize each 
vertex of the 
boundary by 
clicking at the 
vertex location 

…etc. for all vertices 

Click “Vertex Mode”  
           cross-hair  

Click “Close” to 
   complete polygon 

     when done 

 

Figure 22 – Capture Boundary Vertices 

 

Step 8: Editing Boundaries  
Once you have added a boundary it may become necessary to edit or change its 
properties or geometry. 

 

Editing Boundary Properties 
To edit a boundary’s properties, first click on the boundary, and then click on the Edit 
Selected Entity button on the General toolbar. 

 

 

Figure 23 – Edit Selected Entity button on General toolbar 
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This action will display the Boundary Modification dialog box.  Edit the properties as 
required, then click Apply. 

 

 

Figure 24 – Boundary Modification dialog box 

 

Editing a Boundary Geometry 

Moving a Vertex 

To change the geometry of a boundary by moving a vertex using SPATIALnet 
manipulators:  

1. Click on the manipulator and drag it to the required position and click on the 
mouse button.   

2. A pop-up selection box will appear.  Highlight and click on the Move to 
location… option.   

3. The boundary geometry will now be updated to include the newly updated 
vertex. 

 

 

Figure 25 – Moving a vertex 

 

Deleting a Vertex 

To change the geometry of a boundary by deleting a single vertex: 
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1. Click on the manipulator at the vertex to be deleted, drag it, then click on the 
mouse button.   

2. A pop-up selection box will appear.  Highlight and click on the Delete vertex  
option.   

3. The boundary geometry will now be updated with the deleted vertex removed. 

 

 

 

Figure 26 – Deleting a vertex 

 

 Deleting Multiple Vertices 

To change the geometry of a boundary by deleting multiple vertices in a sequence: 

1. Click on the manipulator at one of the end vertices, and drag it and place it 
over the vertex at the other end of the sequence.  

Note: The selected end vertices will not be deleted, only the 
intervening vertex/vertices will be deleted. 

2. A pop-up selection box will appear.  Highlight and click on the Delete multiple 
vertices option.   

Note: When dragging the first end manipulator, make sure that you 
place the mouse directly over the corner of the second end 
manipulator, or else the Delete multiple vertices option will not appear. 
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Figure 27 – Delete multiple vertices 

 

3. The boundary geometry will now be updated with the deleted vertices 
removed. 

 

Step 9: Working with Manipulators and 
Linear Edit Modes 
Manipulators provide many different ways of editing linear geometry. Linear 
manipulators are controlled by the Manipulator Edit Modes panel, which we will learn to 
use in this step. 

 

To display the Manipulator Edit Modes panel: 

1. Select the Spatialnet   >  Linear Edit Modes… option which will produce the 
Manipulator Edit Modes panel, shown below. 

 

 

Figure 28 – Manipulator Edit Modes Panel 
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The Manipulator Edit Modes panel contains the following fields: 

 

No Manipulators 

Selecting this option removes the manipulators from the map view. 

 

 

Figure 29 – Boundary view without 
manipulators 

 

Default Mode 

This option displays the manipulators on the map view. 

 

 

Figure 30 – Boundary view with manipulators 

 

Edit bulges 

Note: “Bulge” is defined mathematically as tan(θ/4) where θ is the angle 
included in the arc. 

Selecting the Edit bulges option on the Manipulator Edit Modes panel (see Figure 28) 
places an additional manipulator (displayed in red) in between the default 
manipulators. Clicking and dragging a red manipulator “bulges” a line segment 
allowing polylines to include curved arcs. 

 To edit a “bulge”:  

1. Click and drag a red manipulator. 
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2. When the desired curvature is achieved, left click the mouse, and then click on 
the pop-up, as shown below. 

 

 

Figure 31 – Additional red 
manipulators placed between 

default manipulators  

Figure 32 – Red manipulator 
“dragged” to produce an arc. 

 

Edit Vertices 

Selecting the Edit Vertices option on the Manipulator Edit Modes panel (see Figure 28) 
places an additional manipulator (displayed in blue) in between the default 
manipulators. Clicking and dragging a blue manipulator inserts a vertex into an 
existing line segment. 

To insert a vertex into an existing line segment:  

1. Click and drag a blue manipulator. 

2. When the desired line shape is achieved, left click the mouse, and then click on 
the pop-up, as shown below. 

 

 

Figure 33 – Additional blue 
manipulators placed between 

default manipulators  

Figure 34 – Blue manipulator 
“dragged” to produce a line 

segment. 

 

Rotate Entity 

Selecting the Rotate Entity option on the Manipulator Edit Modes panel (see Figure 28) 
enables the user to rotate the boundary about its centroid. The user can either 
manually rotate the boundary, or else specify the rotation angle by typing in the 
desired number. 
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To rotate an entity, either:  

1. Click and drag a manipulator. 

2. When the desired rotation is achieved, left click the mouse, and then click on 
the pop-up, as shown below. 

 

                                                Or 

 

1. Click and drag a manipulator. 

2. Type in the desired angle of rotation (in degrees), and press Enter.  A pop-up 
will appear.  Click on the pop-up, as shown below. 

 

 

Figure 35 – Rotation manipulators  Figure 36 – Rotation manipulator  
“dragged” to rotate boundary. 

 

 

Translate Entity 

Selecting the Translate Entity option on the Manipulator Edit Modes panel (see Figure 
28) enables the user to move the entire boundary to a new location without changing 
its shape, scale, or rotation.  

To translate an entity:  

1. Click and drag a manipulator. 

2. When the desired location is achieved, left click the mouse, and then click on 
the pop-up, as shown below. 
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Figure 37 – Translate  
manipulators  

Figure 38 – Translate manipulator 
“dragged” to new location. 

 

Reshape Entity 

Selecting the Reshape Entity option on the Manipulator Edit Modes panel (see Figure 
28) places an additional manipulator (displayed in red) in between the default 
manipulators, enabling the user to reshape the boundary.  When a red manipulator is 
clicked on and dragged, the Line Capture Controls panel is displayed, allowing the line 
segment to be replaced by a new set of segments captured using the tools on the line 
capture panel. (See Spatialnet FM User Manual for details on how to use the Line 
Capture Controls panel.)  

To reshape an entity:  

1. Click and drag a red manipulator. 

2. Enter the desired data into the Line Capture Controls panel. 

 

 

Figure 39 – Reshape Entity 
manipulators  

Figure 40 – Reshape Entity 
manipulator “dragged” to display 

Lind Capture Controls panel. 

 

Orthogonal Line 

The option is not used for OSP. 

 

Using AutoCAD Grips instead of SPATIALnet Manipulators. 

It is possible to use the normal AutoCAD grips to edit the geometry of SPATIALnet 
entities, instead of manipulators.  This allows you to use AutoCAD drafting functions to 
edit the geometry of modeled entities. However, it also disables the ability to select 
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modeled entities from the map and run the SPATIALnet functions associated with them.  
“Native Grips” are useful when: 

• The geometry editing you need to perform is not supported by SPATIALnet 
manipulators (e.g. the AutoCAD STRETCH command), or is more easily done using 
AutoCAD functions. 

• You wish to edit many objects at once (e.g. move all objects within an area 120 
feet to the north). 

 

To use normal AutoCAD grips instead of SPATIALnet manipulators: 

1. Click the Current Selection button    on the General toolbar. The will display 
the SPATIALnet Current Selection panel. 

2. Click on the Selection Display: dropdown menu, and highlight and click on the 
Native Grips option, as shown below. 

 

 

Figure 41 – SPATIALnet Current Selection panel 
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The differences between Native Grips and Manipulators modes are described below: 

 Native Grip Mode Manipulator Mode 

Grip Display Normal AutoCAD Grips SPATIALnet Manipulators 

Selection Behavior Additive (selecting one or more objects 
adds them to the current selection set) 

Depends on whether Single or 
Multiple selection mode enabled. 

Drafting Operations Normal AutoCAD drafting operations 
available for all objects. 

Normal AutoCAD drafting for 
CAD-Scraped entities, 
manipulators for Modeled entities. 

Snap Modes All AutoCAD snap modes work All AutoCAD snap modes work 
except for ORTHO. 

Save Changes Modeled entities saved to database immediately, CAD-Scraped entities only 
saved when the AutoCAD Save function is run. 

SPATIALnet functions Most SPATIALnet functions are not 
available for any entities.  Eg, it is not 
possible to select a modeled entity, 
display its details, edit its properties, 
etc. 

SPATIALnet functions are available 
for modeled entities. 

 

 

• SPATIALnet manipulators will no longer appear, and will be replaced by 
AutoCAD grips. 

• All normal AutoCAD drafting functions will work. 

• All of AutoCAD snap modes with work. 

• Changes made using the AutoCAD editor will be immediately saved to the 
database, even for SPATIALnet modeled entities, but will still require the use of 
the Save button for CAD scraped entities. 

• No SPATIALnet functions are available in native edit mode; e.g., it is not 
possible to select a modeled entity, display its details, or edit its properties.  

 

Note: If the SPATIALnet Manipulators option is selected, AutoCAD author 
modes will NOT work.  

 

Step 10: Configure Network Support 
Structures 
Before we add any FTTX equipment, we must extend the support network along the 
path the network will follow.  SPATIALnet FM provides a configuration dictionary for 
specifying the types of support structures (Poles, Manholes Vaults, etc.) in your 
system, and the linear support that connects them (strand, trenches, etc.)  The 
process is very similar to those you have already seen. 

As a concrete example, we will configure the Joint-use Pole type, prior to adding a run 
of Joint-use Poles to the network map. 

To configure a type of support structure: 
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1. Run the menu command SPATIALnet > Dictionaries > Support Structure 
Definitions   

2. Select Joint from the displayed list. 

3. Click the Edit button.  A Panel similar to that shown below should be 
displayed.  Edit the values to match those shown. 

 

 

Figure 42 – Configure Network Support Structure. 

 

4. Click the Apply button to commit the changes to the database 

5. Close both the Edit Support Structure Definition panel, and the Support 
Structure Definitions list panel. 

 

Note that the panel shown in Figure 42 allows you to use your own strand symbol 
library, and configure the system’s design functions to work with it. 
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Step 11: Add New Poles and Strand 
Having configured the Joint-use Pole type, let’s now run a set of Joint Use Poles.  To 
do this: 

1. Select the Joint Pole button on the Strand toolbar.  
 

 

 

2. A panel similar to that shown below will appear.  Enter desired values for 
the fields, and click back in the AutoCAD window to place a new pole on the 
map.  (Note the first click will transfer input focus to the map window, 
subsequent clicks will add a new Pole with the values specified in the dialog 
box). 

 

 

Figure 43 – Pole Creation Panel 
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3. Run a line of Joint-use poles following the road-edge, similar to that shown 
below. 

 

Figure 44 – New Poles 

 

4. To add strand linking the poles, select the Draw Strand button on the Strand 
toolbar. 

 

 

5. Draw a single line passing close to the center of each of the poles.  There is 
no need to draw separate lines between each pole, or to add a vertex at 
each pole.  The system will segment the strand lines automatically. 

6. When you have finished drawing the strand lines, run the AutoCAD Save 
command.  This will segment the strand line and attach each strand 
segment to the poles at which it starts and ends. 

7. To edit the footages of each strand segment: 

• Select the segment (click on it in the map window). 

• Grab the middle manipulator and drag (and drop) it on the side where 
you want the distance placed – click on “Add footage to this Side of 
Line”.  
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Figure 45 – Add footage pop up 

 

• The Strand Modification dialog will appear, enter the strand segment 
length, and click Apply. 

 

 

Figure 46 – Strand Modification dialog box 

 

The Strand Details dialog box and the map will be updated automatically. 

When done, the new strand should look similar to that shown below: 
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Figure 47 – New strand connecting the poles 

 

 

Step 12: Add Pedestals 
 
Let’s now move to the underground plant, with our first task being the placement of 
pedestals.   

To place a pedestal (or any other underground structure): 

 

1. Click the Add Drop Pedestal button on the Trench toolbar, as shown below, or 
select SPATIALnet > Add > Support Structure > UG Structure from the menu. 

 

 

2. The Underground Structure Creation panel similar to that shown below will be 
displayed. 
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Figure 48 – Underground Structure Creation Panel 

 

3. Choose the structure type to be added, and fill in other information as 
required. 

4. Click on the map location at which each pedestal is to be placed.  It will be 
displayed on the map. 

5. Add the remaining pedestals to complete the design. 

 

 

Step 13: Add Trenches 
In SPATIALnet, underground routes containing conduits and/or cables are referred to 
as “Trenches”.  In this step, we will create the trenches which link the underground 
housings (pedestals, etc.) that we have placed so far.  To create a trench: 

1. Click the Add Trench button on the Trench toolbar, as shown below, or 
select SPATIALnet > Add > Support Structure > Trench  from the menu. 

 

2. The trench tool begins the AutoCAD POLYLINE command and sets the 
currently layer to the layer on which trenches were configured in the 
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dictionary.  Digitize the route of each trench using the AutoCAD drafting 
functions available in the POLYLINE command. 

Notes:  

1. Unlike other linear objects in SPATIALnet, trenches (and aerial 
strand lines also) are first drafted as CAD Polylines.  When the 
AutoCAD “Save” function is run, SPATIALnet automatically 
“promotes” each CAD Polyline to a modeled trench line.  The length 
attribute of the line is initially set to 0, and the trench is connected 
to the start and end housings at either end of the line. 

2. SPATIALnet will only “promote” Polylines that meet  the following 
criteria: 
(a) They are on the correct layer 
(b) They begin and end at an underground support structure 
(c)  They pass close to the insertion point of any housings part way 
along the Polyline (SPATIALnet will break the trench into individual 
segments which begin and end at each intermediate structure). 

3. If any Polyline segments fail to meet the conditions in 2, they will 
not be “promoted” to trenches.  Instead, they will be moved to 
Layer 0.  You may then correct the problem, move the polyline onto 
the correct layer and try to save/promote again. 

 

Step 14: Edit Trench Footages 
Linear support structures (trenches and aerial spans) provide a unique way for editing 
their lengths. When a linear support structure is selected in SPATIALnet, a special red 
manipulator is placed at the center of the line when the linear object is selected.  This 
manipulator can be used to enter or update the length property of the linear support 
object. 

To edit the length of a trench, 

1. Select the trench whose length you wish to edit. 

2. A red Length manipulator will be displayed, as shown below. 

 

 

Length Manipulator 
 

Figure 49 –Edit Length manipulator on selected trench line 

 

3. Drag the manipulator to the side of the trench line on which you want to 
display the length annotation.   
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4. Click the Add footage to this side of line option on the pop-up, as shown 
below. 

 

Figure 50 –Selecting side on which length annotation will be placed 

 

5. The Trench Modification panel will be displayed, and the cursor 
automatically placed in the Length field.  Type in the length you wish to 
assign to the trench segment as shown below. 

 

 

Figure 51 –Editing Length in the Trench Modification Panel 

 

6. Hit Enter on the keyboard to accept the footage and commit it to the 
database.  Annotation should be displayed on the side of the line you 
chose, displaying the footage you entered. 

7. Repeat the above process to specify the lengths of the remaining trench 
segments in the new subdivision. 

 

Step 15: Add Duct Forms 
Having established the routes of the trench and entered the length of each segment, 
let’s now specify the ducts and inner ducts, if any, in each trench. 
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SPATIALnet has a sophisticated conduit and duct manager, which we will use to add 
various duct configurations to our subdivision. 

Let’s begin by adding four 6” PVC ducts in a 2x2 grid to one of the trenches we 
created.  We shall explore how to change the duct configuration shortly. 

To add the bank of ducts: 

1. Select the trench to which the duct bank is to added. 

2. Click the Add Ducts button on the Trench Toolbar, as shown below: 

 

3. The Add Ducts… panel will be displayed.  Fill in the values as shown below 
and click the Add button. 

 

 

Figure 52 – Add Ducts panel 
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4. The system will automatically display an array of ducts matching the 
specifications in the Add Ducts panel and place this near to the trench as 
shown below: 

 

 

Duct Forms  

Figure 53 – Add Ducts panel 

 

5. Place other duct forms around the subdivision. 

Note: The way the duct forms are displayed depends on the values configured 
in the Duct Radius dictionary for each Duct Size, and for the Grid Size. 

 

 

 

 

Step 16: Edit Duct Forms 
Existing duct forms can be edited, both in terms of the number and configuration of 
the ducts, and the information associated with each duct. 

To edit information ducts in a duct bank: 

 

1. Select either the duct bank itself by clicking on any of the duct graphics, or 
select the trench segment to which it belongs by clicking on the linework. 

2. Click the Edit button on the General toolbar, as shown below. 
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3. The Edit Duct Information panel will be displayed.  Select each duct in the 
list to the left, and edit its properties in the fields to the right.  When you 
wish to commit the changes to the database, click the Save button. 

 

Figure 54 – Edit Duct Information 

 

Note: When the Duct Name of each duct is filled in,  SPATIALnet automatically 
displays the name on the duct form shown on the map. 

 

SPATIALnet displays manipulators To change the geometry arrangement of the duct 
forms.  A manipulator is provided for each duct, allowing the ducts to be moved 
individually.  Another manipulator is provided which allows the duct bank to be moved 
and rotated as a whole. 

 

4. Use both the individual and bank-wide manipulators to rearrange the layout 
of the ducts into a 4x1 row, similar to that shown below. 

 

Figure 55 – New Duct Configuration 

 

 

5. Use the Delete button on the Edit Duct Information panel to remove duct D 
from the above configuration. 
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Step 17: Add New Ducts and Inner-ducts 
The number of ducts in a bank can be changed by using the Add Ducts tool.  Ducts of 
any size can be added to a duct bank, and they can be added as inner-ducts, or sub-
ducts, of the existing ducts. 

To add new ducts to a duct bank: 

1. Select the duct bank into which the new ducts are to be placed. 

2. The Add Another Duct panel will be displayed, as shown below. 

 

 

Figure 56 – Add another duct panel 

 

 

3. Specify the name of each new duct and click the Add button to add it to the 
duct bank. 

 

To add ducts as inner ducts, or subducts, of the existing ducts, check the Add as 
subduct box on the Add another duct panel shown in Figure 56.  This displays the duct 
configuration in the right window of the Add another duct panel, as shown below.  You 
can choose the outer duct for the new subduct either by clicking on the diagram, or on 
the list of ducts. 
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Figure 57 – Add a subduct 

 

 

 

Step 18: Add New Site Type  
The next thing we will do is place a new network building (also referred to as a 
“facility” or “site”).  Before we can create a new facility and place it on the map, we 
must first ensure that its characteristics have been defined in the system’s Site 
Dictionary (as a general rule, this is true for all network entity types managed by the 
system).  Most of the time, the dictionary will contain the type of object you wish to 
create and you will not need to perform the actions described in this step.  However,  
assume that this time, the kind of site we need to create—let’s call it a Shared Hub—is 
new to the system and therefore, not in the Site Dictionary.  Let’s see how the 
characteristics of a new kind of facility (including its display symbology) are stored as 
a Site Type. 

The steps for creating a new Site Type are: 

1. From the menu, select SPATIALnet > Dictionaries > Other Definitions > Site 
Definitions...  A dialog box will be displayed, listing all the site types currently 
defined. 

2. Click on the Add button and fill in the field values as shown in the dialog box 
below: 
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Figure 58 – Add Site Definition dialog box 

 

3. Click on the Add button shown in Figure 58 to create the new Site Type.  It 
should now be listed in the Site Definitions list. 

A very useful feature of the various configuration dictionaries is the ability to nominate 
certain attributes of an object to be displayed as annotation.  This is done by mapping 
a database field stored against the object to an AutoCAD attribute definition in the 
block used to represent the object.  When such a mapping exists, SPATIALnet will 
automatically fill in the block attributes with the values stored in the associated 
database field. 

An attribute mapping may be of one of the following types: 

• Pre-defined field. 

• Custom attribute. 

Pre-defined fields are those which appear on the various panels by default.  These are 
supplied by the system and cannot be changed. 

Note: Pre-defined fields are only pre-defined in the database and on the 
panels.  They are not pre-assigned to AutoCAD block attributes.  You must 
perform the steps below to make them appear as annotation. 

In addition to pre-defined fields, the system allows up to 15 custom attributes to be 
defined.  This allows you to add your own properties to each type of object, store 
these in the database and, if desired, display them as annotation on the map views. 

Items 4 to 7 below illustrate the process for adding a new custom attribute to the 
system.  Suppose that you wish to track another piece of information about each 
Shared Hub, in addition to the attributes that SPATIALnet FM supplies by default.  For 
example, let’s say you wish to record the square footage of floorspace your equipment 
is occupying in the shared facility.  To do this: 

4. Select the Shared Hub entry you just created in the Site Definitions list. 
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5. Click the Attributes button on the list panel.  Since there are no attributes 
mapped for the Shared Hub type, the Attribute Mapping list will initially be 
empty. 

6. Click the Add button on the Attribute Mapping list panel.  This will allow you to 
specify the details of the new attribute you wish to associate with Shared Hub 
records.   

7. Fill in the fields of the Add Attribute Mapping panel, as shown below. Click the 
Add button when done, then close the Site Definitions and Attribute Mapping 
panels. 

 

 

Figure 59 – Adding a custom attribute to the Shared Hub type. 

 

You should also try to map a pre-defined field to an AutoCAD attribute.  The hub.dwg 
file already contains an attribute definition with attribute tag NAME.  This is intended to 
display the name of the site, but will not do so until an Attribute Mapping is created 
which maps the pre-defined field Designation to the NAME attribute tag.  You should 
create this now, using the same process as described in items 4 – 7, above.  

Notes: 

1. The SPATIALnet Attribute field shown in Figure 59 determines which 
database column contains the values for the attribute.  The choices in 
the pull-down list fall into two groups: 
(a) All of the pre-defined fields specified by SPATIALnet for the type 
 of object being configured. 
(b) A set of 30 placeholders for custom attributes, labeled 
 SPATIALnet FM Attribute 1 to SPATIALnet FM Attribute 30. 

2. The Attribute Tag field provides you with the option of tying your custom 
property to an AutoCAD block attribute.  This allows you to display the 
property as annotation text associated with the type’s symbol. To 

Confidential  Page 63 



Step 19: Add New Site  SPATIALnet FM Tutorial 
 

Page 64  Confidential 

display this property as annotation using a block attribute: 
(a) In AutoCAD, open the DWG file containing the block associated  
 with the type being configured in the dictionary.  This will be  
 hub.dwg in the current example (if you are running SPATIALnet,  
 open it as a “native drawing”).  Note that the block files supplied 
 with SPATIALnet (including hub.dwg) are stored in the 
  Symbol\smt sub-directory of the SPATIALnet installation folder. 
(b) In the block’s DWG file, Create an attribute with a Tag that  
 matches the value you entered into the Attribute Tag field in  
 Figure 59 (USED_SQ_FTG in this example).  Details for adding block 
  attributes can be found in the AutoCAD Users Guide under the  
 ATTDEF command. 
(c) Save the block DWG file. 

3. The system is supplied with the file hub.dwg, which will be used to 
represent the Shared Hub in this exercise (you can find it in the 
Symbol\smt sub-directory of the SPATIALnet installation folder).  You can 
create your own block, however, and use it instead.  

4. If you change any of the display characteristics of a device type, those 
characteristics will be used to render the device the next time a view is 
created in AutoCAD.  Network characteristics however (such as 
number of ports) will only affect new instances of the type.  Any 
existing instances will continue to use the values present when they 
were created.  

Step 19: Add New Site 
Now that we have defined the “Shared Hub” site type, we can create an instance of it 
in the database. 

To do this, find the location labeled SHARED HUB SITE and zoom to it, as described in 
Step 4 above.  To add the new site: 

1. From the menu, run the command SPATIALnet > Add > Other > Site…. 

2. Fill in the fields of the Building Creation dialog with the values shown in Figure 
60, below (Note: for this exercise, it is important to ensure that the Capable of 
modeling inside plant check box is cleared.  We’ll visit inside plant in Part B of 
the tutorial.) 
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.  

Figure 60 – Building Creation Dialog 

Notes:  

1. The grid control showing the custom Used Square Ftg. attribute 
you added in Step 18 will only become visible when you select 
Shared Hub in the Facility Type field. 

2. To update the value of a custom attribute in the grid control, 
double click on the cell in the right hand column, into which you 
can then type the value. 

 

3. Ensure that the “Placement” cross hair is selected (in the depressed position) 
in the Building Creation Dialog, as shown in Figure 60, above, and also here: 
 

 

4. Place the new Shared Hub on the map by clicking twice on the location shown 
below (first click to set input focus back to the drawing window, second click to 
place the new entity). 
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Figure 61 – Place new Shared Hub SH-01 

 

Notes:  If you added the USED_SQ_FTG block attribute as described in Step 
18, you will also see the value of Used Square Ftg. shown on the map.  This is 
not shown in Figure 61, above. 

 

Step 20: Document References 
SPATIALnet provides the capability for attaching references to files, programs, 
websites, URL’s, etc. to any object in the system. This can be useful for making all the 
information associated with an object or job easily accessible from one place. 

Note: The SPATIALnet database only stores a reference to the document, and 
not the document itself.  If the filename or path changes, the reference will 
no longer be valid.  

 

Attaching a Document Reference 
To attach a reference to an object: 

1. Select the object by clicking on it. 

2. Click the Details of Selected Entity button on the General toolbar. 

 

 

 

3. This will display the Site (OSP) Details dialog box, shown below. 
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Figure 62 – Site (OSP) Details dialog box 

 

4. Click on the Add >> button and then select the Document… option from the 
pop-up.  

 

 

Figure 63 – Site (OSP) Details dialog box 

 

5. This will produce the Document Reference Creation dialog box, shown below. 
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Figure 64 – Document Reference Creation dialog box 

 

6. Enter the document title in the Document Title field. (The asterisk indicates that 
this field is mandatory.) 

Note:  The document title can be any text you wish, and does not have 
to correspond with the document file name. 

7. Enter the appropriate document file name in the Document File Name Field. 

(Click on the    button to browse for file name.) 

8. Click the Add button, then click the Close button. 

9. The document reference should now be visible in the Site (OSP) Details dialog 
box. 

 

 

Figure 65 – Document Reference Creation dialog box 
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Deleting a Document Reference 
To delete a reference to an object: 

1. Select the object by clicking on it. 

2. Click the Details of Selected Entity button on the General toolbar. 

 

 

 

3. This will display the Site (OSP) Details dialog box, shown below. 

 

 

Figure 66 – Site (OSP) Details dialog box 

 

4. Highlight the reference to be deleted, and click on the Delete button.   
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5. This will display the Entities being deleted dialog box, shown below. 

 

 

Figure 67 – Entities being deleted dialog box 

 

6. Click the Confirm button.  The deleted document should now no longer be 
visible in the Site (OSP) Details dialog box. 
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Chapter 3 

Addresses and Service Areas 

 

This chapter reviews the management of service addresses in SPATIALnet.  Service 
addresses are typically used to represent residential service addresses for both 
single and multiple dwelling units, and for small businesses.  Larger sites, for 
example a major office complex or large institution, are usually modeled using 
SPATIALnet’s inside plant tools. This is because providing service to these sites 
normally involves the deployment of devices of various kinds, rather than just the 
installation of a drop line. 

Included in this chapter is an introduction to the use of Service Areas.  Service 
Areas are boundaries (defined in the Landbase Boundaries dictionary) with a 
special feature, in that they can automatically locate all addresses contained within 
them, and assign those addresses to the boundary.  This is particularly useful for 
finding all addresses contained with, for example, a Telephone Rate area or an 
HFC Node boundary.  

 

Step 21: Extend Landbase 
Let’s now prepare to design a new residential distribution network.  Let’s assume the 
homes to be fed are in a new subdivision whose landbase is not yet completely 
captured in the system.  So, our first step is to update the landbase to include the 
changes made in the subdivision.  The area we will be working in is shown below: 
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Figure 68 – Location of new area in existing landbase 

 

Our first task is to complete the landbase by joining the partially drawn roadway to 
the existing road.  This can be done using normal AutoCAD operations (not covered in 
this course), and running the AutoCAD Save function when done.  The end result 
should look similar to that shown below: 

 

 

Eventual location of 
new    FTTX 
Distribution Cabinet 

 

Figure 69 – Completed new road edge, showing location of new FTTX cabinet 

 

Step 22: Add Street Centerlines 
Altering the CAD graphics for the road edge, as in Figure 9, only provides a visual 
indication that the new roads exist. However, since there is no intelligence behind 
these CAD line segments they cannot be used as a means for searching the database 
for roads, addresses, etc. To create an intelligent representation of the new roads we 
must add Street Centerlines to the map. 

To add Street Centerlines: 
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1. Select SPATIALnet > Add > Landbase > Road or click the Add Road button on 
the Landbase toolbar. 

 

 

 

2. This will display the Road Creation dialog box.  Fill out the box, as shown 
below. 
Note:  Make sure the City field is filled out. Although it is not 
mandatory, it is needed for later steps. 

 

 

Figure 670 – Road Creation dialog box 

 

3. Click Add to bring up the line capture controls and run a centerline down 
the middle of the road, as show below.   

4. Repeat again to create four centerlines, and name the roads SOUTHLINK 
CT, NORTHLINK CT, CENTERLINE RD, and NEW RD, as shown below. 
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Figure 71 – Creation of centerlines 

 

 

Step 23: Configure Service Area Boundary 
There are many cases where a geographical boundary is used to delimit a particular 
characteristic of a distribution network.  For example, a telephony rate center area 
denotes the region within which all addresses are assigned a specific rate code.  
Alternatively, it is common practice to draw a boundary enclosing the geographical 
area which is served by a single network distribution point, such as a specific Optical 
Node in an HFC network, or a particular distribution cabinet in an FTTX network. 

When such boundaries are used, it is convenient to assign each address which is 
located within that boundary to the boundary itself.  In this way, addresses can be 
automatically allocated to the correct rate center, distribution area, etc. with no input 
required from the user. 

In SPATIALnet FM, this automatic association between addresses and certain boundary 
types can be made via the use of Service Boundaries.  A Service Boundary is a normal 
geographical boundary, with the added feature that any address placed within that 
boundary will be automatically associated to that boundary in the database.  
SPATIALnet FM supports up to 3 different types of service boundaries (e.g. so that an 
address can simultaneously be associated with (say) a telephony rate center, a 
distribution node boundary, and a dispatch area).  The remainder of this step explains 
how Service Boundaries are configured. 

 

To configure a service boundary: 

1. Select SPATIALnet > Dictionaries > Landbase Definitions > Boundary 
Definitions… to display the Boundary Definitions dialog box.  
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Figure 72 – Add Boundary Definition dialog boxl 

 

2. Click the Add... button to display the Add Boundary Definition dialog box.  

3. Fill out the fields, as shown below, then click Add.  Note that the Service 
Area Type field should be set to 1, as shown below.  This will define the 
Rate Center boundary as the first of the three available Service Area 
types.  In turn, this will allow SPATIALnet FM to automatically associate 
the boundary to any addresses located within the area it encloses (we 
shall see this in practice below). 

 

 

Figure 683 – Add Boundary Definition panel 

 

4. Click the Close button. 
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Step 24: Add Service Area Boundary 
Now that we have configured FTTP Distribution areas as a Service Area Boundary 
type, we will add one to our map.   Specifically, we will draw the boundary which 
encloses the area fed by the FTTP Distribution Cabinet we will place in Step 47.  
Because FTTP Distribution areas are configured as a Service Area, any addresses 
included in that area can be automatically associated with the boundary. 

 

The process for adding a service area boundary is identical to adding any other 
boundary (see Step 7): 

1.  Select the menu option SPATIALnet > Add > Landbase > Boundary… or 
click the Add Boundary button on the Landbase toolbar. 

 

 

 

2. This will display the Boundary Creation dialog box.  Fill out the fields, 
and click the Add button, as shown below. 

 

 

Figure 694 – Boundary Creation dialog box 

 

3. Draw the boundary on the map, similar to that shown below.   
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Figure 705 – Boundary Creation on map 

 

Note the Display Service Area Manager Panel check box. If checked when we add 
a service boundary, the service area manager dialog box is displayed, providing 
options to list or assign addresses or devices within the boundary area (none yet in 
this area). 

 

 

Figure 716 – Service Area Manager panel displaying List options and Assign 
options available. 
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Step 25: Adding Buildings and Addresses 
(Manual Addition) 
Having captured the pole and strand network, let’s now add the addresses which will 
be connected to the network.  As with all other data types managed by the system, 
address types are configured in the Address Definitions table, under the STATIALnet  > 
Dictionaries  >  Landbase Definitions > Building Definitions … menu.  The process for 
configuring new addresses is almost identical to that for configuring new site types 
(see Step 18) so we won’t repeat it here.  Your database should already have an SDU 
address type configured in it (if it does not, you can configure it now.  The symbol 
sdu.dwg is provided in the library for this purpose). 

To add addresses to the system: 

1. Run the menu command SPATIALnet > Add > Landbase > Address… 
or 
Click the Add Building and Addresses button on the Landbase toolbar 
 

 

 

2. A panel similar to the one below will appear.  Fill in the values as shown. 

 

Figure 727 – Building Creation dialog box 

 

3. Click on the AutoCAD map area once to transfer the input focus, and then 
click once at the location of the first new address. 

4. Switch the Operational Mode to Selection (click on the arrow button, not 
the cross-hairs shown in Figure 77Error! Reference source not found.). 
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5. Rotate the address to be 90º to the road edge (drag the rotation 
manipulator onto the road-edge and select 90º to … in the pop-up).  The 
system will remember the rotation of this address, and will place all 
subsequent addresses at this rotation. 

6. Change the Operational Mode back to Placement (click on the cross-hairs in 
Error! Reference source not found.).  Then add a sequence of new 
addresses to the map, just by clicking at the location of each one.  Note 
that the address number will automatically increment by the value specified 
in the Next Street Number Add (Subtract) field (enter a negative number if 
you wish the street numbers to decrement). 

The end result should look similar to that shown below. 

 

Figure 73 – New addresses entered into map 

 

Note that addresses which were placed inside a Service Area boundary will have their 
first Service Area link automatically set to the boundary.  This can be seen under the 
Service Areas link in the Details Panel for the address, as shown below. 
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Figure 79 – Service Area “FTTP” automatically set for new address. 

 

Step 26: Add Land Parcels 
In addition to modeling service addresses, SPATIALnet FM also includes the ability to 
model land parcels.  In many cases, land parcel data along with the associated 
address information, is obtainable from various landbase suppliers and can be 
automatically loaded into the system (the loading process is outside the scope of this 
course).  The major advantage this brings is the ability to use parcel information to 
automatically create service address records via SPATIALnet FM’s Migrate Parcel tool.  
That tool is the subject of the next step.  In this step, we shall learn how to manually 
add land parcels and capture the information associated with them. 

 

To add land parcels: 

1. Select SPATIALnet > Add > Landbase > Parcel…   or click on the Add Parcel 
button on the Landbase toobar. 

 

 

 

2. This will display the Parcel Creation dialog box, shown below.   
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Figure 740 – Parcel Creation dialog box 

 

3. Click on the Edit button on the Parcel Address field. 

 

 

Figure 751 – Parcel Address dialog box 
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4. Fill out the fields, as shown above, then click on the Done button. 

5. Draw a land parcel, making sure that the parcel is at the same location as 
the street name, as illustrated below.  

6. Repeat the process to create four land parcels, making sure that you 
update the Street Number field for each parcel. 

 

Note: The parcel numbers will be automatically displayed in the center of 
each parcel if the Show Parcel Labels box is checked on the View Settings Panel. 

 

 

Figure 762 – Land Parcels on New Rd 

 

Step 27: Automatically Create Service 
Addresses from Land Parcels 
The data in the land parcels can be used to automatically create the service addresses 
using SPATIALnet’s  Migrate Parcels tool.  Where land parcel data is available, this tool 
provides a more efficient means for creating service addresses than the manual entry 
approach used in previously. 

To use the Migrate Parcels tool: 

1. Check that the multi-select mode is enabled, by confirming that the double 
arrows are displayed on the Toggle Selection Mode button on the General 
toolbar, as shown below. If the single arrow is displayed, click on the 
Toggle Selection Mode button to toggle back to the double arrow. 
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2. Draw a box around the land parcels to select them, as shown below. 

 

 

Figure 773 – Selected Land Parcels 

 

3. On the Landbase toolbar, click on the Migrate Parcel button.  

 

 

 

4. If the migration was successful, the Parcel Migration Results panel should 
appear. 

 

 

Figure 784 – Parcel Migration Results Panel 
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5. The service addresses should now be visible on the map. 

 

 

Figure 795 – Service Addresses shown on map 

 

Step 28: Edit Multiple Addresses 
SPATIALnet provides the ability to edit multiple fields on multiple addresses, making it 
easy and efficient to correct or update many service address records with a single 
operation. The multi-address edit panel also includes functions for filtering the specific 
addresses which are to be edited from the initially selected set.  
In our example, we have not as yet, entered any zip codes or a State for any of the 
addresses we have created either manually, or by using the Migrate Parcel tool.  We 
shall now use the multi-address edit tool to set these values for all of the addresses 
we have created so far.  

There are two methods that can be used to access the Multiple Address Modification 
Panel; the Select Boundary method, and the Select Multiple Addresses method.   

 

Select Boundary Method: 

1. Select a boundary on the map by clicking on it. 
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Figure 806 – Selecting a boundary 

 

2. Click on the Edit Multiple Addresses button on the Landbase toolbar, as 
shown below. 

 

 

 

3. The Multiple Address Modification Panel should now be displayed, with all 
the addresses that are enclosed within the boundary. 

 

OR 

 

Select Multiple Addresses Method 

1. Check that the multi-select mode is enabled, by confirming that the double 
arrows are displayed on the Toggle Selection Mode button on the General 
toolbar, as shown below. If the single arrow is displayed, click on the 
Toggle Selection Mode button to toggle back to the double arrow. 

 

 

 

2. Draw a box around the addresses to select them, as shown below. 
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Figure 817 – Selected Land Parcels 

 

3. Click on the Edit Multiple Addresses button on the Landbase toolbar, as 
shown below. 

 

 

 

4. The Multiple Address Modification Panel should now be displayed. 
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Figure 828 – Multiple Address Modification panel 

 

5. Click on the fields you wish to edit to turn the field from gray to white.  In 
this step we are going to edit the zip code and State.  Enter the data, then 
click Apply. 

 

Note:  It is possible to remove addresses from the list of those to be updated 
by highlighting the address in the list window and then clicking on the  –  
button, as shown below.  To add an address to the list, simply click on it in 
the map.   
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Chapter 4 

Outside Plant Fiber 

 

Step 29: Add Term Panel to Site 
Now that we have created the site, let us place a term panel within it, ready for us to 
connect fiber cables. 

1. Select the new Shared Hub site by clicking on its symbol on the map.  When it 
is selected, the SPATIALnet Move and Rotate manipulators shown in Figure 1 
will be displayed. 

2. From the menu, run the command Fiber > Add > Term Panel…, or click the Add 
Term Panel button on the Fiber toolbar: 

 

 

3. Fill in the fields of the Fiber Term Panel Creation Dialog Box with the values 
shown below: 
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Figure 89 – Fiber Term Panel Creation Dialog Box 

 

4. Ensure that the “Selection” arrow is selected in the Fiber Term Panel Creation 
Dialog Box, as shown in Figure 89, above, and also here:     

 

5. Click the Add button to place the new term panel in the selected Shared Hub. 

6. The click yes on the confirmation panel to complete the operation: 

 

 

Figure 90 – Term Panel Confirmation Dialog Box 

7. To verify that the term panel was placed successfully, display the details of the 
shared hub by clicking on the Details button on the General toolbar (ensure the 
Shared Hub is selected first):  
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8. Examine the Equipment branch of the browser window as shown below to 
ensure that the Term Panel was placed within the Shared hub. 

 

Figure 83 – Site (OSP) Details showing Term Rack placed 
in the Shared Hub. 

 

Step 30: Adding More Equipment to a Site 
– Understanding Splice Locations. 
In the previous step we have just added a fiber termination panel.  However, many 
facilities have more than one term panel, and it’s important to understand how to 
place these additional term panels in SPATIALnet so that fiber cables can be spliced to 
them correctly. 

In this step, we are going to add additional term panels to our Shared Hub and learn 
about the important concept of splice locations within a site. Understanding splice 
locations is important when using SPATIALnet since, as we shall see shortly, splicing 
locations are the key to being able to connect fiber optic equipment together (that is, 
to splice fibers to other fibers or to equipment ports).  

Examining Figure 83 from the previous step, we can see that when we placed a new 
term panel into our site, the system created two new entries in the Site Details 
panel—one under the Equipment branch and one under the Connectivity branch. 
These are highlighted in Figure 84 below. 
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T  

Figure 84 – Site (OSP) Details highlighting term panel and 
splice location 

 

Each Splice entry under Connectivity represents a distinct splicing location within a 
site.  For example, a building may have distinct fiber entry locations on its north wall 
and on its south wall.  In such a situation, only fiber cables located at a single entry 
point could be spliced together, or connected to termination ports at that entry point.  
A fiber cable entering through the north wall could not, for example, be spliced to a 
termination panel at the south wall. 

When you placed the new term panel in Step 29, SPATIALnet automatically created a 
splice location to contain the term panel.  If we expand the Site branch under 
Connectivity in Figure 84, we see that the ports associated with the term panel are 
located there: 

 

T  

Figure 85 – Showing Term Ports located at a Splice 
Location 

 

Let’s now add another term panel and observe SPATIALnet’s behavior. 

Adding Additional Term Panels to a Site – “Select Site” 
Method 

To add another term panel to the Shared Hub site we created in Step 19, we follow 
the same procedure as in Step 29: 

1. Select the Shared Hub Site either by: 
(a) Clicking on it in the map, or 
(b) Highlighting it in the details panel and clicking the Select button, as shown 
below: 
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Figure 86 – Site (OSP) Details panel, with Shared Hub selected 

 

2. Follow steps 2–8 on pages 88–90 to add the new term panel.   

Note: Use a different designation when completing the Fiber Term Panel Creation 
panel to make it easy to tell the two term panels apart. 

 

When this operation is complete, the details of the site will appear as shown below: 

 

 

Second Term Panel added

Second Splice Location also added

 

Figure 87 – Second Term Panel and Splice Location added to a Site 

 

Note that not only was a second Term Panel added to the site under the Equipment 
branch, but that a second Splice Location was also added under the Connectivity 
branch.  Also, observe that the new Term Panel was added to this second location 
(test this by expanding the second Splice branch).  This means the two term panels 
were placed in separate locations, and therefore cannot be spliced to a single cable. 
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In some cases, this may be what you wish to do.  But in many cases, you wish to add 
a second Term Panel to an existing location so that fibers from a single cable can be 
spliced across more than one panel.  We shall learn how to do this in the “Select 
Splice” method, below. 

   

Adding Additional Term Panels to a Site – “Select Splice” 
Method 

If you have a Site selected (in the above example, it is Shared Hub: SH-01) when you 
are adding equipment such as a Term Panel, SPATIALnet will always create a new, 
distinct splice location for each new piece of equipment.  A consequence of this 
configuration is that fibers from a single cable can only be spliced to a single term 
panel. However, there will often be cases where you wish to place more than one 
Term Panel at a single location, so that the fibers from a single cable can be spliced to 
ports on any panel at that location. 

To place adjacent term panels at a single Splice location: 

1. Select the Splice location by highlighting it in the details panel and clicking the 
Select button, as shown below. (Compare panel below, with panel in Figure 
86.) 

Note: Merely highlighting the splice location is not enough to select it.  
To properly select it, you must click on the Select button. 

 

 

Figure 88 – Site (OSP) Details panel, with splice selected into which a 
new term panel will be placed. 

 

Note: It is only possible to select the splice location by selecting it in 
the Site (OSP) Details panel.  It is not possible to select it by clicking on 
the map. 

2. Follow steps 2–6 on pages 88–90 to add the new term panel.   
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3. Examine the Equipment branch of the browser window, as shown below, to 
ensure that the Term Panel was placed within the Shared hub. If done correctly 
there should now be two term panels, but only be one splice entry. 

 

 

Figure 89 – Site (OSP) Details panel, with Splice Location selected 

 

4. Finally, examine the contents of the Splice Location by expanding the Splice 
branch under the Connectivity heading in Figure 89.  You should find the port 
banks for the two term panels located there, as shown below. 
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Figure 90 – Both Term Panels located at a single splice location. 

 

 

Step 31: Moving Equipment Between 
Splice Locations. 
The above steps discussed how to place a Term Panel into the correct splice location 
within a Site. However, from time to time you may need to move equipment from one 
splice location to another.  This is achieved by a simple drag and drop operation in the 
Site (OSP) Details panel, as we shall now see. 

Let’s repeat the earlier steps for adding an additional panel.  This time, however, after 
we have added the panel, we will move it to a different splice location from the one it 
was created in.  

1. Add another Term Panel to the building (i.e., Shared Hub: SH-01) as in Step 29. 
The new term panel should be visible in the Site (OSP) Details panel in its own 
splice location, as shown below.  
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Figure 91 – Additional Term Panel added to Site (OSP) Details panel. 

 

2. To move the Term Panel to a new Splice location simply click on the Term 
Panel and drag it over the desired splice location, as shown below. 
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Figure 92 – Drag and drop term panel from one splice location to 
another. 

 

3. When the Term Panel is over the desired splice location, click on the pop-up, as 
shown below. 
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Figure 93 – Pop-up in Site (OSP) Details panel. 

 

 

Step 32: Configure New HFC Node Type 
and Usage Codes 
As with any type of record in SPATIALnet , before we can add a new instance of an HFC 
node, we have to make sure that the type of node we wish to add is configured in the 
Node Definitions dictionary.  To configure a node we must: 

• Specify an identifying name for the type of node, and 

• Specify the number and types of fiber ports on this type of node (port types 
are defined by their “Usage Codes”—more on this below). 

Let’s suppose we wish to add a Generic type of node with two fiber receivers and one 
transmitter (for the return path signal).  Before we actually go through the steps to 
configure the node type, let’s first look at how we will tell SPATIALnet what each of its 
ports will be used for, and what kind of signal they will be using. 

SPATIALnet FM provides a great deal of flexibility for tracking the various uses to which 
fibers in the network might be put.  As with all other record types, this is done via a 
user-defined dictionary of “Usage Codes”.  Since our network will be using fibers for 
transmitting forward and return signals to an HFC node, we should define these usage 
codes in the system’s dictionary.  Let’s do this now. 
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1. From the menu, run the command SPATIALnet  >  Dictionaries > Other Definitions 
>  Usage Code Definitions.  A dialog box will be displayed listing all of the usage 
codes currently defined.   

2. Click on the Add button and fill in the field values as shown in the left dialog 
box below (for the forward path), then close this by clicking on its Add button.  
Repeat this step but this time, fill in the values (for the return signal) shown in 
the right dialog box in Figure 94, below. 

 

  

Figure 94 – New Usage Code Entry Forms 

 

3. Close the Usage Code Definitions panel. 

Note:  You will only need to run items 1 to 3 above when you wish to add a 
new usage type that you wish to record.  You will not need to do this each 
time you configure a new piece of equipment that makes use of a usage code. 

 

Now that we have the usage code defined, we can configure the node type itself.  To 
do this: 

4. From the menu, run the command SPATIALnet  > Dictionaries  > Fiber Definitions 
> Node Receiver Definitions.  A dialog box will be displayed listing all of the node 
types currently defined.   

5. Click on the Add button and fill in the field values as shown in the dialog box 
below: 
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Figure 95 – Add Node Definition Dialog Box 

 

6. Click on the Add button shown in Figure 95 to create the new node type.  It 
should now be listed in the Node Definitions list. 

To complete the definition of this node type, we now add and configure its fiber ports. 

7. Ensure the GenericNode2F1R Node type is selected in the Node Definitions list. 

8. Click on the Ports button.  Since there are no ports defined for this node type, 
the Ports list will initially be empty. 

9. Click the Add button on the Ports list panel.  This will allow you to specify the 
details of each port you wish to add to the node type.  We will add two ports of 
type HFC Forward Path, and one port of type HFC Return Path., as shown in 
Figure 96, below. 

10. Fill in the fields of the Add Port Definition panels for the three ports, as shown 
below, and click the Add button when done for each port.  

 (Note that the panel for defining Port 1 is not shown, but its values can 
be seen in the list panel behind the two Add Port Definition panels visible for 
ports 2 and 3).   

11. Close each of the panels shown in Figure 96, below when complete. 
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Figure 96 – Adding ports to a node type. 

 

This completes configuration of the new node type, its ports, and the new usage codes 
we are adding to the network. 

 

Step 33: Add New HFC Node 
We will now add a new HFC node, using a process very similar to adding a site 
described in Step 18. 

To add the node: 

1. From the menu, run the command Fiber >  Add > Node Receiver…, or click the 
Add Node RX button on the Fiber toolbar:  

 

2. Fill in the fields of the Optical Node Creation Dialog Box with the values shown 
below: 
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Figure 97 – HFC Optical Node Creation Dialog Box 

 

3. Ensure that the “Placement” cross hair is selected in the Optical Node Creation 
Dialog Box, as shown in Figure 97, above, and also here: 
 

 

4. Create the new HFC Optical Node at the specified location on the map by 
clicking on the location shown below. 

Shared 
Hub 
Location 

HFC 
Node 
Location 

 

Figure 98 – Place new HFC Optical Node 
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Step 34: Add New Fiber/Buffer/Ribbon 
Configuration 
In the next step, we shall define a new cable type, but before we do, we shall review a 
key configuration feature of fiber optic cables: the arrangement of fibers into buffers, 
ribbons, etc.  In SPATIALnet, these are referred to as Fiber Color Scheme 
Definitions.  To open the Fiber Color Scheme Definitions list: 

1. Select the menu option SPATIALnet > Dictionaries > Fiber Definitions > Fiber Color 
Scheme Definitions… 

2. A panel similar to that shown below is displayed. 

 

Figure 99 – Fiber Color Scheme Definitions Panel 

 

3. Select one of the existing entries in the list and click the Edit button.  A panel 
similar to that shown is then displayed. 

 

Confidential  Page 103 



Step 35: Add New Fiber Cable Type  SPATIALnet FM Tutorial 
 

 

Figure 100 – Fiber Color Scheme Definitions Panel 

 

The above panel configures information about the sequence of fiber colors, 
buffer colors and ribbon colors that are associated with the particular color 
scheme.  In addition to recording the actual configuration to be used in the 
cable, the panel also has fields for configuring how these colors will be 
displayed in both graphical and textual representations of the fiber (for textual 
displays, a 6 character hexadecimal (base-16) number is used to represent the 
RGB-value of the display color.  For graphical displays, the color index to be 
used by AutoCAD to draw the fiber is shown. 

4. Click on the Apply button to commit any changes made to the fiber color 
scheme configuration to the database. 

 

Step 35: Add New Fiber Cable Type 
We have completed placing our new facility, and an HFC Node that it will feed.  We are 
now ready to connect the two by creating a new fiber cable.  As with our “Shared 
Hub” site type in Step 18, we shall assume that the type of cable we want to place is 
not currently in the Cable Type Dictionary, and that we need to create it.  The process 
is similar to adding an entry to the other Type dictionaries, but cable types require an 
additional step to specify their linear symbology, as we shall see below. 

To add the basic details of the new cable type: 
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1. From the menu, select SPATIALnet > Dictionaries > Fiber Definitions > Cable 
Definitions…. A dialog box will be displayed, listing all of the cable types 
currently defined. 

 

 

Figure 101 – Cable Definitions dialog box 

 

2. Click on the Add button and fill in the field values as shown in the dialog box 
below. 

 

 

Figure 102 – New Cable Type Entry Form 
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3. Click on the Add button shown in Figure 102 to create the new CableType.  It 
should now be listed in the Cable Definitions list. 

 

Hint: The Description field is what is displayed when you choose the cable 
type for a new cable.  Therefore, you should ensure that you include 
necessary information to identify the cable type, such as number of fibers, 
buffer organization, etc. 

 

Because the symbology of cables can vary depending on the cable’s construction 
status and build environment (Aerial, Underground, etc.), an additional step is 
required to define how the cable will appear in each of these situations.  The 
display of a single cable type in these different situations is controlled by having 
the system render it into a different CAD layer in each case.  You can then set the 
display properties of that layer (color, linetype, lineweight, etc.) as you wish in the 
template DWT file. 

4. From the menu, select SPATIALnet > Dictionaries > Fiber Definitions > Cable 
Definitions…,then click on the Layers… button. 

 

 

Figure 103 – Cable Definitions dialog box 

 

5.  A dialog box will be displayed, listing all of the assignments of cable types to 
CAD layers that are currently defined. 

 

 

Figure 104 – Cable Layer Definitions dialog box 
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6. Click on the Add button and fill in the field values as shown in the left dialog 
box below, then close this by clicking on its Add button.  Repeat this step but 
this time, fill in the values shown in the right dialog box in Figure 105, below. 

 

  

Figure 105 – New Cable Layer Entry Form 

 

 

Step 36: Connect Site and Node with a 
New Fiber Cable 
In this step, we connect the Node we placed in Step 33 to the Shared Hub we placed 
in Step 18 by creating a new fiber cable.  Cable placement is one of the most 
sophisticated functions in SPATIALnet, allowing automated insertion of in-line 
equipment, automated creation of terminating equipment, and many other features.  
We will not cover these more advanced operations in this exercise. 

To create the new cable, and connect it to both the Shared Hub and the HFC Node 
created in the earlier steps: 

1. Zoom the AutoCAD view so that it is roughly centered around the Shared Hub, 
similar to the layout shown in Figure 61, above.  
 
Note: Ensure that the HFC Node we placed in Step 33  is also in the 
current window.  If it is not, zoom out to an extent which includes both 
the Shared Hub and the Node, similar to Figure 98, and click the View 
Refresh  button on the SPATIALnet View toolbar:      

2. Select the Shared Hub in the Map window by clicking on it.  This will be the 
starting point for our new cable. 

3. Start the Add Cable process by selecting Fiber > Add > Cable from the menu.  
Equivalently, click the Add Add Cable button on the SPATIALnet Fiber toolbar.   
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4. Select the fiber cable type A24F fiber cable that we created in Step 35 from the 
pulldown list, and fill in the other fields as shown below.  

 

 

Figure 106 – Fiber Cable Creation Dialog box 

 

5. Ensure that the “Selection” arrow is selected in the Fiber Cable Creation Dialog, 
as in Figure 106, above, and also shown here:   
 

6. When the fields in the dialog box have been filled in, click the Add button. 
Highlight the splice to connect to (SH01TERMRACK01) and press select.  This 
will cause the Line Capture Control panel to become visible, and the cable line 
segment capture process to start. 
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Figure 107 – Line Capture Controls Dialog box 

 

In our hypothetical example, we will run an underground section of cable to a pole 
near the Shared Hub Site, and then run aerial cable to the node.  To do this: 

7. Ensure the Cable Segment Type in the Line Capture Control panel is set to 
Underground. 

8. Right-click at a position near a pole as shown in the example below and select 
Cable Riser from the pop-up menu.  This will automatically place a Cable Riser 
at this location when the cable is created, and transition the segment from 
Underground to Aerial (or vice-versa as appropriate). 

 

Note: If a trench or conduit had already been included in the drawing, we 
could read its length automatically (as we shall do for the aerial spans, 
below).  However, in this case, we shall use the system’s measured length of 
the line segment to determine the length of the underground span. 

 

 

Figure 108 – Location of first line segment for new cable 

  

9. Clicking will cause the Capture loop attributes dialog box to pop up (see 117, 
below). This is because the system is asking if you wish to add a storage loop 
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at the same location as the riser.  If you do, enter the length of cable you wish 
to store into the loop Cable Loop Length field (if you do not, you can leave this 
field set to 0).  If you also wish to record the as-built footage readings at the 
start and end of this segment, you may enter these into the Sheath Reading at 
Segment Start and Sheath Reading at Segment End fields.  When you have 
finished entering data into the Capture loop attributes dialog, click Continue. 

 

 

Figure 109 – Capture loop attributes Dialog box 

 

 

10. We will now run the aerial spans of the fiber cable.  Change the Cable Segment 
Type to Aerial in the Line Capture Control panel.  When this is done, click at 
the position shown below to locate the next vertex of the cable. 

 

Page 110  Confidential 



SPATIALnet FM Tutorial Step 36: Connect Site and Node with a New Fiber Cable 
 

 

Figure 110 – Location of next line segment for new cable 

 

11. Notice that the next strand segment leading to the pole is a slack span, 
represented by a curved arc.  SPATIALnet can automatically trace this arc at a 
specified offset, using offset mode on the Line Capture Control panel.  Before 
starting this, place one more vertex at a point which can be projected onto the 
arc segment we wish to trace.  An example is shown below: 

 

 

Figure 111 – About to start offset tracing the curved span. 

 

Confiden Page 111 tial  



Step 36: Connect Site and Node with a New Fiber Cable  SPATIALnet FM Tutorial 
 

12. Change to Offset capture mode by clicking the Offset button on the Line 
Capture Controls panel:  
 

13. Click on the line you will be offsetting from.  This is the curved slack span 
segment.  It should change color. 

14. Click on a point to establish an offset side and distance for the offset segment.  
This is best achieved by clicking on the last point you captured in the line 
segment (i.e. click at the position of the cross-hairs in 119, above). 

15. The system will now allow you to smoothly track around the arc drawing a 
curved segment at the specified offset distance.  When you reach the position 
where you will begin entering straight segments again, click to add the end 
vertex of the curved segment, as shown below: 

 

Figure 112 – Click to end the curved span. 

 

16. To leave Offset Tracing mode, click the cross-hair button on the Line Capture 
Control panel.  
 

17. Up to this point, we have not captured the length of strand passed by this 
cable.  Let’s now do this by right-clicking on each strand annotation footage 
marker passed by the aerial segment over its entire length (alternatively you 
can right click on each footage as you’re drafting past the strand segments).  
(If the system cannot unambiguously determine the strand footage marker and 
a pop-up is displayed, select the RF_STRAND option.)  A running total will be 
displayed in the Line Capture Control panel as you add each footage. 

18. Draft the last section of cable, leading up to the Node.  To connect the cable to 
the node, right click on the Node symbol and select SH-01ND1 (the node name) 
from the pop-up menu. 

19. We’re done.  Click the Done button on the Line Capture Control panel.  
This will close the panel and end line capture mode.  Click Close on  
the Fiber Cable Creation dialog to end the Cable Creation function. 
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Step 37: Insert “Tap Splice” into Existing 
Cable 

In this step, we will insert an inline splice enclosure into the cable at the pole prior 
to the one containing the Node.   

1. Select the cable we just created and display its details by clicking the 
Details of Selected Entity panel on the General toolbar. 
 

 

 

2. On the Details panel select the cable (the topmost header of the browser 
tree), click the Insert button, and then select Tap Cable from the pop-up 
menu, as shown below.  A “Scissors” tool will be displayed and will track 
along the cable allowing you to select the point at which you wish to insert 
the splice.  Clicking at that point will insert a new splice enclosure. 

 

   

Figure 113 – Tap Cable and Scissor tool for inserting a splice case into an 
existing fiber cable. 

 

3. When you select the Tap Splice… option from the pop-up menu shown in 
Figure 113 above, the insert a tap splice dialog is displayed (see Figure 114, 
below).  This allows you to choose the type of splice you wish to insert, and 
to specify a name for both the splice housing (in the Designation field), and 
the splice itself (in the Splice Name field). 
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Figure 114 – Capture Tap Splice details panel 

 

The completed network near the node should look similar to that shown below. 

 

 

Figure 115 – Completed Cable segments showing inline splice and 
connection to Node. 

 

Note: All the work you have done in this section has already been saved to 
the database.  For non-CAD operations, SPATIALnet saves each change as 
you make it.  You do not need to run the AutoCAD Save function. 

To review the work we have just done, select the cable by clicking on it.  When the 
cable is selected, a Move manipulator as shown in Figure 1 will be displayed at each 
vertex. 

Click on the Details of Selected Entity button on the SPATIALnet General toolbar:  

 

 

 

The details panel of the cable should display four entries under the Cable Segments 
branch, similar to that shown below: 
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Figure 116 – Details browser of newly completed cable in Fiber Cable Details 
dialog box. 

 

We shall study segments in more detail in Step 38, below.  For now it is enough to 
observe that the four segments correspond to: 

1. The Underground segment from the Shared Hub to the Riser. 

2. The Storage Loop at the Riser (labeled as Storage Loop in Figure 116). 

3. The Aerial segment between the Riser and the Inline Splice Case. 

4. The Aerial segment between the Inline Splice Case and the Node. 

 

Step 38: Editing Segments 
We have just successfully placed a cable, and notice that different portions of the 
cable have different characteristics, in that:  

• The portion of the cable is located above ground, or underground 

• The portion of the cable begins or ends at a particular building, splice case, node, 
etc. 

• The portion of the cable has a specific length 

• Each of the fibers within that portion of the cable is utilized for a specific purpose 
(we will learn more about this in later steps). 

In SPATIALnet each such portion of a fiber cable is referred to as a Cable Segment or 
just as a Segment. 

Cable segments have the following properties: 
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• A construction type (Aerial, Underground, Buried, Storage-loop, Pigtail, etc) 

• A distinct start and end location. 

• Several different length parameters (Strand Length, Design Length, As-built 
Length, Map length, etc,) 

• Start and end sheath readings (length from the beginning of the reel) 

• A sequence number indicating the order of that segment in the cable (this is 
assigned and maintained automatically by SPATIALnet). 

Every time one of these properties changes along a cable, SPATIALnet automatically 
creates a new cable segment. 

Note: Segments do not have names of their own.  The cable sheath 
determines the cable’s name, and each segment is referred to as “Cable XXX 
– Segment n”, or “Segment n of XXX” (where XXX is the cable name and n is 
the segment’s sequence number).  If you wish to change the name of a cable 
part way along its length, you must split the existing cable into an old and a 
new cable (see the Cut Cable operation). 

 

In this section we are going to learn how to edit segment lengths and edit the 
segment construction type.  

Editing Segment Lengths (Calculating Total from Segments) 

1. Click on the fiber cable on the map, then on the Details button on the General 
toolbar. 

 

 

Figure 117 – Details of Selected Entity button on General toolbar 

 

2. This action will display the Fiber Cable Details panel, as shown below. 
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Figure 118 – Fiber Cable Details panel. 

 

3. Click on the Lengths button to display the Edit Linear Equipment Length(s) panel. 

 

 

Figure 119 – Edit Linear Equipment Length(s) panel. 

 

4. The Edit Linear Equipment Length(s) panel contains the following sub-headings. 

 

Model Length: Length of cable as determined by AutoCAD. 

Cable Strand Length: Length of support network with which the cable is 
associated. (It is the sum of all the segment strand 
lengths—information.) 
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Cable Design Length: The estimated actual length of cable prior to 
construction. 

Sheath Reading at Start: Footage reading at the beginning of the cable. 

Sheath Reading at End: Footage reading at the end of the cable. 

Cable Asbuilt Length: Actual constructed length of cable. 

 

5. Try clicking on each of the sub-headings, and watch the Value to be Edited box 
at the bottom of the panel.  You will notice that for some sub-headings the box 
is grayed-out.  This means that you cannot edit those options. (There is a way 
to override this feature, however we will return to this point in the next 
section.)  

The values in the sub-headings above refer to the total cable.  In this section we are 
going to edit the values of two of the cable segments, in that we are going to move 50 
feet of cable from Cable Segment 3 to Cable Segment 4. Notice that although the 
individual cable lengths will change, the overall design length will not be affected. 

 

6.  In the Edit Linear Equipment Length(s) panel, click on the Segment 3 heading to 
display the sub-headings. 

7. Click on the Segment Design Length sub-heading, and then enter the new value 
(subtract 50 feet) in the Value to be edited box. (In this case the new value will 
be 2347.0.  However, the original value may be different in your version.)  

8. Click the OK button. (The OK button will be grayed-out until you make a 
change in the Value to be edited window.) 

 

 

Figure 120 – Edit Linear Equipment Length(s) panel. 

 

9. The new value should now be used everywhere the Segment Design Length of 
Segment 3 is displayed (this includes panels, any map annotation, etc.).  
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Now we are going to add the 50 feet of cable we just subtracted from Segment 3 
to Segment 4. 

1. Repeat steps 6-8, except this time edit Segment 4, and add 50 feet of cable to 
the original value. 

 

 

Figure 121 – Edit Linear Equipment Length(s) panel. 

 

2. The new value should now be entered in the Segment Design Length of 
Segment 4.  

 

Note: Clicking the OK button commits the changes to the database.  Clicking 
on the Revert button before clicking the OK button will restore the original 
values. To restore the original values after you have clicked the OK button 
you will need to select  SPATIALnet  > Undo…. 

 

Editing Segment Lengths (Manually Overriding Data) 

In the above section, we changed the design length of the two individual segments. 
But notice that the overall design length did not change, as we merely subtracted 50 
feet from one segment and added it to another. (Look at the Cable Design Length 
entry at the top section of the Edit Linear Equipment Length(s) panel.) If we had added 
50 feet to both segments, the overall design length would have increased by 100 feet. 

By default, SPATIALnet calculates the overall design length for a cable by adding up the 
design lengths of the individual segments.  However, in some circumstances it may be 
necessary to edit the total design length without changing the data entered into the 
individual design segments. To edit the total design length without changing the 
individual design segments we will need to “manually override the data”.  

In step 5 of the above section we saw that it was not possible to edit the design 
length, as the Value to be edited window was grayed out. To override this: 
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1. Click on the Options button in the Edit Linear Equipment Length(s) panel. 

 

 

Figure 122 – Edit Linear Equipment Length(s) panel. 

 

2.  This will display the Length Edit Options panel, shown below. 

 

 

Figure 123 – Length Edit Options panel. 

 

The Length Edit Options panel contains the following options: 

 

Calculate total from segments: Selecting this box results in SPATIALnet calculating 
the total cable length from the individual cable 
segments. 

Manual override of data: Selecting this box enables the user to edit the 
summary fields directly.  
 Note that this may mean that the values in 
the summary fields are no longer the totals 
of the corresponding values in the cable 
segments.   

 

3.  Select the Manual override of data option, and click Done.  

4. Now click again on the sub-headings in the Edit Linear Equipment Length(s) 
panel. Notice now that many of the options that were previously grayed-out in 
the Value to be Edited box are now shown with a white background. This means 
they can now be edited. 

5. Change the value of the Cable Design Length, then click OK. 
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Figure 124 – Edit Linear Equipment Lengths(s) panel. 

 

3. The new value should now be entered in the Segment Design Length field. 

 

Note: Clicking the OK button commits the changes to the database.  Clicking 
on the Revert button before clicking the OK button will restore the original 
values. To restore the original values after you have clicked the OK button 
you will need to run the SPATIALnet  > Undo… option from the main menu. 

 

Editing Segment Construction Type 

Let us now turn to editing properties of segments other than their length.  

To edit a segment construction type, choose one of the following options: 

1. (a)  On the map, click on Segment 4. (For the purposes of identification, 
it is shown highlighted, below.) 

 

 

Figure 125 – Cable Segment 4 highlighted. 

 

(b) Then click on the Edit Selected Entity button on the General toolbar. 
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Note: You do not need to highlight a segment to select it—it will be 
selected when you click on it.  

or 

(a) Click the Details of Selected Entity button on the General toolbar to 
display the Fiber Cable Details panel. 

 

 

(b) On the Fiber Cable Details panel, highlight Segment 4 then click the 
Edit button, as shown below. 

 

  
Figure 126 – Cable Segment 4 highlighted. 

 

 

Note:  It is often useful to be able to find the cable path in the map 
that corresponds to a given segment in the above list.  You can do this 
by highlighting one of the segments displayed in the details panel. To 
do this, click on the segment, then either: 
(a) Click the Display button on the Details panel, and select Highlight 
from the pop-up, or 
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(b) Click the Select button on the Details panel and then click the 

Highlight Selected Entity button  on the General toolbar. To un-highlight 

it, click on the segment then click on the Clear Highlight button  on 
the General toolbar.  

 

 

 

2. Either of the above steps will display the Segment Modification panel. 
Click on the Cable Segment Type drop-down menu, and change the 
segment type from Aerial to Underground, as shown below. 

 

 

Figure 127 – Segment Modification panel. 

 

3. Click the Apply button to save the change to the database. 

 

Step 39: Cutting a Cable 
In this step we are going to modify our design to accommodate another node, and 
change our cabling path to resemble the diagram shown below. 
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Figure 128 – Final Design Showing New Cable and Node. 

 

We will begin this process by first placing a new node. We will use the “cut cable” 
function to create a new splice.  And finally, we will run new cable to our new node, so 
that our finished design resembles Figure 128, above. 

 

1. Place a new node called SH-01ND2 in the place shown in Figure 128. (Refer 
to page 101 for details on how to add a new node.) 

2. Click on the cable running to SH-01ND1, then click the Details of Selected 
Entity button on the General toolbar.   

 

 

Figure 129 –Details of Selected Entity button on the General toolbar. 

 

3. This will display the Fiber Cable Details panel, shown below. Click on the 
Insert button. 
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Figure 130 – Fiber Cable Details Panel. 

 

4. Select the Cut Cable option from the dropdown menu. 

 

 

Figure 131 – Cut Cable… Option. 
 

5. This will produce the Cut Cable panel shown below.  
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Figure 132 – Cut Cable panel 

 

6. Enter the details into the fields, including a new cable name.  

Note: Unlike the “Tap Splice” method (outlined on page 113) which 
merely creates a cable segment, the “cut cable” function creates a 
whole new cable. (See page 115 for the step on “Editing Segments” for 
more information.) 

7. Click on the Select Pos button.  This will create a pair of “scissors”.  

8.  Place the cursor over the place on the cable you wish to “cut” and click on 
the mouse. 

 

 

Figure 133 – Cutting the cable. 

 

9. Now run new cable to node SH-01ND2, so your design resembles Figure 134, 
shown below. 
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Figure 134 – New cable with new node. 

 

Step 40: Reconnect Cable End by Dragging 
to New Site. 
In this step we are going change the design once again; this time by adding another 
node, and then reconnecting the cable end from the second node to the third node. To 
complete the design we will then run another cable to the second node, so that the 
finished design looks something similar to this: 
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Figure 135 – Final design showing cable connected to 3 nodes. 

 

1. Place a new node called SH-01ND3 in the place shown in Figure 135. (Refer 
to page 101 for details on how to add a new node.) 

2. Click on cable end joined to node SH-01D2, and drag the end to the node 
you just created. When the fiber is correctly placed, a pop-up box should 
appear, as shown below. 

 

Page 128  Confidential 



SPATIALnet FM Tutorial Step 41: Configure Optical Coupler 
 

 

Figure 136 – Dragging cable end to a new node. 

 

3. Highlight and click on the Reconnect to Node Facility: SH-01D3. The cable 
should now be connected to the new node. 

4. Use the cable manipulators to realign the cable so it bypasses node SH-
01D2. (Refer back to page 42 for instructions on using manipulators.) 

Now we have just one last step to do, and that is to run a new cable to our second 
node. 

5. Run a new cable to node SH-01D2, using either the “Cut Cable” method 
outlined in the previous step on page 123, or the “Tap Splice” method 
outlined on page 113.  

6. Use the cable manipulators to realign the cable and tidy up your design, 
checking that it looks similar to the final design shown in Figure 135, 
above. 

 

Step 41: Configure Optical Coupler 
In this step, we shall configure an optical coupler, that is, a passive device that splits 
(or combines) the optical signals to and from multiple fibers.   

Optical couplers are modeled as a type of optical node, with the special property that 
a signal path exists between one or more pairs of ports within the node.   

To configure an optical coupler: 

1. Run the menu option SPATIALnet > Dictionaries > Fiber Definitions > Node 
Receiver Definitions… 

2. When the Node Receiver list panel is displayed, click the Add button.  A panel 
similar to that shown below will be displayed.  Fill in the values as shown 
below. 
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Figure 137 – Node Definition Creation panel 

 

3. Click the Add button to add the new coupler definition to the system. 

4. Now the ports on the coupler must be defined, along with the signal path 
connecting them.  To do this, Click on the Ports button of the Node Definitions 
list panel.  Click the Add button to create 3 ports called IN, OUT1 and OUT2, so 
the result appears as shown in the panel below. 

 

Figure 138 – Ports to create for coupler 

 

5. Click the Close button to dismiss the Port Definitions list. 

6. To define the signal path between the ports, click the Mappings button on the 
Node Definitions panel.  This will open a list panel displaying all the port-to-port 
paths through the device (it should currently have no entries).  Click the Add 
button to add the first port mapping. 

7. A panel similar to that show will be displayed.  Fill in the values as shown to 
map the IN port to the OUT1 port. 
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Figure 139 – Port Mapping panel 

8. Click the Add button to save the port mapping to the system. 

9. Add another port mapping to connect IN to OUT2. 

Step 42: Add Fiber Annotation 
It is often useful to place textual annotation on the map to provide further information 
about fiber cables and splices.  SPATIALnet FM largely automates this process so that 
once annotation is placed, the system will ensure that the values displayed are always 
kept up to date and reflect the current state of the network.   

In this exercise, we will add annotation to the fiber segment connected to the inline 
splice we placed in page 107 and annotate the splice case itself.  To do this: 

1. Zoom the window to the area around the inline splice, similar to that shown in 
Figure 115, above. 

2. Click on the fiber cable line between the inline splice and the HFC Node to 
select the cable segment. 

3. Click the Annotate button on the SPATIALnet General toolbar, as shown: 

 

 

4. The panel shown below will be displayed.  Select Fiber Count from the Manual 
Annotations pulldown list.  This specifies the type of annotation to be added. 
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Figure 140 – Annotation Position and Type Control Panel. 

 

5. Click at a location near the cable to be annotated.  An annotation block similar 
to that shown below will be created at the specified position. 

 

 

Figure 141 –Example of fiber count annotation block. 

 

 

6. Click at a different location to add another copy of the annotation block.  Then 
click the Done button shown in Figure 140, above to exit Annotation mode. 

7. Splices can be annotated in a similar way.  The only difference is that when a 
splice is selected, clicking the Annotate button as in point 3 above, will open the 
splice case’s details panel.  This is because a single splice case may contain 
several splices, and the system would like you to choose which one you would 
like to annotate.  You can choose this by selecting the relevant splice in the 
details panel, and then click on that panel’s Annotate… button. 
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Step 43: Splice Fibers 
We have finished laying out the physical plant, and establishing physical connectivity 
between the cable and the various devices.  We now need to connect optical paths 
and assign fibers to specific usages.  In this exercise, we will: 

• Splice specific fibers in our new cable to input ports of the HFC Node. 

• Splice all fibers in our new cable to the output ports of the term panel in the 
Shared Hub. 

• Modify splicing at the inline splice enclosure. 

Splicing is very simple and intuitive in SPATIALnet FM.  Regardless of the type of 
optical connection (fiber to fiber, fiber to device, fiber to term panel port, etc.), a 
single toolbar button and a single panel is always used.  We begin by splicing the 
cable we just created to the HFC Node.  To do this: 

1. Select the HFC Node by clicking on it. 

2. Click the Splicing button on the SPATIALnet Network Tools toolbar. 

 

3. The splicing panel for the node will be displayed, with each of the fibers in the 
cable listed on the left, and each of the ports in the node listed on the right. 

4. To connect one or more fibers to ports, select the number of fibers you wish to 
connect (hold down the Shift key to select a contiguous range, or use the Ctrl 
key to add individual items to the current selection). 

5. When the same number of objects are selected on both sides, you can click on 
the Connect button.  This will form an optical connection between each 
selected objects on the left, and a matching selected object on the right.  (Take 
note of the changes to the Usage and Priority information assigned to the fibers 
when they are connected to ports on the node.  Also, take another look at the 
annotation you placed in Step 42   
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Figure 142 – Splicing panel showing the connection of fibers 1-3 to ports 1-
3. 

 

A similar process should be carried out at the Shared Hub.  This time, the fibers will 
be on the right and the ports on the left.  But the splicing operation is carried out the 
same way.  Again, take note of changes to the Origin of the fibers once they are 
connected to the term panel in the Shared Hub.  This change will ripple down all fibers 
and equipment on the optically connected path. 

As a last exercise for this step, try to de-splice (or disconnect) the unused fibers 
(numbers 4-12) at the inline splice near Node SH-01ND1.  The process for this is very 
similar to the splicing operations we have just done, with the exception that we 
highlight only one side, and click the Disconnect function, rather than the Connect 
function.  When the fibers are disconnected, note the changes to the splicing 
annotation. 

 

Step 44: Trace Fibers  
To verify that the optical path has been spliced correctly you should run SPATIALnet 
FM’s Trace functionality.  This allows you to start at any point in an optical path 
and follow all connections: 

• Upstream. 

• Downstream. 

• In both directions. 

Trace results are shown on the map by highlighting cable sheaths and equipment, and 
several textual report formats are produced.  Traces can also be saved in the 
database for later reporting, or export to third-party tools.  

We will run the trace function on fiber 1 of the sheath we created in Step 36, 
assuming that it was spliced as shown in Step 43.  To do this: 
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1. Select the line representing the fiber sheath by clicking on it in the map view. 
When the cable is selected, a Move manipulator as shown in Figure 1 will be 
displayed at each vertex.  

2. Click on the Fibers/Ports list detail button on the SPATIALnet Network Tools 
toolbar:  

 

 

3. Select Fiber #1 in the Fiber List panel, and click the Trace button, as shown 
below. 

 

 

Figure 143 –Fiber List dialog box. 

 

4. Set the fields of the Trace Configuration panel as shown below. 

 

 

Figure 144 –Configuration for a Bidirectional Trace of Fiber 1 of cable SH-
01ND1-A. 
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Note that the Save trace results for reporting check-box must be checked, or the 
listing and reporting functions below will differ from those shown below. 

 

5. Click the Trace button in Figure 144.  The system will trace optical connectivity 
both upstream and downstream.  The trace will highlight any cable sheaths it 
passes through, and should begin at port 1 of the term panel we placed in the 
Shared Hub, and end at port 1 of the HFC Node. 

6. The trace results will initially be displayed in a tree similar to that shown below.  
If you expand the entries under the Next branch, you can walk along the 
entirety of the traced network. 

 

 

Figure 145 – Trace Results tree. 

 

7. To view the trace results in other formats, click the Display > > button and 
select List… from the pop-up as shown in Figure 145.  This will display a list of 
all saved traces in the system.   

8. Select SH-01ND1-A: Trace 1, the trace we just created and click the Grouplist 
button.  This will display the trace results in sequence in a tabular format.   The 
Expand and Contract button let you show or hide network segments associated 
with different logical circuits (specifically, contiguous segments with the same 
Network Type).  Since we have not created any logical circuits in this exercise, 
these buttons will expand and contract the entire network. 

 

Step 45: Generate Link Loss Report 
As the final step in our tutorial, let us generate a Link Loss report for the fiber we 
traced in Step 44 To do this: 
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1. Select the line representing the fiber sheath by clicking on it in the map 
view. 

2. From the pull down SPATIALnet Fiber menu, select Reports > Link Loss 
Report….  The Fiber Link Loss Report panel will appear.  This allows you to 
control where and how the link loss report is generated.  Use the default 
values assigned by the system.  They should be similar to those shown 
below: 

 

 

Figure 146 – Fiber Link Loss Report creation panel. 

 

3. Click the Generate button in Figure 146.  This will create a Microsoft Excel 
spreadsheet with loss information, similar to that shown below: 

 

Figure 147 – Fiber Link Loss Report output. 

 

Note that Estimated Loss is calculated by the system using the length of the cable 
multiplied by the linear Attenuation Coefficient entered into the fiber specification (see 
Step 33, Figure 102), along with any splice losses. 
 
The following chapter covers topics specific to Fiber To the Home/Premises/Curb/User 
networks (collectively referred to as FTTX networks).  The assumed network 
architecture runs multi-channel fibers to a FTTX cabinet.  In the cabinet, each channel 
on each feeder fiber is passively split onto its own home-run distribution fiber, which 
connects an individual home network interface device to an output port in the cabinet.  
Note that this architecture has been chosen simply to provide a concrete example.  
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Any other FTTX architecture can be managed by configuring the various equipment 
dictionaries appropriately. 

In the exercises, you will:  

• Extend the landbase. 

• Configure and Create a FTTX distribution cabinet site. 

• Create new strand network.  

• Record new addresses. 

• Run fibers to connect the addresses to the FTTX cabinet. 

 

 



SPATIALnet FM Tutorial Step 46: Configure FTTX Distribution Cabinet Site 
 

Chapter 5 

FTTx Networks 

This chapter introduces SPATIALnet FM functions developed specifically for designing 
fiber to the home/curb networks (collectively referred to as FTTx).   The previous 
chapter presents pre-requisite knowledge required in this chapter and should be 
completed before commencing the exercises below. 

 

Step 46 : Configure FTTX Distribution 
Cabinet Site 
The FTTX Distribution Cabinet will be modeled as a site, just like the Shared Hub we 
configured in Step 18.  Re-run Step 18, but use the values shown in the panel, below: 

 

Figure 148 – New FTTX Cabinet Site Type. 

 

Note that we have used hub.dwg as the symbol to represent the FTTX Cabinet.  You 
may wish to change this to a new symbol that you create. 

Recall from Step 18 that to display attributes as text annotation associated with the 
symbol, you need to link the attribute tags in the symbol to fields stored in the 
database.  We would like the name of the cabinet to be displayed on the map, so 
create an Attribute entry called NAME for FTTX Cabinet as shown below (see Step 18, 
page 62, for more details on adding attributes).  If you have used your own symbol, 
you will need to use the attribute tag that you defined, instead of NAME. 
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Figure 149 – Define Attribute for FTTX Cabinet Site Type. 

 

 

Step 47: Add New FTTX Distribution 
Cabinet Site 
Now that we have configured the type of site we wish to add (see Step 46, above), we 
can add it to the newly developed area we are designing.  Usually, you will be able to 
Clone an existing site, using the Clone button on a site’s Details panel.  This will 
eliminate the need to have to create the internals of each site from scratch every 
time.  However, you will have to set up at least one site’s internal structure, so that is 
what we will do here. 

By following the same procedure as in Step 19 (but choosing FTTX Distribution 
Cabinet instead of Shared Hub as shown below),we can place our new site at the 
location shown in Figure . 
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Figure 150 – Define Attribute for FTTX Cabinet Site Type. 

 

Note that this time, the Capable of modeling inside plant check box is set.  This is 
important, as failing to do this will prevent you from placing the site’s internal 
equipment into the FTTX cabinet. 

Once the site has been created, we will need to begin specifying its internal layout.  
Because sites are modeled using SPATIALnet FM’s inside plant functions, all sites must 
have at least one “floor”.  To add a floor to the new site: 

1. Select the site 

2. Open its Details Panel 

3. Click the Add button 

4. Select Add a Floor to the highlighted site. 

After you have created the floor, you must add a rack or frame within which the OSP 
cables can be terminated, and equipment can be mounted.  To do this: 

5. Select the floor you just added in the same details panel. 

6. Click the Add button again. 

7. Select Add a rack to the highlighted site floor. 

8. Supply values in the Rack Creation panel to add the new rack.  (See : 
Adding Racks in Part B on page 209 for more information about adding 
racks to the system). 
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Step 48: Cloning a FTTX Distribution 
Cabinet Site 

In this step we are going to add another FTTX distribution cabinet site. 
However, as ISP buildings such as these can be complex structures, it is often 
cumbersome to create them from scratch, especially if a building very similar 
to the one being created is already in existence. In this situation it is much 
easier to tell the system to copy, or “clone” an existing building—including all 
the ISP characteristics.   

To “clone” a new ISP site: 

1. Select the site to be cloned. In this example, we are going to clone PON-
1, shown below. 

 

 

Figure 151 – Location of PON-1 site. 

 

2. Open its Details Panel, and click on the Clone… button. 
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Figure 152 – Clone button on PON-1 Details panel. 

 

3. This will display the Site (ISP) Clone box.  We now need to give our new 
site its own name.  Change the site name from PON-1 to PON-2. 

 

 

Figure 153 – Clone button on PON-1 Details panel. 

 

4. Place the cursor over the place on the map where you wish to place the 
newly cloned site (see map below), and click the mouse.   
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Figure 154 – Location of new site. 

 

5. The Entities being cloned panel will appear.  This lists all of the individual 
objects that will be replicated when the site is cloned.  Click on the 
Confirm button to place the site, as shown below.  

 

 

Figure 155 – Entities being cloned panel. 

 

 

Step 49: Add Fiber Taps 
Now that the poles, strand, and addresses have been entered, we can place taps and 
create drops to the addresses (the system will automate much of this).  Taps are 
configured in the same way as other equipment (see, for example, : Configure New 
HFC Node Type and Usage Codes on page 98).  We will assume that the system’s Tap 
Box Definitions dictionary already contains the taps you wish to add.  If not, you 
should be able to define the equipment types you need. 

To add Fiber Taps to the system, 
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1.  Run the menu command Fiber > Add > Tap Box… 
or 
Click the Add Tap Box button on the Fiber toolbar 
 

 

2. A panel similar to the one below will appear.  Choose the Tap Box Type and 
enter a name. 

 

Figure 156 – Fiber Tap Box Creation dialog box 

 

3. Click on the AutoCAD map area once to transfer the input focus, and then 
click at the location of each new tap.  They should be drawn close to the 
poles so that the system’s automatic attachment process can assign the tap 
to the right pole.  (We will run this process later.  The distance used by the 
system to determine if equipment is attached to a structure is specified in 
Attachment Tolerance field of the configuration panel for the pole type.  See 
Error! Reference source not found., above). 

When done, the new network should look similar to that shown below: 

 

Confidential  Page 145 



Step 50: Associate Taps with Poles  SPATIALnet FM Tutorial 
 

 

Figure 157 – New Taps 

 

Step 50: Associate Taps with Poles 
The system will automatically associate the taps you placed in Step 49 with the poles 
near to which they are placed.  There is also a manual process for doing this. 

The automated process requires that you first draw a “fence” (a polygon) around the 
area within which you want the system to search for taps which need to be attached 
to poles.  A polygonal area of any type will do, so you could select the boundary you 
created in Step 7.  Alternatively you can create a new boundary around the area of 
the job you are currently working on, and use that instead. 

To have the system automatically use proximity to associate the taps to the poles to 
which they are attached: 

1. Select the boundary that encloses the area you wish to scan. 

2. Click the Attach Equipment by Polygon button on the Construction toolbar. 

 

 

Check that the association was made by clicking on one of the poles with a tap 
attached to it.   The tap should be shown as attached to the pole, as in the area 
highlighted below. 
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Figure 158 – Tap attached to pole after automatic attachment by proximity 
function run. 

 

 

Step 51: Create Drops 
The last step in creating the infrastructure needed to connect addresses to the 
network is to create drops.  This process is also significantly automated, via a “wizard” 
that does most of the work for you. 

To run the drop wizard: 

1. Select a tap box by clicking on it in the map. 

2. Click the Drop Tool button on the Network Tools toolbar.  
 

 

3. A panel similar to that shown in Figure 159, below will be displayed. 

4. The drop tool always operates on a single tap box.  You must dismiss the 
tool and re-start it if you wish to change tap boxes.  While you have a 
single tap box selected, the tool works as follows: 

• Click on any support structure (pole, pedestal, vault, etc.) and any 
drops to be created will be run from that structure to the address they 
serve. 

• Click on any group of addresses.  These will appear in the address list 
window and be assigned to the next sequence of spare ports in the tap 
box.  If there are no spare ports, the system will display an error 
message.  

• Click on a strand/trench footage.  This will be added to the length of 
drop cable required when the structure from which a drop is connected 
to the address is not the structure to which the tap is attached. 
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5. When you click the Apply button, drops will automatically be created 
between any new addresses assigned to the tap box, from the currently 
selected structure.  Each new address will be assigned to the next available 
port in the tap box, while there are still unused ports available.  Addresses 
already connected to the tap box will be shown in the address list, but will 
not be affected when the Apply button is clicked. 

The results of running this process on the area we are building are shown below. 

 

 

Figure 159 – Drop Tool showing auto-created drops and assignments of 
addresses to tap ports. 

 

The automatic assignment of the addresses to the ports in the tap box can be seen by 
showing the port details of a selected tap box (via the Fibers / Ports List button on the 
Network Tools toolbar).  

 

 

 

Figure 160 – Addresses assigned to Ports after Drop Tool run. 
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Note that you can edit the assignments to ports manually, including deleting an 
assignment, by selecting a port and clicking the Edit button in Figure 160. 

 

Step 52: Configure FTTX Fiber Cable Types 
We saw how to configure fiber cable types, and define their display layers in Step 35.  
FTTX cables have an additional feature you should be aware of, so let’s revisit this 
topic briefly, before adding a fiber cable to finish off our network. 

SPATIALnet FM allows you to run a cable through several spliceable locations by right-
clicking as you define the cable path, but it does not always make the cable accessible 
for splicing at those locations.  In FTTX networks, the suggested procedure for 
connecting a fiber cable to the taps along its length is exactly this right-clicking 
process, but the fibers obviously have to be accessible for splicing in each tap box. 

To ensure this is the case, all cables to be used for FTTX distribution should be created 
with the Auto Create Taps field set to the Auto Tap every segment at creation.   

To configure a cable type like this, run the menu function  SPATIALnet  > Dictionaries  >  
Fiber Definitions  >  Cable Definitions, click the Add button to bring up the Add Cable 
Definition dialog box, and supply the values shown in the panel below (or similar). 

 

 

Figure 161 – Cable Type Definition for FTTX cables, showing Auto Tap every 
segment at creation option. 
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Step 53: Add FTTX Cable 
Let us now add a fiber cable connecting each of the taps (and their associated 
addresses) to the FTTX cabinet we placed earlier.  We shall tap the cable as we go 
and, in the next step, run a tool which automatically splices the required fibers to the 
used ports in each tap box.  That will complete the job. 

Adding an FTTX cable is identical to adding any other fiber cable, as was described in 
Step 36.  You should review this now.  The only difference is that FTTX distribution 
fibers should be tapped at each tap box they pass through, so you go past a tap box, 
right-click on it and select its name from the pop-up.  Remember that the cable type 
chosen for the FTTX distribution cable must have Auto Tap every segment at 
creation set (see Step 52, above). 

The network after a distribution cable has been run from the FTTX Cabinet through 
each of the taps is shown below.  Note that annotation has also been added (see Step 
42). 

 

 

Figure 162 – Cable Added to FTTX network, to connect FTTX cabinet to taps. 

 

Step 54: Assign Fibers to Tap Ports (“Tail 
Off” cable) 
The last step in our job is to splice fibers to the tap ports which were associated to 
addresses by the Drop Wizard in Step 51, above.  This is a largely automated process, 
which requires only that you select the sheath you wish to “tail off”, as this process is 
called.  The system will then locate all the taps along the sheath, find all the used 
ports in each tap, and splice the next available fiber in the cable to that port.  If there 
are not enough fibers in the cable to connect to all of the used ports, an error 
message is displayed. 

To run the Tail-Off tool: 

1. Select the fiber cable you wish to tail off (select the one you just placed in 
Step 53, above). 

2. Click the Tail Off Cable button on the Network Tools toolbar.  

Page 150  Confidential 



SPATIALnet FM Tutorial Step 54: Assign Fibers to Tap Ports (“Tail Off” cable) 
 

 

 

3. The Tail off panel will be displayed, as shown in the panel below.   

 

Figure 163 – Cable Tail off panel 

 

4. Click the Apply button.  This will automatically splice the next available fiber 
in the sheath to the next used port.  Note that the annotation readings will 
automatically update as the Tail Off tool processes each tap. 

 

Alternatively, fibers may be spliced to ports manually, by selecting the tap and using 
the same process as was described in Step 43, above. 

 

This completes Part A of the tutorial.  Further more detailed information about all of 
the topics covered in this section is available in the SPATIALnet FM User Manual. 
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Chapter 6 

Outside Plant RF 

In this chapter, we shall go through the process of capturing the base, addressing, 
support network, and RF design for the service area of a new HFC node.  The steps 
involved in this include: 

• Configuring equipment types and design frequencies in the RF dictionary 

• Configuring a new RF Design Profile 

• Capturing addresses and land parcels 

• Drafting poles, aerial strand and underground support network structures 

• Adding RF plant 

• Associating RF taps with addresses 

Step 55: Set Design Frequencies 
The first thing we will do is specify the frequencies at which the various RF signal 
levels will be tracked throughout the system.  To do this: 

1. From the menu, select SPATIALnet > Dictionaries > RF Definitions > Frequency 
Definitions...  A dialog box will be displayed, listing the values currently 
specified for each of the design frequencies. The panel shown below will be 
displayed. 



SPATIALnet FM Tutorial Step 56: Add New RF Cable Type Definition 
 

 

Figure 164 – Frequency Definitions 

2. The Frequencies listed above are those at which design can be performed.  As 
we shall see, not all frequencies are necessary in any given project, but the 
above list shows all those which are available.  Any of these may be edited so 
that a different value is used and, if this is done, that value will be changed 
throughout the entire system. 

 

Step 56: Add New RF Cable Type Definition 
Now we will add the definition of a new type of RF cable to the RF cable dictionary.  To 
do this: 

1. From the menu, select SPATIALnet > Dictionaries > RF Definitions > Cable 
Definitions...  A dialog box will be displayed, listing all the cable types currently 
defined.  Click the Add button to add a new cable type to the dictionary, as 
shown below. 
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Figure 165 – Add RF Cable Type Definition 

 

2. Fill in the field values and click on the Add button. 

 

Step 57: Add New Active Equipment 
Definition 
Let’s now add a definition of a new type of active device to RF Active Devices 
dictionary.  To do this: 

1. From the menu, select SPATIALnet > Dictionaries > RF Definitions > Active 
Definitions...  A dialog box will be displayed, listing all the active device types 
currently defined.   
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Figure 166 – RF Active Device Definitions Panel 

 

2. Click the Add button to add a new active device type.  A panel similar to that 
shown below will be displayed. 
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Figure 167 – Add RF Active Device  Definition Panel 

 

3. Fill in the field values and click on the Add button. 

4. Once RF devices are defined, their port configurations must be specified. To do 
this: 

• Open the RF Active Device Definitions panel as described in procedure 1 
above (if it is not still open). 

• Highlight the RF device just configured, and click the Ports button, as 
shown below. 
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Figure 168 – Ports Button on RF Active Device Definitions Panel 

 

5. A panel will be displayed with no entries.  

 

 

Figure 169 – RF Port Information Panel 

 

6.  Click the Add button to display the Add RF Port Information panel. 

 

Confidential  Page 157 



Step 57: Add New Active Equipment Definition  SPATIALnet FM Tutorial 
 

 

Figure 170 –Add RF Port Information Panel 

 

7. Add an entry for each port the active device has, as shown in the example 
below. 
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Figure 171 – Configure Active Equipment Ports 

 

8. In the case of some multi-output amplifiers it may also be necessary to 
configure components for the ports. To do this 

• Click the Components button on the RF Active Device Definitions list panel. A 
dialog box will be displayed with no entries.  

• Highlight the components you want to associate with this active device and 
click select. Creation of device components is covered in step 6. 

Note: Ports must be configured as “internal” and “splittable” to be able 
to associate internal components such as splitters and jumpers. 
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Step 58: Add New Passive Equipment 
Definition 
Let’s now add a definition of a new type of passive device to RF Passive Devices 
dictionary.  To do this: 

1. From the menu, select SPATIALnet > Dictionaries > RF Definitions > Passive 
Definitions...  A dialog box will be displayed, listing all the passive device types 
currently defined. 

 

 

Figure 172 – RF Passive Device Definition 

 

 

2. Click on the Add button.  A panel similar to that shown below will be displayed. 
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Figure 173 – Add RF Passive Device Type Definition Panel 

 

 

3. Fill in the values, and click the Add Button. 

4. In a manner similar to the active device configured in the previous step, once a 
passive device has been defined, its ports must be configured. To do this: 

• Open the RF Passive Device Definitions panel as described in procedure 1 
above (if it is not still open). 

• Highlight the RF device just configured, and click the Ports button, as 
shown below. 
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Figure 174 – Ports Button on RF Passive Device Definitions Panel 

 

9. A panel will be displayed with no entries. Click the Add button to display the 
Add RF Port Information panel, and add an entry for each port the RF device 
has, similar to that shown below.  Note that in this case, the levels associated 
with each port are the loss incurred by signals traveling from the input of the 
device to that port. 

 

 

Figure 175 –RF Port Information Panel 

 

 

Step 59: Add New RF Tap Definition 
 
Let’s now add a definition of a new type of RF Tap to RF Tap dictionary.  Before adding 
the tap itself, let’s review the way that tap values are configured.  SPATIALnet keeps a 
separate dictionary of tap values, an entry of which is then assigned to each tap 
configuration (this simplifies changing face plates, etc.)  To add or update a Tap Value 
Dictionary entry: 

1. From the menu, select SPATIALnet > Dictionaries > RF Definitions > Tap Value 
Definitions...  A dialog box will be displayed, listing all the active tap value 
definitions.  Click the Add button.   A panel will be displayed, similar to that 
shown below. 
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Figure 176 – Tap Value Definitions 

 

2. To define a new tap, select SPATIALnet > Dictionaries > RF Definitions > Tap 
Definitions...  A dialog box will be displayed, listing all the taps currently 
defined. 

3. Click on the Add button and fill in the field values, similar to that shown below. 
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Figure 177 – Tap Definition 

 

 

4. When the values for each field have been entered, click the Ports button.  A 
dialog box will be displayed with no entries.  Click the Add button and add an 
entry for each port the tap has, similar to the panel shown below. 

Note that the ports on the tap refer to the tap insertion loss – loss to tap 
spigots is a function of the tap value. 
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Figure 178 – Tap Port Definition 

 

 

Step 60: Add New Device Component 
Definition 
 

Let’s now add a definition of a new type of Active Component to RF Active Component 
dictionary.  To do this: 

1. From the menu, select SPATIALnet > Dictionaries > RF Definitions > Device 
Component Definitions….  A dialog box will be displayed, listing all the active 
device component types currently defined. 

2. Click on the Add button and fill in the field values. 

Note: some components such as pads and equalizers only have losses at the 
given frequencies; other components such as internal splitters will require 
losses to be specified through creating ports in much the same manner as on 
active and passive devices. 

Confidential  Page 165 



Step 61: Create New Design Profile and Assign Equipment and Frequencies  SPATIALnet FM Tutorial 
 

 

Step 61: Create New Design Profile and 
Assign Equipment and Frequencies 
The RF equipment dictionaries contain the specifications for all RF devices used 
anywhere in the system.  If all of these were displayed each time you wished to pick a 
plant item to add to the database, the equipment lists could be unmanageably long. In 
addition, it is sometimes necessary to design and manage different parts of the 
system utilizing different equipment and different frequencies. 

To remedy this, a Design Profile can be created and used to specify the subset of 
equipment available in the job, to nominate which design frequencies are to be used, 
to specify which frequencies will be used to fill in annotation values, to specify 
maximum amplifier and tap cascades, and to specify tap output parameters. 

To create a new Design Profile: 

1. From the menu, select SPATIALnet > Dictionaries > Other Definitions > RF Design 
Profile Definitions...  A dialog box will be displayed, listing all the active design 
profiles currently defined. 

 

 

Figure 179 – RF Design Profile Definitions Panel 

 

2. Click on the Add button and dialog similar to the following will be displayed: 
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Figure 180 – Add RF Design Profile Panel 

 

3. Fill in the field values, enter a name for the new design profile and select 
which of the design frequencies will be used in that profile. Click the Add 
button. 

4. Once the design profile has been created, select it in the list and click on the 
Equipment button category that will be available in the Design profile. A drop-
down panel will appear displaying the equipment list. 
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Figure 181 – RF Design Profile Definitions Panel 

 

5. Select the equipment type from the drop-down menu, and click. A panel 
listing the RF design profile equipment will appear.  Highlight the appropriate 
equipment type from the list, and click Add.  

 

 

Figure 182 – RF Design Profile Equipment List Panel 

 

6. The relevant RF equipment definitions panel should now be displayed.  
Highlight the definition to be added to the design profile and click Select.  
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Figure 183 –RF Cable Definitions Panel 

 

The selected definition should now be visible in the RF Design Profile Equipment 
List panel. 

 

Step 62: Assign Design Profile to Job 
Let’s now assign the RF Design profile we just created to the job we are working on.  
To do this,  

1. Run the menu command SPATIALnet > Administration > Change Profile of Current 
Job…  The Change of Profiles for Job panel will be displayed.  

 

 

Figure 184 – Change Profiles for Job Panel 

 

2. Select the desired profile from the drop down list. 

 

 

Figure 185 – Change Profiles for Job Panel 

 

3. Click Apply and close the Change of Profiles for Job panel. 
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Step 63: Add RF Module to Existing HFC 
Node 
Let’s now begin adding the RF plant itself, beginning with the HFC Node.  In 
SPATIALnet, nodes are modeled as a housing (or Site) into which RF modules and 
optical modules are placed.  These can then be connected, to connect RF legs with 
optical transmitters and receivers, or to couple optical ports together. 

There are two ways an RF module can be added to the system: 

• Add an RF module to an existing site in which a fiber receiver has already been 
placed 

• Add a new site, and place the RF module directly with in it. 

In this step, we’ll take the first approach.  In the next one, we’ll take the second. 

 

To add an RF Node Receiver to an existing node site, we must first find an existing 
Node (with a fiber module installed in it). To do this: 

1. Run the menu command Fiber > Find By Matching > Node Receiver…  The 
following panel will be displayed, listing the fiber node modules returned by the 
search.  Use the query filter fields above each column to narrow the search 
conditions if necessary. 

 

 

 

Figure 186 – Find Fiber Optical Node panel 

 

2. Select the optical node you wish to view in the result list and click on the Map 
View button.  The system will zoom the map to the selected node’s location. 

3. Click on the chosen Node in the map to select it and then click on the Details 
button (on the General toolbar) to display the node’s details.  A box similar to 
the one shown below should appear. 
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Figure 187 – Site (PSP) Details panel 

 

Note that the Node Site currently contains a fiber splice and an optical 
receiver/transmitter.  Let’s now add the RF module to this site. 

4. Make sure the Node Site is selected (shown in Bold in the Site (OSP) Details 
panel as above.  If it is not, click on it in the Details panel and click the Select 
button). 

5. From the RF Tools toolbar, click the Add Node button, as shown below. 

 

 

 

6. A panel similar to that shown below will be displayed.  Select the type of Node 
to add, fill in the remainder of the fields similar to those shown below. 
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Figure 188 – RF Node Creation Panel 

 

7. Click the Add button to add the RF module to the existing node.  The details 
panel will show this as illustrated below. 
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Figure 189 – Site (OSP) Details Panel 

 

 

Step 64: Add RF Node Directly to Map 
In the previous step, we added an RF module to an existing HFC node housing that 
already contains a fiber receiver/transmitter.  In this step, we shall add a new node 
directly to the map, where none existed previously, and automatically place an RF 
module in it. 

To do this, 

1. Zoom the map to the location at which you wish to create the new HFC node. 

2. Make sure there is no currently selected entity (otherwise, the system may try 
to place the new RF node as a module inside that entity).  To do this, you can 
clear the selection on the General toolbar. 

3. From the RF Tools toolbar, click the Add Node button, as shown below. 

 

 

4. A panel similar to that shown below will be displayed. 
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Figure 190 -  RF Node Creation Panel 

 

5. Click on the AutoCAD map window once to activate it.  Click again at the 
location at which you wish to place the new node.  A new node will be created 
at that location. 

We will now add the fiber module into the new node. 

6. Select the new node housing by clicking on it in the map. 

7. Click on the Add Node Receiver button on the Fiber toolbar to add a new optical 
module to the node.  A panel similar to that shown below will be displayed. 
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Figure 191 – Fiber Optical Node Creation Panel 

 

8. Click the Add button.  This will add the fiber optic module to the selected node 
housing. 

 

Step 65: Connect Optical and RF Ports in 
HFC Node 
Once the optical and RF components have been installed in the node housing, they 
can be connected together, creating a traceable circuit from the appropriate fiber 
ports in the node to the RF outputs associated with them.  This requires the creation 
of an “interface table” for the housing.  Once created, the ports which are to be 
connected are assigned to the interface, and the connections (or port mappings) are 
made. 

To create the interface at the node site: 

 

1. Select the node and open its Details panel. 

2. Click on the entry showing the RF module and click the Edit button, as shown 
below. 
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Figure 192 – Site (OSP) Details Panel 

 

3. A panel similar to that shown will be displayed.  Click on the Interface field, as 
shown below. 
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Figure 193 – RF Node Modification Panel 

 

4. A pop-up will be displayed.  Click on the Select Current Site option. 

5. A panel similar to that shown below will be displayed.  Click the New button to 
create the new interface.  In the Create Interface panel, give it the same name 
as the Node Housing.  Also, ensure that the Instance Based Mapping option is 
checked in the panel, as shown below. 
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Figure 194 – Interface Creation Panel 

 

 

6. Click the Add button to create the interface. 

This completes the first part of the process.  The HFC Node how has an interface table 
associated with it which will allow ports from the various modules in the node to be 
mapped together.  Because we created the interface from the RF module, that module 
is already associated with the interface table. 

The next part of the process requires that we associate the fiber ports with the 
interface table.  To do this: 

7. Select the fiber module in the HFC node details panel and expand the branch 
under it.  Click on the Port Bank entry and click the Edit button, as shown 
below. 

 

 

Figure 195 – Edit Optical Port Banks 
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8. A panel allowing the port bank to be associated with the interface we created 
above will be displayed. To do this, click on the Interface button and select the 
interface from the pop-up, as shown below. 

 

 

Figure 196 – Assign Fiber Optic ports to interface 

 

9. Click the Apply button to save the change. 

10. To complete the final step for mapping the RF ports to fiber optic ports, now 
that both the fiber and RF ports are present in the interface table, we can 
specify which ports are connected together.   

11. To do this, select either the RF module, or the Fiber Port Bank in the Site (OSP) 
Details panel again, click the Edit button, and select Port Mappings from the 
pop-up, as shown below. 

 

 

Figure 197 – Edit Port Mappings 

 

12. When the Port Mappings panel is displayed, for each connection to be made: 
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• Select the device from which the ports are to be mapped on the left of the 
panel 

• Selected source port on the left of the panel,  

• Select the device to which the ports are to be mapped on the right of the 
panel 

 

 

Figure 198 – Create Port Mappings 

 

Step 66: Connect RF Cable to RF Node 
Note: The following 12 steps highlight the functionality used to place “as-
built” plant. To learn how to do RF design in SPATIALnet please see the steps 
beginning with Step 78 : Designing RF Plant – Cable and Taps. 

 

Let’s now connect a cable to the RF node receiver we just placed and configured.  To 
do this 
 

1. Select the Node to which you wish to connect the new RF cable. 

2. Click the Add Cable button on the RF Tools toolbar, as shown below. 

 

 

 

3. Specify the details of the RF cable to be added by filling in the fields shown in 
the RF Cable Creation dialog box. 

4. Click the Add button. If no specific ports are selected, a list of available ports to 
connect the cable to will be displayed.  Select the port to which you wish to 
connect the cable. 

5. Capture the path of the cable as required. 
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Step 67: Add RF Cable in Free Space 
As an alternative to attaching an RF cable to an existing device, a cable may be drawn 
in free space by clicking at the desired start location and drawing the cable line along 
the desired path.  The steps are similar to connecting a cable to an existing device, as 
described below: 

1. Click the Add Cable button on the RF Tools toolbar, as shown below. 

 

 

 

2. Specify the details of the RF cable to be added by filling in the fields shown in 
the RF Cable Creation dialog box. 

3. Click on the AutoCAD window to activate it.  Then click at the location in space 
at which you wish to begin the cable. 

4. Capture the path of the cable as required. 

 

Step 68: Add RF Power Supply 
Let us now add a power supply associated with the node (although power supplies do 
not need to be associated with nodes).  To do this: 

1. Click the Add Power Supply button on the RF Tools toolbar, as shown below: 

 

 

 

2. The RF Power Supply Creation panel, similar to that displayed below should 
appear.   Fill in the details. 
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Figure 199 – RF Power Supply Creation Panel 

 

3. Click on the AutoCAD map window once to activate it.  Then click at the 
location at which the power supply is to be placed.  This will add the new power 
supply to the system. 

 

 

Step 69: Add RF Power Inserter 
Let’s now add a Power Inserter to the network, connect it to the power supply we 
placed in the previous step, and reconnect the cables so that it is connected to the 
network we have placed so far. 

A Power Inserter is classed as a Passive RF device, so to add one: 

1. Click the Add Passive button on the RF Tools toolbar, as shown below. 
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2. The RF Passive Device Creation panel is shown.  Select the Lindsay Power 
Inserter from the Equipment Type pulldown menu. 

 

 

Figure 200 – RF Passive Device Creation Panel 

 

3. Click once on the AutoCAD window to activate it, then click on the map at the 
location at which the power inserter is to be placed. 

4. Once the power inserter has been placed, click on it.  Each of the ports will be 
shown as a circle, as shown below. 

 

 

Figure 201 – Location of Ports shown on Power Inserter 

 

5. When a new device or cable is to be connected to an existing device or cable, 
the port to be connected should be selected by clicking on it.  Click on the 
Power Supply port (the topmost one) to indicate that it will be the starting 
point for the new cable. 

6. Click the Add Cable button on the RF Tools toolbar as shown below. 

 

Confidential  Page 183 



Step 70: Add RF Active Device  SPATIALnet FM Tutorial 
 

 

 

7. Select the RF cable to add, and draw the path from the power inserter to the 
power supply.   

8. To connect the cable to the power supply, right click on the power supply 
symbol and select the power supply name from the pop-up, as shown below. 

 

 

Figure 202 – Connect cable to Power Inserter 

 

 

Step 70: Add RF Active Device 
 

To add an RF Active Device: 

1. Click the Add Active button on the RF Tools toolbar, as shown below. 

 

 

 

 This will display the RF Active Device Creation dialog box. 
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Figure 203 – RF Active Device Creation Panel 
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2. Select the equipment, system and construction type from the pulldown menus, 
and fill in the details of the RF Active type in the panel.   

3. Click the location on the screen at which you wish to place the new Device. 

 
 

Step 71: Add RF Passive Device 
To add an RF Passive Device: 

1. Click the Add Passive button on the RF Tools toolbar, as shown below. 

 

 

 

     This will display the RF Passive Device Creation panel. 

 

 

Figure 204 – RF Passive Device Creation Panel 

 

 

 

2. Fill in the details of the RF node and click the location on the screen at which 
you wish to place the new Device. 
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Step 72: Add RF Tap Device 
To add an RF Tap Device: 

1. Click the Add Tap button on the RF Tools toolbar, as shown below. 

 

 

 

          This will display the RF Tap Creation dialog box. 

 

 

 

Figure 205 – RF Tap Device Creation Panel 

 

2. Fill in the details of the RF Tap, and click the location on the screen at which 
you wish to place the new Device. 
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Step 73: Associate Taps with Addresses 
The last step in creating the infrastructure needed to connect addresses to the 
network is to create drops, that is, assign tap ports to addresses.  This process is also 
significantly automated, via a “wizard” that does most of the work for you. 

To run the drop wizard: 

1. Select a tap box by clicking on it in the map. 

2. Click the Drop Tool button on the Network Tools toolbar.  
 

 

 

3. A panel similar to that shown in Figure 206, below will be displayed. 

4. The drop tool always operates on a single tap.  While you have a single tap box 
selected, the tool works as follows: 

• Click on any support structure (pole, pedestal, vault, etc.) and any 
drops to be created will be run from that structure to the address they 
serve. 

• Click on any group of addresses.  These will appear in the address list 
window and be assigned to the next sequence of spare ports in the tap 
box.  If there are no spare ports, the system will display an error 
message.  

• Click on a strand/trench footage.  This will be added to the length of 
drop cable required when the structure from which a drop is connected 
to the address is not the structure to which the tap is attached. 

5. When you click the Apply button, drops will automatically be created between 
any new addresses assigned to the tap box, from the currently selected 
structure.  Each new address will be assigned to the next available port in the 
tap box, while there are still unused ports available.  Addresses already 
connected to the tap box will be shown in the address list, but will not be 
affected when the Apply button is clicked. 

The results of running this process on the area we are building are shown below. 
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Figure 206 – Drop Tool showing auto-created drops and assignments of 
addresses to tap ports. 

 

The automatic assignment of the addresses to the ports in the tap box can be seen by 
showing the Details panel of a selected tap.  

 

 

Figure 207 – Addresses assigned to Ports after Drop Tool run. 

 

Step 74: Edit Signal Levels 
To edit the signal levels on any RF device: 

1. Select that device and open its Details panel. 

2. Click the Levels button on the Details panel.  A panel similar to that shown 
below will be displayed. 

3.  
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Figure 208 – RF Levels at a device 

 

4. To update any of the levels at any of the ports, double-click on the desired cell 
and change the value. 

5. Click Update to save the changes. 

 

Step 75: Reconnect Cables or Devices 
When a cable or device is connected to another device, you can disconnect or 
reconnect the cable or device by clicking on the manipulator representing the cable 
end, or device port. 

If you drag the manipulator onto a new device port, the cable or device will be 
reconnected to that port. 

 

Step 76: Connect RF Equipment Directly to 
Other RF Equipment 
It is possible to “chain” RF devices together by connecting their ports in sequence 
without intervening cables.  To do this, select the port to which the new device is to 
be added prior to adding the device. 

The new device will be added and connected directly to the selected port. 

 

Step 77: Creating an RF Cable Leg with 
Inline Equipment 
Up to now, we have been placing RF devices, and then connecting them with cables.  
However, it is possible to place RF devices “inline” as a leg of RF is being entered into 
the system.  This is done as a variation on the “Create Cable” process.  To do this,  

 

1. Begin the “Create Cable” process using either method described in Step 66 or 
Step 67.  
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2. When you reach a location at which a device is to be placed (e.g. a tap, a 
passive or an active device), right click during cable creation.  A pop-up menu 
will be displayed, as shown below. 

 

 

Figure 209 – RF Levels at a device 

 

3. Select the category of device you wish to place from the first pop-up, and then 
the particular device from the follow-on pop-up.  Note that only equipment 
assigned to the current profile will be displayed. 

4. When you finish drafting the cable path, any in-line devices will be 
automatically created along the cable, with their ports wired in the correct 
direction. 

 

Step 78: Designing RF Plant – Cable and 
Taps 
SPATIALnet has the capability to do “on the fly” RF design as the cables and 
equipment are placed. The system will automatically suggest tap values, keep track 
of signal attenuation / amplification, calculate pads and equalizers at amplifiers, and 
perform power calculations. If you’ve gone through the steps above placing as-built 
RF plant, you will notice that actually designing the plant is not much different – the 
major exception being it is necessary to capture the cable distance between devices 
in order to perform the design calculations. 

 

Let’s begin by starting a design from the RF Node we placed in step 10. We’ll begin 
by attaching a cable to one of the available output ports on the node. Tip: it can be 
helpful to have a relatively large section of landbase and route refreshed then zoom 
in closer to add equipment so that it is not necessary to refresh every time you need 
to pan to add design. 

 

1. Click on the Node symbol to make sure it is selected. There are two ways to 
connect to a specific port on an RF device: select the symbol, press the add 
cable button and select from the available port dialog that appears; or select 
the symbol, select a specific port (you’ll know it’s selected because it changes 
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colors), and then press the add cable button. Now, select Add RF Cable from 
the RF toolbar: 

 

2. Select a cable type and a RF system type, enter other desired values. In mos
cases if you have strand distances available to you for design purposes, you
also want the Design Length Control set to “Estim

t 
’ll 

ate From Strand”, but the 

e AutoCAD determined length). 

4. You’ve now begun the design process! Note the addition of the Design Details 
to the standard line capture control dialog box: 

system has the flexibility to manually enter distances or estimate from the 
model length (th

3. Choose the port you’d like to connect to, if you didn’t select a specific port, 
and press Add. 

 

Figure 210 – Line Capture Controls with Design Details 

The design details show the current signal levels at the fwd high and low 
frequencies as well as a slope graph that can help to track the signal levels 
and slope as you design. Note, that the black line in the graph displays the 
slope and will flatten out as you design farther away from and active or othe
equalizing device. The design details can be collapsed by pressing the arrow 
next to the title “Design Details”. Click the Align Intermediate Housings 
checkbox to rotate connected devices without cable in between and set the 
Network Capture mode to Cable

 

r 

 Mode if there will be cable in between 

 
leg 

and you do want the tap on this port – right click on the housecount or pole 
symbol and a dialog similar to following will appear: 

devices or Cluster mode if there will be multiple pieces of equipment placed 
with no cable between. 

5. At this point, you have some design decisions to make. For instance, is there 
a housecount at the same location as the node and do you want to feed the 
tap from this port? Or, if you’re designing a Trunk section of the network you
may not want to place any taps at this time. Let’s assume this is a feeder 
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Figure 203 – Select pole annotation 

Select the pole / ped annotation to register the housecount and the system will only 
display taps with the correct number of ports in the Auto suggest function. 

6. Next right click on the map where you’d like to insert the tap and hold the 
curser over the Auto Suggest Taps option. A list of taps that meet the design 
criteria is then displayed, select the desired tap and the section of cable and 
equipment will be displayed on the screen in a temporary fashion (when the 
design leg is complete and you click done all design entities will then be 
displayed properly). 

 

Figure 204 – Select Auto Suggested Tap 

7. Let’s now continue placing taps along this run. Right click on the next stran
distance and a box similar to the one displayed when selecting housecounts
will appear. Select the “Aerial Footage” distance (or other distance attribute) 
to enter the actual strand distance into the system for this section o

Note: When placing Trunk or Express cable it will be necessary to rig
click on all distances along a run for the system to perform the design 
calculations correctly. 

8. Right click on the next housecount, right click to place an auto-suggested tap, 

d 
 

f cable.  

ht 

 
 

Also, at some point the Auto Suggest Taps option will be 

r, let’s place a coup nd place the 
end of line annotation block. 

9. If you’ve selected a self-terminating tap as your last tap, the system will 
automatically end the Cable Capture control and place the e nt. If 

and continue in this fashion. Note, that as you add cable and taps, the slope
graph begins to flatten out and the signal levels decrease due to the cable
attenuation and tap insertion losses. At some point, the Auto Suggest Tap 
options will have a gray line between two groups of taps: the upper group is 
non-self terminating taps and the lower group consists only of self 
terminating taps. 
completely blank, this is because there is not enough signal to place a tap 
that is within specification. It’s now time to amplify the signal. For this 
exercise, howeve le of taps, then terminate a

quipme
you’ve selected a non-self terminating tap as the last one, you’ll need to 
switch to cluster mode and select a terminator from the passives menu and 
then press done. 
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10.  The final step is to place the end of line annotation block. To do this simp
select the tap on the screen, press the Annotate Selected Entity icon on the
general toolbar: 

ly 
 

 

Then select the appropriate end of line annotation block from the drop down 
list in the dialog that appears and click on the screen where you want it 
inserted. Note that all levels are filled in automatically. 

Step 79: Designing RF Plant – Splitters, 
Taps, and Amplifiers 
In this exercise we’ll use the same methods described in Step 24, but we’ll go a lit
further and add an amplifier and maybe a splitter or two. 

tle 

ble ports. Before starting, ensure that you have a section of 
landbase and strand or trench large enough to need at least 2 splits and at 
least 1 line extender. 

 and 

3. When you come to the first split point right click and pick passive instead of 
Auto Suggest tap, then select the split you would like to use. Note that if 

e. 

 

lant – Powering  

1. Let’s once again start at the node placed in Step 10 and we’ll design off one 
of the other availa

2. Proceed now as in Step 24 – select the node, hit the Add RF cable button
begin to design.  

there is also a tap at that location, you may need to switch into Cluster Mod

4. When you are running low on signal, right click and select and amplifier from
the Active menu. 

 

It is encouraged that you take your time on this step and attempt to design 
numerous different scenarios so that you become accustomed to the tools and 
comfortable with their use. 

 

Step 80: Designing RF P
In this section we’ll add a new Power Supply to power the plant we’ve just built. 
Depending on your corporate policies it may or may no e necessary to place a 

 
cascade
Add Pa

t b
power block everyplace the power needs to be stopped. For instance, some 
companies require a power block on output of an amplifier if there are no other 
amplifiers cascaded afterwards; other companies simply need an “IN” flag in the 
amplifier annotation block.  

1. If company policies dictate, place power stops on the outputs of all “last in
 amplifiers. Select the output port at the amplifier, then click on the 

ssive button on the RF toolbar: 
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2. Select a power block from the drop down list of available passive devices an
click Add. 

d 

3. Next, determine the desired location for the power inserter. Like a power 
block, select the device port where you’d like to place the power inserter, 
click on the Add Passive on the RF toolbar and select a power inserter. 

tween 

4. Once  in place it’s time to place the power supply and 
hook it up to the network. Select Add Power Supply from the RF Tools toolbar: 

Note: Typically power inserters are defined with 3 ports – an in port, 
an out port, and a power port. The insertion loss is calculated be
the in and out port while the power port is the port actually connected 
to the power supply. 

 the power inserter is

 

Select the desired power supply and click  Add, then connect the power port 
on the power inserter to the power supply with the desired cable type. 

5. After placing the power supply and ensuring that power blocks are in place, 
click on the RF Power Tool button: 

 

 A trace result window similar to the one pictured below will appear showing 
equipment that is powered by all 
devices (if any) with warning

the selected power supply and showing 
 messages. 
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Figure 205 – RF Power Trace Results 

 

 

Step 81: Designing RF Plant – RF Network 
Reporting 
At this point, the network should be designed and working. To be sure, you can 
select a leg at a time and verify through the use of the RF Network Reporting tool. 
Press the RF Network Reporting button on the RF toolbar: 

 

 

A window similar to the following will be displayed: 
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Figure 206 – RF Network Reporting 

 The information contained in this report will provide a good amount of detail about 
the state of your network, allow you to view equipment details without having to 
navigate to each piece of equipment and allow you to zoom directly to certain 
devices or areas. 

 

Step 82: MDU Detail Drawings 
MDUs (Multiple Dwelling Units) pose a particular challenge in outside plant mapping, 
since they require a lot of design detail to be represented in a small space.  Often, 
they also include a significant vertical layout component, such as in high-rise 
apartment buildings. 

To support MDUs, SPATIALnet includes the ability to create MDU detail drawings.  
These are separate drawing spaces “internal” to the MDU which allow internal 
diagrams and plans of MDUs to be stored in the database and connected to the 
network. 

To create an MDU detail drawing: 
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1. Create an MDU by clicking the Create Buildings and Addresses button on the 
Landbase toolbar, as shown below. 

 

2. Specify the details of the MDU and place it on the map by clicking at the 
desired location. 

3. Select the new MDU by clicking on it. 

4. Add a new MDU Detail drawing to the MDU by clicking on the Add MDU Detail 
drawing button on the MDU Detail Drawing toolbar, as shown below. 

 

 

5. Specify the name you wish to give to the drawing and click the Add button to 
save it. 

6. To verify that the new detail drawing was added, open the MDU’s details panel.  
The new drawing should be listed similar to that shown below. 

 

Figure 2117 – Building Details Panel showing MDU Details 

 

7. To load the graphical appearance of the detail drawing, you must first open it 
in an AutoCAD window and then either draft the details you wish to record, or 
copy the contents of an existing DWG file into them.  The CAD-scrape process 
for MDU detail drawings works in an identical fashion to the process for outside 
plant maps. 

8. Adding modeled network features to an MDU detail drawing is identical to the 
process used for entering features into the outside plant maps. 
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Step 83: MDU Detail Drawings 
Demarcation Points 
To allow the outside plant map representation of the network to connect to the 
network represented in MDU detail drawings, special symbols called Demarcation 
Points or “demarks” are used.  When an MDU with a detail drawing is placed, a 
Demark should be placed in the detail drawing, and a matching Demark in the outside  

plant map.  In this situation, the system will assume that the point in the network 
represented by the outside plant representation of the Demark is the same as the 
point represented by the Demark in the detail drawing. 

To add a Demark to a Detail Drawing: 

1. Open the Detail Drawing by selecting the MDU, opening its Details panel, 
selecting the detail drawing to be shown, and Selecting Display > View Drawing, 
as shown below. 

 

 

Figure 2128 – Building Details Panel showing procedure for displaying Detail 
Drawing 

 

2. To place the Demark in the drawing, click the Add MDU Demark button on the 
MDU toolbar, as shown below. 

 

 

3. Give the Demark point a name and click on the location at which you wish to 
place the Demark point. 

4. To place the corresponding Demark on the outside plant map, repeat 2 and 3 
above, but place the Demark symbol at the location on the outside plant map 
at which you wish to display it (typically close to the MDU symbol). 
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5. The details panel of the MDU should display both Demark points, as shown 
below. 

Figure 2139 – Demarks added to MDU, and shown on outside plant map 

 

 

6. Demarks can be connected to the network in the same way as other plant.  
That is, when adding a cable, right-click on the Demark to form the connection.  
The cable connected to either side of matching Demarks will be treated as a 
single cable by the system. 
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Chapter 7 

Inside Plant 

This part of the tutorial walks you through the inside plant engineering and 
management functions of SPATIALnet FM.  The tutorial is divided into two sections.  
The first of these deals only with managing inside plant at the physical level (that is, 
equipment locations and attributes, connections between equipment, etc.).  The 
second section is more advanced and introduces you to SPATIALnet FM’s logical 
network modeling functions.  If you are not planning to use SPATIALnet FM to manage 
circuits, CWDM, DWDM or other routing/multiplexing schemes, then you should stop 
at the end of Section 1. 

 

Section 1.  Physical Plant Engineering and 
Management 
In this section’s example, you will perform an end-to-end job for fitting out a new 
network point of presence (POP) with equipment, including storing a floorplan and 
generating rack elevations and schematic views of the connectivity.  You will also add 
a customer site, and connect this to the POP via some outside plant fiber.  We will not 
go through the details of adding a realistic outside plant network in this part of the 
tutorial, since that was the subject of Part A.  So let’s assume that the customer and 
POP are next door to one another and require only minimal outside plant to connect 
them.  We don’t want to dispense with outside plant altogether in this part of the 
exercise, however, as one of the important topics we’ll cover is the interface between 
the outside and inside plant networks, allowing you to seamlessly trace connectivity 
and circuits between them. 

The sequence of steps is organized so that system configuration is not addressed until 
the end of the section.  This is because inside plant equipment requires more 
specification information that outside plant, much of this being graphical.  So, rather 
than interrupting the flow by inserting system configuration steps into the natural 
inside plant workflow, equipment specification is deferred until the last three steps. 

When Section 1 is complete, you may wish to work through Section 2, where we 
define logical network services and route these through the physical plant we created 
in Section 1. 

Step 84: Logging On and Selecting a Job 
This step is identical to Step 1 in Part A.  Please refer to the steps on page 26. 
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Step 85: Find a Map Location 
To record inside plant, Sites do not have to have a location on a map.  You can quite 
easily use SPATIALnet FM to manage sites as “aspatial” entities (that is, objects whose 
geographical location is not being modeled) and and never enter a single map into the 
system. 

However, in most cases, you will probably want to integrate inside plant management 
with your outside plant network so let’s take that approach here.  So, to begin with, 
we will need a map location at which to place our POP and the customer.  If you 
already have a map in the system, feel free to use that.  If you do not, run : CAD-
Scrape Landbase and Strand from Part A of the tutorial (page 28) to import some 
reference landbase.  Alternatively, just create a map view in empty space as follows: 

1. Make a drawing window is open. 

2. Run the menu command SPATIALnet > View > Settings… 

3. Make sure the View Type field is set to All Networks (Seamless), and that the 
Select Area check box is clear. 

4. Click the Apply button.  This will create a drawing window with a view onto the 
database at the coordinates of the original drawing window.  Most likely, it will 
be empty.  If it isn’t it doesn’t matter because we will not be interacting with 
any existing map objects in the remaining steps. 

5. Dismiss the View Settings panel by clicking the Close button. 

 

Step 86: Add New ISP Site 
 

All inside plant in SPATIALnet FM must be contained within a site.  So, now that you 
have logged on and have a map view open, the first real step in this exercise is to add 
a new site.  Before we can add a new site, however, we must ensure that the type of 
site we wish to add is in the system’s Site Dictionary.  For Part B of the tutorial, we 
shall only use site types which are supplied in the default configuration of SPATIALnet 
FM.  : Add New Site Type in Part A (page 61) walks you through adding a new site 
type should you wish to review this. 

Sites have both outside plant (OSP) and inside plant (ISP) characteristics, so they 
appear on both the FM OSP and FM ISP menus.  However, the configuration of site 
types is treated as an OSP function (which is why we covered it in Part A). 

Note: Although they refer to the same object, the OSP and ISP menus use 
slightly different language to refer to a site.   Adding a site is found under 
FM OSP > Add > Facility…, and also under FM ISP > Add > Building…   Both menu 
options run the same command, however. 

 

To add our new Point of Presence and a neighboring customer site: 
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1. Run the menu command FM ISP > Add > Building…  (you could equally well run 
FM OSP > Add > Facility… or click the Add Facility button on the Add toolbar as 
shown here , since they all do exactly the same thing). 
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2. Fill in the fields of the Building Creation dialog with the values shown in Figure 
214, below (Note: for this exercise, it is important to ensure that the Capable of 
modeling inside plant check box is checked for both buildings) 

 

Figure 214 – ISP Building Creation Dialogs for POP (left) and Customer (right) 

 

3. Ensure that the “Placement” cross hair is selected in the Building Creation 
dialog, as shown in Figure 214, above, and also here: 
 

4. Place the new building on the map by clicking twice in the drawing window 
(first click to set input focus back to the drawing window, second click to place 
the new entity). 

5. When you have added the POP, repeat items 2 to 4 above for the Customer 
building.  To simplify linking up the two buildings later, place the customer site 
close to the POP, similar to the example shown below. (Of course, if you would 
like to run a geographically realistic outside plant network between the two 
buildings using the steps covered in Part A, then by all means do so!) 

 

Figure 215 – Example locations of POP and Office Tower 

6. When you have added both buildings, click the Close button shown in Figure 
214 to dismiss the Building Creation panel. 
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Note: The relative sizes of the POP and Customer symbols may appear 
different to that shown in Figure 215, above.  If so, you may change the 
symbol scale of either site type from the FM OSP > System Configuration > Site 
Definitions… menu by editing the Symbol Scale property of the chosen Site Type. 

 

Step 87: Search for and Select Sites 
All inside plant equipmenet in SPATIALnet FM must be assigned to a floor in the 
building inside which it is located.  So, before we can add any equipment to a building, 
we have to add at least one floor.  But before we can add a floor to a building, we 
must be able to find the building, select it, and display its details.   

The steps below provide several alternative options for doing this.  You should try 
using each of them. 

Option 1: Select from the map 

1. Select one of the buildings by clicking on its map symbol in the drawing 
window, as shown in Figure 215, above.   

2. Click the Details button on the General toolbar, as shown: 

 

 

Option 2: Search by Name 

1. Run the menu command FM ISP > Find > Find by Name > Building…  The panel 
showin in Figure 216, below will be displayed. This panel provides a number of 
search operators, such as equals, like, etc.   

2. Fill in the values for each of the fields shown in Figure 216, below for each of 
the buildings and click the OK button. 

 

Figure 216 –Wildcard searches for all Buildings whose name includes Cent 
(left) and whose name begins with Office (right) 

 

3. When the search is complete, the details of the building will be displayed.  

 

Notes:  

1. Using a like search lets you include wildcards (represented by the % 
character).  

2. The search is case sensitive. 
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Option 3: List Buildings 

1. Run the menu command FM ISP > List > Building…  This will display a panel 
listing all buildings by name.   

2. Click on the row containing the building you wish to work with. 

3. Click the Display >> button and select Details from the pop-up menu. 

 

After completing steps in any of the above options, the details panels for each of the 
buildings should be visible, similar to those shown below. 

 

Figure 217 –Details panels for Central POP and Office Tower buildings. 

 

 

Step 88: Add Floor to Sites 
If you completed Step 87 you should have Details panels open for each of the Central 
POP and Office Tower buildings, as shown in Figure 217, above (if you haven’t, you 
should do this now). 

We will now add a floor to each of these buildngs.  After doing that, we can choose to 
import floorplan drawings, or to draft a floorplan directly into AutoCAD.  Neither of 
these are mandatory, but to illustrate the process, we shall import a floorplan in Step 
89, below. 

To add a floor to each of our buildings, repeat the following steps for each building: 

1. Click the Add… button on the Building Details panel, and select Add a floor to 
the highlighted building from the pop-up menu. 

2. Fill in the values for each of the fields shown in Figure 218, below for each of 
the buildings, and click the Add button. 
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Figure 218 – Floor details to be added for Central POP (left) and Office 
Tower (right) 

 

3. Dismiss each of the Building Floorplan Creation panels with the Close button.  

4. Expand the Building Floorplan drawings branch of the tree view in each of 
the Building Details panels.  The new floors should be visible, as shown 
highlighted in Figure 219, below. 

 

Figure 219 – Floors added to Central POP (left) and Office Tower (right) 

 

 

Step 89: Import Floorplan Drawing 
While it is not necessary to import a floorplan drawing, if you have one, it is certainly 
helpful to use the information in it to accurately locate inside plant equipment.  For 
this exercise, a sample floorplan drawing supplied with the documentation will be used 
(you can substitute this for a drawing of your own if you wish). 

Existing floorplan drawings are imported into the system using CAD-Scrape in a way 
that is completely analogous to the import of the base map in : CAD-Scrape Landbase 
and Strand of Part A (see page 28).   

To import a floorplan drawing: 

1. Run the AutoCAD File > Open command. 
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2. Navigate to the directory containing your SPATIALnet documentation (usually 
Program Files/SPATIALnet/doc) 

3. Open the AutoCAD file Floorplan.dwg. 

4. When the file is opened, SPATIALnet will display the following panel: 

 

 

Figure 220 – SPATIALnet Open Drawing File Dialog 

 

 

5. Select SPATIALnet view from the Open drawing as pulldown list and make sure 
the other fields are filled in as shown in Figure 220 above.  These fields 
determine which building and which floor the floorplan will be associated with.  

6. When the field values are correct, click on the Continue button. 

7. When the graphics are visible in the AutoCAD window and the Open Drawing 
File dialog has closed, run the File > Save AutoCAD command to import the 
graphics into the SPATIALnet database (running the Save command will 
automatically initiate the CAD-Scrape process.  The Scrape process may take a 
minute or two.  See Chapter 10 for further information about CAD-Scrape). 

When this process is complete, the imported graphics will be displayed whenever you 
open the floorplan view for the specific building and floor. 

 

Notes: 

1. You can also CAD-Scrape any AutoCAD objects created during the 
session using normal AutoCAD drawing commands.  You don’t always 
have to open a DWG file.  You do have to have a SPATIALnet view 
open, however (not a native CAD file). 

2. Any blocks scraped in must be defined either in a DWG file on the 
AutoCAD Support File path (the usual method), or in the view template 
DWT file.  CAD-Scrape only records block names; it does not read the 
block definition into the database. 

3. Properties of CAD Layers must be defined in the view template DWT 
file.  If the system renders a CAD object into a layer which is not 
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defined in the view template DWT file, the default color, linetype, 
lineweight, etc. will be used. 

4. Because of points 2 and 3, the objects rendered back into AutoCAD 
after being imported using CAD-Scrape may appear different from the 
original objects.  This can be fixed by making the Layer and block 
definitions available as described in points 2 and 3. 

 

To validate that the floorplan is indeed stored in the database, close the window from 
which you ran the CAD-Scrape, and open the details panel for the Central POP 
building.  Clicking the Display>> button and selecting Floorplan View from the pop-up 
menu will retrieve the floorplan from the database and display it in AutoCAD. 

Note: If you do not import a floorplan, then displaying a floorplan view will 
create an empty window.  It is still possible to place equipment into this 
window, and to draft and Scrape CAD objects at any later time. 

 

Step 90: Adding Racks 
Let us now add a pair of racks to each of the buildings we created in Step 86, above.  
Repeat the following steps for each of the buildings: 

1. Select the building and display its Details panel (see Step 87, above). 

2. Click the Display>> button and select Floorplan View from the pop-up menu.  
The floorplan view of the building will be displayed in a new drawing window. 

3. Run the Add Rack function by one of the following methods: 

a. Run the FM ISP > Add > Rack… menu command. 
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b. Click the Add Rack button on the Add Network Equipment ISP toolbar, 
as shown here:  

 

4. Fill in the fields of the Rack Creation dialog as shown in Figure 221, below (see 
item 5 below for making the selection in the Type field) 
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Figure 221 – Rack Creation panel 

 

5. To select the type of equipment to add, click the Select button.  This will bring 
up a list of entries in the equipment dictionary that match the class of 
equipment you are trying to add.  You can refine this list further using the 
query operators and filter values at the top of each column.  When you have 
highlighted the row containing the rack type you would like to add, click the 
Select button on the equipment dictionary list panel.  This will close the panel 
and return you to the Rack Creation panel.  For this example, select the Virtual 
Rack entry. 

Note: If you know the numerical Catalog ID of the equipment you would like 
to add, you can type it directly into the Type field shown in Figure 221, above 
without having to list entries from the equipment dictionary. 

6. When all the information has been specified in the Rack Creation panel, click 
the location on the floorplan drawing where you would like to place the rack 
(click twice—once to set input focus to the drawing window, and again to 
specify the location of the new rack).  The new rack should appear similar to 
that shown below. 

 

Figure 222 – New rack appearance in floorplan view. 
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Note: The rack symbol will not be displayed correctly if the directory 
containing the block file is not on AutoCAD’s support path.  In this case, a 
symbol similar to the following will be displayed instead of that shown in 
Figure 222: 

 

To remedy this problem, ensure that the blklib\floorplan subdirectory of your 
SPATIALnet installation is included in AutoCAD’s support file search path. 

 

7. Repeat items 3 to 6 above to create another rack in the Central POP building 
(change the Rack No, Name and Comment fields to different values), and then 
repeat items 1 to 6 to create a new pair of racks in the Office Tower building. 

Note: The following must be unique for each rack in a building: 

• Combination of Floor No, Aisle No, Rack No. 

• Name 

These values may be duplicated in different buildings, however. 

 

Step 91: Generating a Rack Elevation View 
Let us now look at our new racks front-on in an elevation view.  To do this: 

1. Bring up the floorplan view of the Central POP building, which should now 
contain the two racks added in Step 90 (the first two items in Step 90 will 
remind you how to do this). 

2. Change the system selection type to Multiple by clicking the Current Selection 
button on the General toolbar as shown here: 

 

Then choose Multiple in the Selection Mode field of the dialog box that is 
displayed.  Also, if it is shown, click the Clear button to remove any existing 
selection (this button will be hidden if there is no current selection). 

3. Select the pair of racks in the floorplan view by drawing a box around them, 
using the normal AutoCAD/Windows graphical selection technique. 

4. Click on the Rack Elevation toolbar button, as shown here:  
Two rack elevation symbols, one representing each of the  
selected racks, will be displayed in a new drawing window. 
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Step 92: Adding Chasses 
With the elevation view you created in Step 91, above, it is easy to insert equipment 
into the racks.  In this step, we will insert a fiber patch panel and then a chassis into 
the racks.  (We will insert some transmitter and receiver cards into the chassis in Step 
93.) 

1. If a rack elevation showing the two racks in the Central POP building is not 
visible, re-do Step 91, above, to display it. 

2. Select the rack labeled Fiber Patch by clicking on it in the elevation view.  A 
small triangle will be displayed at the base of the rack indicating that it is now 
selected. 

3. Run the Add Chassis function by one of the following methods: 

a. Run the FM ISP > Add > Chassis… menu command. 
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b. Click the Add Chassis button on the Add Network Equipment ISP 
toolbar, as shown here:  

 

4. Fill in the fields of the Chassis Creation dialog as shown in Figure 223, below 
(see item 5 below for making the selection in the Type field).  Note that we will 
place the chassis at mount point 44 on the rack, which is selected from the 
Position pull-down list. 

 

Figure 223 – Chassis Creation panel 

 

5. To select the type of equipment to add, click the Select button.  This will bring 
up a list of entries in the equipment dictionary that match the class of 
equipment you are trying to add.  You can refine this list further using the 
query operators and filter values at the top of each column.  In this case, we 
will add a Antec/LL72IN Fiber Patch Shelf. 

When you have highlighted the row containing the chassis type you would like 
to add, click the Select button on the equipment dictionary list panel.  This will 
close the panel and return you to the Chassis Creation panel. 
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Note: If you know the numerical Catalog ID of the equipment you would like 
to add, you can type it directly into the Type field shown in Figure 223, above 
without having to list entries from the equipment dictionary. 

6. When all the information has been specified in the Chassis Creation panel, click 
the Add button shown in Figure 223.   

7. Now add a transmitter/receiver chassis in the second rack by selecting the 
rack, and repeating items 2 to 6 above.  In item 5, choose the Antec LL2 Light 
Link 2 chassis from the equipment dictionary. 

8. The new chasses should appear similar to those shown in Figure 224, below. 

 

Figure 224 – New chasses appearance in elevation view. 

 

Note: The symbols will not be displayed correctly if the directory containing 
the elevation block files is not on AutoCAD’s support path.  In this case, 
symbols similar to the following will be displayed instead of those shown in 
Figure 224: 

 

To remedy this problem, ensure that the blklib\elevation subdirectory of your 
SPATIALnet installation is included in AutoCAD’s support file search path. 

 

9. Repeat items 3 to 7 above to create a similar pair of chasses in the racks in the 
Office Tower building. 

Note: The following must be unique for each chassis in a building: 

• Combination of Floor No, Aisle No, Rack No, Mount Point No. 

• Name 

These values may be duplicated in different buildings, however. 
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Step 93: Adding Cards 
Now that we have some racks and chasses in place, the last pieces of equipment we’ll 
install at each site are some cards that fit into the LL2 chassis.  As you’ll see, the 
process for inserting cards is almost a re-run of Step 91 and Step 92, giving the ISP 
environment a consistent set of procedures for managing any kind of equipment. 

To insert an optical transmitter into the LL2 chassis,  

1. Make sure the rack elevation view you were working with during Step 92 is 
open and the LL2 chassis (shown on the right in Figure 224) is visible.  If it is 
not, run Step 91 again. 

2. Select the LL2 chassis labeled Fiber Tx/Rx (shown on the right in Figure 224) 
by clicking on it in the elevation view.  A square SPATIALnet manipulator will 
appear at the bottom left corner of the chassis when it is selected. 

3. Run the Add Card function by one of the following methods: 

a. Run the FM ISP > Add > Card… menu command. 
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b. Click the Add Card button on the Add Network Equipment ISP toolbar, 
as shown here:  

 

 

4. Fill in the fields of the Card Creation dialog as shown in Figure 225, below (see 
item 5 below for making the selection in the Type field).  Note that we will 
place the first card in slot 1 of the chasses, and the second card in slot 2.  Slot 
numbers are selected from the Position pull-down list shown below. 

 

Figure 225 – Card Creation panel 

 

5. To select the type of equipment to add, click the Select button.  This will bring 
up a list of entries in the equipment dictionary that match the class of 
equipment you are trying to add.  You can refine this list further using the 
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query operators and filter values at the top of each column.  In this case, we 
will add an Antec/LLNTX Optical Transmitter. 

When you have highlighted the row containing the card type you would like to 
add, click the Select button on the equipment dictionary list panel.  This will 
close the panel and return you to the Card Creation panel. 

Note: If you know the numerical Catalog ID of the equipment you would like 
to add, you can type it directly into the Type field shown in Figure 225, above 
without having to list entries from the equipment dictionary. 

6. When all the information has been specified in the Card Creation panel, click the 
Add button shown in Figure 225.   

7. Now add an optical receiver to the same chassis by repeating items 2 to 6 
above.  In item 5, choose the Antec/LLNRX Optical Receiver from the 
equipment dictionary and insert this card into slot 2 of the LL2 chassis. 

8. The new cards should appear similar to those shown in Figure 226, below. 

 

Figure 226 – New cards’ appearance in elevation view. 

 

Note: The symbols will not be displayed correctly if the directory containing 
the block files is not on AutoCAD’s support path.  In this case, a symbol 
similar to the following will be displayed instead of that shown in Figure 226: 

 

To remedy this problem, ensure that the blklib\elevation subdirectory of your 
SPATIALnet installation is included in AutoCAD’s support file search path. 

9. Repeat items 2 to 7 above to create a similar pair of cards in the Fiber Tx/Rx 
chassis in the Office Tower building. 

Note: The following must be unique for each card in a building: 

• Combination of Floor No, Aisle No, Rack No, Mount Point No, Slot No. 

• Name 

These values may be duplicated in different buildings, however. 
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Step 94: Creating a Connectivity Schematic 
Detail Drawing 
We’ve covered two of the three ISP view types (floorplans and rack elevations).  Let’s 
now look at the third (schematics). 

In Step 92 and Step 93, we inserted a fiber patch panel and some optical equipment, 
but we did not connect them in any way.  So, while we have a record of our 
equipment and its location, we do not yet have any record of its connectivity.  This is 
where schematic views are very helpful. 

Schematic views are similar to floorplans, in that they exist as persistent objects in 
the database.  Therefore, before you can use a schematic view, you need to create it 
in the database and name it.  By contrast, rack elevation views are generated “on the 
fly” and do not exist in the database.  When you close a rack elevation window, you 
have to regenerate the elevation view by selecting the same set of racks again. 

One difference between schematic and floorplan drawings, however, is that floorplan 
drawings are associated with a unique floor in the building.  Schematic drawings, on 
the other hand, are just associated with the building itself, and know nothing about 
floors.  This makes it easier to represent connected equipment on different floors. 

To create a new schematic drawing: 

1. Make sure the Current Building is set to the building you are working on 
(Central POP for this example).   

Note: If you have an ISP view open already (a rack elevation, floorplan or 
schematic), Current Building will be set to the building containing the 
data in the view.  If you do not have an ISP view open already, or you 
would like to check Current Building, click the Current Selection button on 
the General toolbar, and inspect or make a selection from the SPATIALnet 
Current Selection Panel.  You can change Current Building by clicking on the 
field where the current value is displayed and making a selection from 
the pop-up list.  See Figure 227, below for an example. 

 

 

Figure 227 – Current Selection panel allows you to set Current Building. 

 

2. Run the menu command FM ISP > Detail Drawings > List Detail Drawings.  A panel 
with an empty list box should be displayed. 

Page 216 idential  Conf



SPATIALnet FM Tutorial Step 94: Creating a Connectivity Schematic Detail Drawing 
 

3. Click the Add… button on the All Detail Drawings list panel.  

4. Fill in the fields of the Detail Drawing Creation panel as shown in Figure 228, 
below. 

 

Figure 228 – Detail Drawing Creation panel 

 

5. When the fields are filled in as required, click the Add button shown in Figure 
228. 

6. Click the Close button to dismiss the panel.   

The new detail drawing you just created should now be visible in the All Detail 
Drawings list for the current building. 

 

7. Select the new row in the All Detail Drawings list panel, click the panel’s 
Display>> button and select Detail Drawing from the pop-up menu.  This will 
retrieve the detail drawing from the database and display it on the screen, 

 

It should be immediately obvious that this drawing is currently empty.  This is 
because SPATIALnet FM takes the approach that connectivity schematics should be 
more than a diagram of all connections that the software can find the network without 
any context.  Rather, schematics should present a form of structured documentation 
which conveys the underlying design intentions and organization of the network in a 
way that is meaningful to human operators.  To achieve this, you must tell SPATIALnet 
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FM which pieces of equipment are to appear in which schematic drawings, and where 
they will be placed within those drawings.  SPATIALnet FM will then take care of the 
rest (connectivity, data updates, etc.) 

So, since we have not yet placed any equipment into our new schematic, it is 
currently empty.  Let us remedy that state of affairs now. 

 

Step 95: Placing Equipment into a 
Schematic View 
 

To place equipment into a schematic view, it is easiest to first select the equipment in 
another view, and then place it into the schematic.  Rack elevations are ideal for 
selecting the equipment we need, so make sure the rack elevation view we generated 
in Step 91 is currently visible on the screen (see Step 91 above if you need to 
regenerate it). 

In addition, the window containing the currently empty schematic drawing should also 
be visible.  An easy way to achieve this is to use AutoCAD’s Window > Tile Vertically 
menu option.  Then arrange the windows so they look something like Figure 229, 
below.   

We will place a schematic representation of the patch panel, the transmitter and the 
receiver into the schematic view.  To do this: 

 

1. Click on the piece of equipment in the rack elevation view that you wish to 
place into the schematic view. 
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2. Click the Place Selected Card in Detail Drawing button on the Detail Drawings 
toolbar, as shown here:  

 

3. The Detail Drawing Card Creation panel will appear, as shown in Figure 229, 
below.   

4. Click on the Schematic window to activate it for input.  Then click at the 
location at which you wish to place the schematic representation of the 
selected equipment.  The system will display the appropriate symbol at the 
location you specified. 

5. Close the Detail Drawing Card Creation panel. 

6. Repeat items 1 to 5 above until all of the equipment you wish to display in the 
schematic has been placed (in the current example, this includes the fiber 
patch panel, the optical transmitter and the optical receiver.  A suggested 
layout is shown in Figure 229, below). 

 

Figure 229, below shows the sequence of steps as they typically appear on the screen. 

Note: Many of the Tooltips and other user interface features refer to this 
function as placing a “Card” into a Detail or Schematic drawing.  The function 
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actually applies to any connectable device, including racks, standalone 
equipment and chasses as well as cards. 

Detail Drawing Card 
Creation panel appears 3 

Click on 
device in rack 
elevation 
view 

Click on location in 
schematic drawing where 
device is to be placed 

5 
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Rack 
Elevation 
View 

Schematic 
View 

1 

Click the Place 
Selected Card in 
Detail Drawing 
button 

2 

4 

Close panel 

 

Figure 229 – Sequence of steps for placing equipment from a rack elevation view 
into a schematic view 

 

Note: The symbols will not be displayed correctly if the directories containing 
the block files are not on AutoCAD’s support path.  In this case, a symbol 
similar to the following will be displayed instead of those shown in Figure 
229: 

 

To remedy this problem, ensure that the blklib\elevation and blklib\detail 
subdirectories of your SPATIALnet installation are both included in AutoCAD’s 
support file search path. 
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Step 96: Connecting Equipment 
Once equipment is visible in a schematic drawing, connecting it is very easy.  Notice 
that if you select an object in a schematic view, yellow circles are drawn at each 
connectable port.  Thes circles are SPATIALnet FM’s “connection manipulators” and are 
used to form new connections when you drag and drop them from one port to 
another. 

To try this out, let’s connect the transmitter and receiver to the patch panel with some 
jumper cables. 

1. Ensure the schematic drawing shown in the right window pane in Figure 229, 
above, is visible and has the input focus. 

2. Click on the transmitter symbol.  A connection manipulator (shown as a yellow 
circle) will be drawn at each of the ports. 

3. Click on the connection manipulator and drag it over each piece of equipment.  
When a connection manipulator senses another piece of equipment nearby, it 
will activate the manipulators on that equipment’s ports. 

4. Continue to drag the connection manipulator to the port labeled IN 1 on the 
patch rack.  Drop the manipulator onto this port. 

5. A pop-up will prompt you to create a new connection between the ports.  Click 
on this button, as shown in Figure 230, below. 

 

Figure 230 – Creating a connection between equipment ports. 

 

6. When you click the pop-up button to create the connection, the Cable Creation 
panel will be displayed, prompting you for details about the jumper cable to be 
used for the connections. 

7. Click the Select button on the panel and select a Fiber Jumper cable type from 
the equipment dictionary.  Fill in the other fields with values you choose. 

8. Click the Add button on the Cable Creation panel.  This will create a connection 
between the ports you selected, and will show this graphically in the schematic. 
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9. When you select the connection, green manipulators will be displayed at each 
vertex of the connection line, and red manipulators will be displayed at each 
segment’s mid-point.  The green manipulators move the vertices, while the red 
manipulators move the entire segment orthogonally.  These tools let you tidy 
up the appearance of the schematic.   

Notes: 

1. Any graphical changes you make to the schematic (move 
equipment, move linework, etc.) will be stored in the database and 
will be present each time the drawing is viewed in future sessions. 

2. Deleting a connection line in a schematic deletes the connection 
between the ports, and removes the cable making the connection 
from the database. 

3. Deleting a piece of equipment from a schematic can either: 

a. Delete the equipment, and all its representations from the 
datatbase, or 
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b. Delete the equipment from the schematic only.  In this 
case, any connections to the equipment are replaced by a 
“feather” hyperlink symbol: 
 

4. CAD-Scrape may be used in schematic drawings to add 
miscellaneous annotation, mark-up, etc. 

Step 97: Moving Equipment 
Step 96 completed the process for adding and connecting inside plant equipment.  Let 
us now see how we move it around. 

To change the location of floor-mounted equipment (racks and standalones), you 
simply select the symbol representing the equipment and drag it to its new location 
using the manipulator. 

Moving equipment in rack elevation views is more interesting, as rack-mounted 
equipment can only be moved to valid, unoccupied mount-point locations, and cards 
or modules can only be moved to valid, unoccupied slots.  SPATIALnet FM’s elevation 
views provide a visual “drag and drop” approach to this, similar to creation of 
connections in schematic views that we saw in Step 96. 

Suppose we wish to move the LL2 chassis we created in Step 92, and all the cards it 
now contains, to a new location either in the same rack or a different rack.  To do 
this: 

1. If it is not already visible, generate the rack elevation view containing the two 
racks in the Central POP building, as described in Step 91, above. 

2. Select the LL2 chassis by clicking on it.  Notice that a green square 
manipulator is displayed in the bottom left corner.  Click on this manipulator 
to begin dragging the chassis. 

3. As you begin to drag the chassis, all the rack mount-points in the rack 
elevation view are highlighted with yellow square markers.  Drop the chassis 
onto one of these markers in either rack.   
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4. The mount-point numbers near your drop point will be displayed.  Click on the 
mount point number at which you wish to re-mount the chassis and the 
chassis and all its contents will be moved. 

Step 98: Creating a Cable Run List Report 
In addition to the tools we have seen so far for managing data about your network, 
SPATIALnet FM also provides many reporting tools.  We shall look at one of these in 
this step, the Cable Run List. 

The Cable Run List report lists all of the inside plant connections, disconnections and 
re-connections that are made in the current job, and stores these in a .CSV file which 
can be read with Microsoft Excel.  To produce a cable run-list for the current job: 

1. Run the menu command FM ISP > Reports > Generate a Cable Run List 

2. Type a filename into the Output Path field, or click the button labeled … to 
browse to a location where the file will be stored.  Note that the filename 
should end in the extension .csv 

3. Click the Save List button. 

4. Open the file you saved in Microsoft Excel. 

 

Step 99: Connecting ISP Buildings with 
Outside Plant Cables 
 

One of the most powerful features of SPATIALnet FM is the ability to manage a 
comprehensive and detailed model of both inside and outside plant networks in a 
single application.  To utilize the full power of this feature, you must be able to 
connect inside plant to outside plant.  Since this part of the tutorial focuses on inside 
plant (see Part A for outside plant), we shall create only minimal outside plant in this 
step—just enough to connect together the two buildings that have been with us since 
Step 86. 

To do this: 

1. Create a map view showing both buildings (Refer to Step 87, above, for a 
reminder of how to do this.  Use the Display>> Map View button). 

2. Make sure both buildings have at least one rack in them.  If they do not, you 
will have to add one before you can continue with this step. 

3. Select the Central POP building by clicking on it. 

4. Run the Add Fiber Cable command to create a fiber between the Central POP 
and Office Tower buildings via one of the following methods: 

a. Run the menu command FM OSP > Add > Fiber Cable 
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b. Click the Add Cable button on the Fiber Add toolbar, as shown 
here:  
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5. Fill in the fields of the Fiber Cable Creation panel as shown in Figure 231, 
below. 

 

Figure 231 – Fiber Cable Creation Dialog 

 

6. Ensure that the “Selection” arrow is selected in the Fiber Cable Creation Dialog, 
as in Figure 231, above, and also shown here:   
 

7. Click the Add button.  You will be prompted to specify which rack the fiber 
cable you are about to create should be connected to, and which splice 
enclosure within the rack.  Since none of our racks have splice enclosures in 
them yet, you must create one with the New Splice button. 

8. After creating the new splice, expand the OSP Equipment branch of the rack 
view and Select the splice, as shown in Figure 232, below.  This will begin the 
cable creation process. 

 

Figure 232 – New OSP fiber splice point in rack 
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9. We won’t bother with any real outside plant routing for this cable, so just right 
click on the Office Tower building, and select this from the displayed pop-up 
to connect the cable (Hint: if the Cable Creation dialog box is overlapping one 
of the buildings, use the       button on the Line Capture Control panel to hide 
it). 

10. You will need to specify the terminating splice enclosure for the cable in the 
Office Tower building, just as you did for the Central POP in items 7 and 8, 
above. 

11. Click the Done button        on the Line Capture Control panel to finalize the 
cable and add it to the database. 

 

The last task in the process is to add a fiber termination panel so that we can connect 
the fiber to the ISP patch shelf we created in Step 92.  To do this: 

12. Select the rack containing the end of the OSP fiber we just created (Rack01 if 
you followed the example in Figure 232).  You may do this by bringing up a 
floorplan view or rack elevation (see Step 91) containing it, running the menu 
command FM ISP > List > Racks, or by any other selection method. 

13. When the rack is selected, bring up its Details panel by clicking on the Details 
button (if you are looking at a list panel), or clicking the Details button on the 
General toolbar, as shown here. 
 

14. Find the Splice Enclosure entry under the OSP Equipment – OSP 
Connectivity branch and select it by clicking the Select button on the Details 
panel. 

15. Add a Term Panel to the splice enclosure (see Step 29 of Part A on page 88).  
Choose the 72-port IO panel and call it Central POP TERM 1. 

16. With the Splice Enclosure selected as in item 14, splice the Term Panel to the 
OSP Fiber (see Step 43 of Part A on page 133). 

 

This completes adding an (albeit minimal) outside plant cable and connecting it 
physically to a rack. 

 

Step 100: Creating OSP/ISP Interfaces 
Before we can trace a signal from inside plant to outside plant, we need to tell the 
system how the two networks are interfaced together.  That is, we need to model the 
front-to-back connection of the patch panel chassis we created in Step 92.  In 
SPATIALnet FM, this kind of connection exists as a named mapping called an OSP 
Interface.  We will now create one. 

To do this: 

1. Make sure Current Building is set to Central POP (see the Note in Step 94 for 
more information about Current Building) 
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2. Run the menu command FM ISP > List > OSP Interface.  This will list the OSP 
interfaces which have been defined for the Current Building.  At present, there 
are none so this list will be empty. 

3. Click the New button on the list panel and fill in the fields of the Interface 
Creation panel with the values shown in Figure 233, below. 

 

 

Figure 233 – Interface Creation panel. 

 

4. Click the Add button to create the new interface, which will be named 
CentralPOP OSP CABLE1. 

We now need to apply this interface to map the front of the fiber patch panel to the 
back (i.e., to the fiber termination created in item 15 of Step 99, above). 

To do this: 

5. Select the fiber patch panel by any means (rack elevation drawing, list, entry 
in Rack01 Details panel, etc.). 

6. Click the Edit button.  The Chassis Modification panel will be displayed.  Note 
that the Interface field is currently set to nothing selected. 

7. Click on the Interface field and choose Select current building from the pop-up 
menu.  This will display a list of all OSP Interfaces defined for the current 
building. 

8. Choose the CentralPOP OSP CABLE1 interface (listed under ISP/OSP 
Interfaces) and click the Select button. 

9. Click Apply and then Close on the Chassis Modification panel. 

 

Figure 234 below shows the sequence of panels used to select the fiber patch panel 
and map it to the OSP Interface. 
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Figure 234 – Mapping an OSP Interface to the fiber patch panel 

 

At this point, the OSP Interface is pointing to the front panel.  We now need to add 
the back panel part.  To do this, we follow an identical process to items 5-9 above, but 
we select the Term Patch Port Bank under the rack’s OSP connectivity branch. 

This completes the connection of the inside plant network to the outside plant.  It is 
now possible to trace connections through both networks, as we shall see in the next 
step. 

 

Step 101: Tracing 
 

Now that we have connected our inside and outside plant networks, let’s trace a 
physically connected path from one building to the other.  To do this: 

 

1. Open the map view showing the OSP cable connecting the Central POP and 
Office Tower buildings. 

2. Open the Detail Schematic drawing for Central POP you created in Step 94. 

3. Use the AutoCAD menu option Window > Tile Vertically to show both windows 
approximately equally on the screen. 

4. Select the jumper connection from Transmitter 1 to the fiber patch panel by 
clicking on the line connecting the two. 
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5. Begin a trace by clicking on the Trace Fiber toolbar button on the Trace 
toolbar, as shown here: 
 

6. Fill in the fields of the Trace Configuration panel as shown in Figure 235, 
below. 

 

 

Figure 235 – Trace Configuration Panel 

7. Click the Trace button.  The system will begin at the selected inside plant 
jumper cable and work its way through the inside and outside plant networks.  
The physical path traversed by the trace is visually highlighted and a report is 
produced.  Note in particular that the trace begins inside the Central POP 
building, travels along the OSP cable, and ends at the Office Tower building.  
The results are shown in Figure 236, below. 

 

 

Figure 236 – Trace results showing tracing from ISP to OSP and into next building. 
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Step 102: Configuring a Rack Type 
Note: Step 102 and Step 103 are only relevant to users who will be 
responsible for configuring new types of inside plant equipment in SPATIALnet 
FM’s equipment dictionary and/or creating ISP symbols.  If you will not be 
required to do this, you can skip these steps. 

If you have worked through Part A of this tutorial, which deals with outside plant, you 
will already be familiar with how to update the various dictionaries SPATIALnet FM uses 
to specify the various classes of OSP equipment; a similar approach is used for inside 
plant.  The main difference, however, is that in ISP all equipment configuration is 
managed from a single equipment dictionary, instead of a separate dictionary existing 
for each class of equipment. (The reason behind this is that a common set of 
properties can be used to specify almost all types of ISP equipment, whereas each 
class of OSP equipment requires different specification properties.) 

Entering the specification of a new type of ISP equipment into the system generally 
involves two tasks: 

• Creating an equipment dictionary entry. 

• Creating various kinds of intelligent symbology and registering these with the 
system. 

We shall cover both of these below.  Before we do, however, we must review some 
background about SPATIALnet FM’s ISP view types. 

 

Inside Plant View Types 

Another key difference between inside and outside plant equipment is that there is 
only a single outside plant view type (the map view), while there are three inside 
plant view types: 

• Floorplan views 

• Rack elevation views 

• Connectivity schematic detail views. 

Full details of these view types are provided in the SPATIALnet FM User Manual.  We 
will just review the basics here, as they apply to the configuration of equipment types. 

The most important fact about ISP views is that a single piece of equipment will have 
very different appearances and behaviors in each of the three view types, as 
summarized in the table below.  Note, however, that a given piece of equipment may 
not be represented in all view types (rack mounted equipment has no representation 
in floorplan views, for example). 

ISP View 
Type 

Type of display Types of actions which can 
be performed 

Example 
equipment block 

for view type 

Floorplan “Top down” plan view showing 
location of racks and free-standing 
“Standalone” equipment (chasses, 
cards and cables are not shown).   

Can move objects around to 
change their location, but can’t 
graphically change connectivity 
or vertical rack layouts. 
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Rack 
Elevation 

Front elevation view showing actual 
dimensions of racks, chasses, cards 
and standalones.  Cables are not 
shown.   

Location of objects in racks can 
be maintained by “drag and 
drop” functions.  Cannot 
graphically change floor 
location or connectivity. 

 

Schematic 
Detail 

Ortho-schematic circuit diagram 
showing ports on equipment and 
any connections between them (i.e. 
jumper cables, patch cords, etc.).  
Any kind of equipment can be 
displayed in this view, so long as it 
is connectable to the network. 

Can graphically manage 
connectivity by dragging and 
dropping connections between 
ports.  Cannot graphically 
change floor location or vertical 
rack layouts. 

 

Table 4. Summary of ISP View types. 

 

The block library is organized so that symbols for each of the three types of views are 
stored in a separate sub-directory, as shown below.  Normally, these directories are 
added to AutoCAD’s Support File Path when the system is installed. 

 

Figure 237 – SPATIALnet ISP block library organization 

 

When you configure a new piece of equipment, you need to decide which of the three 
types of views it will be visible in, and create symbology accordingly.  This means that 
for floor-standing equipment (racks and standalone equipment), you may need to 
configure three separate symbols for a single type of equipment.  For all other types 
(chasses and cards), you will have to configure two at most.  Cables do not require 
symbols in any of the view types as they are drawn automatically by the system when 
required. 

Intelligent Symbology 

As we saw in the earlier steps, SPATIALnet FM’s ISP functions provide a highly 
interactive graphical environment for viewing and managing inside plant.  For this to 
work, the symbols displayed in inside plant views need to have certain kinds of data 
encoded within them. Specifically: 

• The location of equipment mount points on rack symbols in Rack Elevation 
views 

• The location of card/module slot insertion points on chassis symbols in Rack 
Elevation views 
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• The location and types of ports on any kind of connectable equipment in 
Schematic Detail views. 

If you don’t do this, users will not be able to interact with the equipment using the 
tools covered earlier.  Fortunately, supplying the required information is a fairly simple 
task. 

In this step, we shall limit ourselves to looking only at how to encode equipment 
mount points (since these are generally the only ones that apply to racks).   We’ll look 
at the others when we configure a chassis in Step 103. 

Let us suppose that a new type of rack with 50 mount points is to be added to the ISP 
equipment dictionary.  The rack is nothing but a passive frame (i.e. it has no network 
electronics) so it will only appear in floorplan and elevation views, and not in 
schematics.  We will therefore only need two symbols.  Luckily, we almost never have 
to create new symbols from scratch, as we can copy existing symbols already in the 
library. 

 

Floorplan Symbol 

Floorplan symbols do not contain any intelligence.  We just need to decide how we 
want the rack to appear in a floorplan.  Usually we just copy or slightly modify an 
existing floorplan symbol for this.  In this case, let’s just copy the appearance of an 
existing type of rack and not change it. 

The equipment library contains a block for a 49-RU EMCOR rack.  We will use this 
without any modifications as the basis for the floorplan symbol that will represent our 
new rack type. 

To do this: 

1. Locate the file fr_emcor_32x23.dwg in the blklib\floorplan directory. 

2. Make a copy of this file in the same directory and call it fr_generic_50ru.dwg. 

This completes preparation of the floorplan symbol for the rack type. 

 

Elevation Symbol 

For the rack’s elevation symbol, we will again use the 49-RU EMCOR rack as our 
template, but this time we need to make some changes.  Specifically, we need to add 
an extra RU and register a new mount point. 

Before we change the file, let us examine what we have in it.  

1. Locate the file er_emcor-19x49ru_rack.dwg in the blklib\elevation directory. 

2. Make a copy of this file in the same directory and call it er_generic_50ru.dwg. 

3. Open er_generic_50ru.dwg as a native drawing in AutoCAD using AuotCAD’s 
File > Open command. 

The file depicts the front vertical view of the rack, with each rack unit measured off, 
as shown in Figure 238, below.  However, in addition to the visible content of this 
symbol, there are tiny circles at each mount point location, shown (slightly 
exaggerated in size) in the detail on the right of Figure 238.  These circles are actually 
blocks with attributes that tell SPATIALnet FM where equipment can be mounted on the 
rack, and supply the RU number of each mount point.  This information is used to 
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configure the mount point numbers available on the rack, and in elevation views to 
provide the “drag and drop” functionatliy. 

Note: You cannot mount equipment at a rack location where there is no 
marker block present. 

Each of the marker blocks is actually an instance of the block 
_snet_rack_mount_point.  This block has a single attribute, MOUNT_POINT_ID, whose 
value is just the RU number of the mount point.  The DWG file defining the 
_snet_rack_mount_point block is supplied with SPATIALnet FM, and can be found in the 
symbol\smt directory. 

To modify the existing elevation symbol so that it contains an additional RU, you must 
therefore: 

4. Modify the graphical representation of the rack to include an extra RU.  Normal 
AutoCAD drawing functions can be used for this, as the file is just a plain DWG. 

5. INSERT an additional _snet_rack_mount_point with a MOUNT_POINT_ID value of 
50 at the location at which equipment mounted at RU 50 will be displayed. 

Note: Do not copy an existing _snet_rack_mount_point, as duplicate mount 
point numbers may result.  This will prevent the block from being registered.  
Use the AutoCAD INSERT command (or any equivalent way of inserting a 
block). 

 

6. Save the file when done (make sure it is written into the blklib\elevation 
directory). 

 

49 
Mount point 
marker 
blocks 

 

Figure 238 – Rack Elevation symbol for rack, showing mount point 
marker blocks (slightly exaggerated in size) 

 

Now that the mount point marker blocks have been entered into the DWG file 
correctly, the new symbol must be registered with SPATIALnet FM so the mount point 
information can be loaded into the database.  This will complete configuration of the 
symbology for the new rack type.  To do this: 
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7. Ensure the file er_generic_50ru.dwg is open and in the currently active 
AutoCAD window. 

8. Run the menu command  
FM ISP > System Configuration > Rack Elevation Drawings > Register RE symbol. 

9. A list of the mount points that SPATIALnet FM has found in the drawing will be 
displayed. 

10. Click the Register button to load the rack configuration information into the 
database. 

 

Note: As of SPATIALnet FM 4.0, the list of marker blocks displayed on the ISP 
RE Symbol Creation panel was limited to about 40 entries.  Therefore, some 
marker blocks which are in the drawing may not appear in the list.  However, 
they will be registered correctly.  To verify this, run the menu command:  
FM ISP > System Configuration > Rack Elevation Drawings > Query RE symbol  
after the symbol has been registered, and display the Details of the selected 
rack elevation configuration.  All mount points should be present. 

 

Equipment Dictionary Entry 

Now that the symbology is complete, we can add the new rack type to the equipment 
dictionary.  Since all of the configuration information for the rack has already been 
entered graphically and registered with the database, creating the equipment 
dictionary entry becomes very simple.   

To do this: 

11. Run the menu command FM ISP > System Configuration > Equipment Dictionary > 
Add Entry… 

12. Fill in the fields with the values shown below (note the reference to the 
symbols we just created.  Also note there is no representation of the rack in a 
schematic view). 
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Figure 239 – Equipment Dictionary Entry Creation form for new rack. 

 

13. Click the Add button shown in Figure 239 to create the new equipment 
dictionary entry.  The system will display a message with the new Catalog ID 
assigned to the rack type. 

 

This completes specification of the new rack type.  Instances of this equipment can 
now be added to the database. 

 

Step 103: Configuring a Chassis Type 
The process for configuring new chassis types is almost identical to that for racks, so 
the background provided in Step 102 applies equally well here (you may want to 
review this now).  The only additional features we will contend with that were not 
covered in Step 102 are the addition of chassis mount points and the definition of a 
schematic representation of the equipment which includes the specification of its 
ports.  Conceptually, however, these are also almost identical to the configuration 
process covered in Step 102. 

As with our approach in Step 102, we will begin the process by modifying an existing 
chassis, in this case a Cisco 2611 router.  For the purposes of this exercise, let us 
suppose that a new model called the 26XX has been released with an additional slot 
for a PC card on the front panel.  Configuration of chasses follows the same 
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procedures as the configuration of racks in Step 102, that is, configure the symbology, 
register it, and then add an equipment dictionary entry. 

 

Intelligent Symbology 

We want to begin with the existing 2611 chassis and add that extra slot.  As with 
mount points on racks (see Step 102, above), chasses use a marker block to indicate 
the location and number of each of the card insertion slots.  The marker block is called 
_snet_chassis_mount_point3, and can be found in the symbol\smt sub-directory of the 
SPATIALnet installation folder.  This block has one attribute, MOUNT_POINT_ID which 
stores the number of the slot represented by the marker.   

To create the symbology for the new chassis: 

 

1. Open the drawing ec_cisco_2611_chassis.dwg in the blklib\elevation 
subdirectory of the SPATIALnet installation folder. 

2. Save this in the same directory as ec_cisco_26XX_chassis.dwg. 

3. Draw an extra rectangle representing the new PC Card bay on the front panel. 

4. INSERT a _snet_chassis_mount_point3 block and set the MOUNT_POINT_ID to 03. 

5. Save the drawing. 

6. Run the menu command  
FM ISP > System Configuration > Rack Elevation Drawings > Register RE symbol. 

7. A list of the mount points that SPATIALnet FM has found in the drawing will be 
displayed. 

8. Click the Register button to load the chassis configuration information into the 
database. 

This completes the process for creating the symbology for the new chassis type. 
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